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Introduction

Welcome to the eighth edition of Networking For Dummies, the book
that’s written especially for people who have this nagging feeling in
the back of their minds that they should network their computers but haven’t
a clue about how to start or where to begin.

Do you often burn a spreadsheet file to a CD-R disc just so you can give it to
someone else in your office? Are you frustrated because you can’t use the
fancy color laser printer that’s on the financial secretary’s computer? Do you
wait in line to use the computer that has the customer database? You need a
network!

Or maybe you already have a network, but you have just one problem: They
promised that the network would make your life easier, but instead it has
turned your computing life upside down. Just when you had this computer
thing figured out, someone popped into your office, hooked up a cable, and
said, “Happy networking!” Makes you want to scream.

Either way, you've found the right book. Help is here, within these humble
pages.

This book talks about networks in everyday — and often irreverent — terms.
The language is friendly; you don’t need a graduate education to get through
it. And the occasional potshot helps unseat the hallowed and sacred tradi-
tions of networkdom, bringing just a bit of fun to an otherwise dry subject.
The goal is to bring the lofty precepts of networking down to earth, where
you can touch them and squeeze them and say, “What’s the big deal? I can
do this!”

About This Book

This isn’t the kind of book you pick up and read from start to finish, as if it
were a cheap novel. If | ever see you reading it at the beach, I'll kick sand in
your face. This book is more like a reference, the kind of book you can pick
up, turn to just about any page, and start reading. It has 29 chapters, each
one covering a specific aspect of networking — such as printing on the net-
work, hooking up network cables, or setting up security so that bad guys
can’t break in. Just turn to the chapter you're interested in and start reading.
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Each chapter is divided into self-contained chunks, all related to the major
theme of the chapter. For example, the chapter on hooking up the network
cable contains nuggets like these:

v What is Ethernet?

v All about cable

v To shield or not to shield

1 Wall jacks and patch panels

v Hubs and switches
You don’t have to memorize anything in this book. It’s a need-to-know book:
You pick it up when you need to know something. Need to know what 100BaseT

is? Pick up the book. Need to know how to create good passwords? Pick up
the book. Otherwise, put it down and get on with your life.

How to Use This Book

This book works like a reference. Start with the topic you want to find out
about. Look for it in the table of contents or in the index to get going. The
table of contents is detailed enough that you should be able to find most of
the topics you're looking for. If not, turn to the index, where you can find
even more detail.

After you find your topic in the table of contents or the index, turn to the area
of interest and read as much as you need or want. Then close the book and
get on with it.

Of course, this book is loaded with information, so if you want to take a brief
excursion into your topic, you're more than welcome. If you want to know the
big security picture, read the whole chapter on security. If you just want to
know how to create a decent password, read just the section on passwords.
You get the idea.

If you need to type something, you see the text you need to type like this:
Type this stuff. In this example, you type Type this stuff at the keyboard and
then press Enter. An explanation usually follows, just in case you're scratch-
ing your head and grunting, “Huh?”

Whenever | describe a message or information that you see on the screen, |
present it this way:

A message from your friendly network
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This book rarely directs you elsewhere for information — just about every-
thing that you need to know about networks is right here. If you find the need
for additional information, plenty of other For Dummies books can help. If
you have a networking question that isn’t covered in this book, allow me to
suggest my own Networking All-in-One Desk Reference For Dummies, 2nd
Edition (Wiley) — this much-expanded reference book goes deeper into spe-
cific network operating systems and TCP/IP protocols. You can also find
plenty of other For Dummies books that cover just about every operating
system and application program known to humanity.

What You Don’t Need to Read

Aside from the topics you can use right away, much of this book is skippable.
I carefully placed extra-technical information in self-contained sidebars and
clearly marked them so that you can steer clear of them. Don’t read this stuff
unless you're really into technical explanations and want to know a little of
what’s going on behind the scenes. Don’t worry: My feelings won’t be hurt if
you don’t read every word.

Foolish Assumptions

I’'m making only two assumptions about who you are: You're someone who
works with a PC, and you either have a network or you're thinking about get-
ting one. | hope that you know (and are on speaking terms with) someone
who knows more about computers than you do. My goal is to decrease your
reliance on that person, but don’t throw away his or her phone number yet.

Is this book useful for Macintosh users? Absolutely. Although the bulk of this
book is devoted to showing you how to link Windows-based computers to
form a network, you can find information about how to network Macintosh
computers as well.

Windows Vista? Gotcha covered. You'll find plenty of information about how
to network with the latest and greatest Microsoft operating system.

How This Book Is Organized

Inside this book, you find chapters arranged in seven parts. Each chapter
breaks down into sections that cover various aspects of the chapter’s main
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subject. The chapters are in a logical sequence, so reading them in order (if
you want to read the whole thing) makes sense. But the book is modular
enough that you can pick it up and start reading at any point.

Here’s the lowdown on what’s in each of the seven parts.

Part I: Let’s Network!

The chapters in this part present a layperson’s introduction to what network-
ing is all about. This part is a good place to start if you're clueless about what
a network is and why you’re suddenly expected to use one. It’s also a great
place to start if you're a hapless network user who doesn’t give a whit about
“optimizing network performance” but you want to know what the network is
and how to get the most out of it.

The best thing about this part is that it focuses on how to use a network with-
out getting into the technical details of setting up a network or maintaining a
network server. In other words, this part is aimed at ordinary network users
who have to know how to get along with a network.

Part I1: Building Your Own Network

Uh-oh. The boss just gave you an ultimatum: Get a network up and running
by Friday or pack your things. The chapters in this section cover everything
you need to know to build a network, from picking the network operating
system to installing the cable.

Part I1: Getting Connected

After you get a basic network up and running, the chapters in this part show
you how to connect it to the world. You find out all about safely connecting your
network to the Internet, setting up an e-mail server, and even connecting
your network to computers at home and on the road.

Part 1U: Network Management
For Dummies

I hope that the job of managing the network doesn’t fall on your shoulders,
but in case it does, the chapters in this part can help you out. You find out all
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about backup, security, performance, dusting, mopping, changing the oil, and
all the other stuff that network managers have to do.

Part U: Protecting Vour Network

This part is all about network security: backing up your data, protecting your
network from evil people who want to break your network’s back, and hard-
ening your network against threats, such as viruses and spyware.

Part Ul: Beyond Windows

There’s more to networking than Windows. That’s why this part focuses on
the two most popular alternatives: Linux and Macintosh.

Part VlI: The Part of Tens

This wouldn’t be a For Dummies book without a collection of lists of interest-
ing snippets: ten networking commandments, ten things you should keep in
your closet, ten big network mistakes, and more!

Icons Used in This Book

Those nifty little pictures in the margin aren’t there just to pretty up the
place. They also have practical functions:

Hold it — technical details lurk just around the corner. Read on only if you
have a pocket protector.

Pay special attention to this icon; it lets you know that some particularly
useful tidbit is at hand — perhaps a shortcut or a little-used command that
pays off big.

‘j
&
Did I tell you about the memory course I took?

WING/
§g~ Danger, Will Robinson! This icon highlights information that may help you
avert disaster.
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Where to Go from Here

Yes, you can get there from here. With this book in hand, you’re ready to plow
right through the rugged networking terrain. Browse through the table of
contents and decide where you want to start. Be bold! Be courageous! Be
adventurous! Above all, have fun!



Part |
Let's Network!

The 5th Wave By Rich Tennant

© RICKTENNS T

“Oh, Arthur is very careful about security on the
Web. He never goes online in the same room on
consecutive days.”




In this part . . .

0ne day the Network Thugs barge into your office and
shove a gun in your face. “Don’t move until we hook
you up to the network!” one of them says while the other
one connects one end of a suspicious-looking cable to the
back of your computer and shoves the other end into a
hole in the wall. “It’s done,” they say as they start to leave.
“Now, don’t you say nuttin’ to nobody — or we’ll be back!”

If this has happened to you, you’ll appreciate the chapters
in this part. They provide a gentle introduction to com-
puter networks written especially for the reluctant net-
work user.

What if you don’t have a network yet and you’re the one
who’s supposed to do the installing? Then the chapters

in this part clue you in to what a network is all about. That
way, you're prepared for the (unfortunately more techni-
cal) chapters in Part Il and beyond.




Chapter 1

Networks Will Not Take Qver the
World, and Other Network Basics

In This Chapter

Getting a handle on networks

Considering why networking is useful (and is everywhere)
Telling the difference between servers and clients
Looking under the hood at the network operating system

Asking “How does it work when a network works if a network
works for me?” (Say what?)

Assessing how networks change computing life
Identifying (and offering sympathy to) the network administrator
Comparing servers to clients: What have they got that you don’t got?

C omputer networks get a bad rap in the movies. In the Terminator movies,
Skynet (a computer network of the future) takes over the planet, builds
deadly terminator robots, and sends them back through time to kill everyone
unfortunate enough to have the name Sarah Connor. In The Matrix movies, a
vast and powerful computer network enslaves humans and keeps them
trapped in a simulation of the real world. And in one of Matthew Broderick’s
first movies, War Games, a computer whiz kid nearly starts World War III by
connecting to a Defense Department network and playing the game Global
Thermonuclear War.

Fear not. These bad networks exist only in the dreams of science fiction writ-
ers. Real-world networks are much more calm and predictable. They don’t
think for themselves, they can’t evolve into something you don’t want them
to be, and they won’t hurt you — even if your name is Sarah Connor.

Now that you’re over your fear of networks, you're ready to breeze through
this chapter. It’s a gentle, even superficial, introduction to computer net-
works, with a slant toward the concepts that can help you use a computer
that’s attached to a network. This chapter goes easy on the details; the
detailed and boring stuff comes later.
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What Is a Network?

A network is nothing more than two or more computers connected by a cable
(or in some cases by radio connection) so that they can exchange information.

Of course, computers can exchange information in ways other than networks.
Most of us have used what computer nerds call the sneakernet. That’s where
you copy a file to a diskette, a CD-RW disc, or a removable flash drive, and
then walk the data over to someone else’s computer. (The term sneakernet is
typical of computer nerds’ feeble attempts at humor, and why not? As a way
to transfer information, sneakernet is feeble.)

The whole problem with the sneakernet is that it’s slow — plus, it wears a
trail in your carpet. One day, some penny-pinching computer geeks discov-
ered that connecting computers with cables was cheaper than replacing the
carpet every six months. Thus, the modern computer network was born.

You can create a computer network by hooking together all the computers in
your office with cables and using the computer’s network interface (an elec-
tronic circuit that resides inside your computer and has a special jack on the
computer’s backside). Then you set up your computer’s operating system
software to make the network work, and — voila — you have a working net-
work. That’s all there is to it.

If you don’t want to mess with cables, you can create a wireless network
instead. In a wireless network, each computer is equipped with a special
wireless network adapter that has little rabbit-ear antennas. Thus, the com-
puters can communicate with each other without the need for cables.

Figure 1-1 shows a typical network with four computers. You can see that
all four computers are connected by a network cable to a central network
device: the hub. You can also see that Ward’s computer has a fancy laser
printer attached to it. Because of the network, June, Wally, and the Beaver
can also use this laser printer. (Also, you can see that the Beaver stuck yes-
terday’s bubble gum to the back of his computer. Although the bubble gum
isn’t recommended, it shouldn’t adversely affect the network.)

Computer networking has its own, strange vocabulary. Fortunately, you don’t
have to know every esoteric networking term. Here are a few basic buzz-
words to get you by:

v LAN: Networks are often called LANs. The acronym LAN stands for local-
area network. It’s the first TLA, or three-letter acronym, that you see in this
book. You don'’t really need to remember it, or any of the many TLAs that
follow. In fact, the only three-letter acronym you need to remember is TLA.

v FLA: You may guess that a four-letter acronym is an FLA. Wrong! A
four-letter acronym is an ETLA, which stands for extended three-letter
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acronym. (After all, it just wouldn’t be right if the acronym for four-letter
acronym had only three letters.)

v On the network: Every computer connected to the network is said to be
on the network. The technical term (which you can forget) for a com-
puter that’s on the network is a node.

v Online: When a computer is turned on and can access the network, the
computer is said to be online. When a computer can’t access the net-
work, it’s offline. A computer can be offline for several reasons. The
computer can be turned off, the user may have disabled the network
connection, the computer may be broken, the cable that connects it to
the network can be unplugged, or a wad of gum can be jammed into the
disk drive.

v Up: When a computer is turned on and working properly, it’s said to be
up. When a computer is turned off, broken, or being serviced, it’s said to
be down. Turning off a computer is sometimes called taking it down.
Turning it back on is sometimes called bringing it up.

<P Don’t confuse local-area networks with the Internet. The Infernet is a huge
amalgamation of computer networks strewn about the entire planet. Networking
the computers in your home or office so that they can share information with
one another and connecting your computer to the worldwide Internet are
two separate, but related, tasks. If you want to use your local-area network to
connect your computers to the Internet, you can consult Chapter 10 for
instructions.

June's computer Wally's computer

|
Figure 1-1:

A typical
network.
— Ward's laser printer
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Why Bother with a Network?

A\

Frankly, computer networks are a bit of a pain to set up. So, why bother?
Because the benefits of having a network make the pain of setting up one
bearable. You don’t have to be a PhD to understand the benefits of network-
ing. In fact, you learned everything you need to know in kindergarten: Networks
are all about sharing. Specifically, networks are about sharing three things:
files, resources, and programs.

Sharing files

Networks enable you to share information with other computers on the net-
work. Depending on how you set up your network, you can share files with
your network friends in several different ways. You can send a file from your
computer directly to a friend’s computer by attaching the file to an e-mail
message and then mailing it. Or, you can let your friend access your com-
puter over the network so that your friend can retrieve the file directly from
your hard drive. Yet another method is to copy the file to a disk on another
computer and then tell your friend where you put the file so that he can
retrieve it later. One way or the other, the data travels to your friend’s com-
puter over the network cable, and not on a floppy disk, CD-RW, or flash drive,
as it would in a sneakernet.

Sharing resources

You can set up certain computer resources — such as hard drives or printers —
so that all computers on the network can access them. For example, the laser
printer attached to Ward’s computer in Figure 1-1 is a shared resource, which
means that anyone on the network can use it. Without the network, June,
Wally, and the Beaver would have to buy their own laser printers.

Hard drives can be shared resources, too. In fact, you must set up a hard
drive as a shared resource to share files with other users. Suppose that Wally
wants to share a file with the Beaver, and a shared hard drive has been set up
on June’s computer. All Wally has to do is copy his file to the shared hard
drive in June’s computer and tell the Beaver where he put it. Then when the
Beaver gets around to it, he can copy the file from June’s computer to his
own (unless, of course, Eddie Haskell deletes the file first).

You can share other resources, too, such as an Internet connection. In fact,
sharing an Internet connection is one of the main reasons many networks
are set up.
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Sharing programs

Rather than keep separate copies of programs on each person’s computer,
putting programs on a drive that everyone shares is sometimes best. For
example, if ten computer users all use a particular program, you can purchase
and install ten copies of the program — one for each computer. Or, you can
purchase a ten-user license for the program and then install just one copy of
the program on a shared drive. Each of the ten users can then access the
program from the shared hard drive.

In most cases, however, running a shared copy of a program over the net-
work is unacceptably slow. A more common way of using a network to share
programs is to copy the program’s installation disks or CDs to a shared net-
work drive. Then you can use that copy to install a separate copy of the pro-
gram on each user’s local hard drive. For example, Microsoft Office enables
you to do this if you purchase a license from Microsoft for each computer on
which you install Office.

The advantage of installing Office from a shared network drive is that you
don’t have to lug around the installation disks or CDs to each user’s computer.
And, the system administrator can customize the network installation so that
the software is installed the same way on each user’s computer. (However,
these benefits are significant only for larger networks. If your network has fewer
than about ten computers, you're probably better off installing the program
separately on each computer directly from the installation disks or CDs.)

Remember that purchasing a single-user copy of a program and then putting
it on a shared network drive — so that everyone on the network can access it —
is illegal. If five people use the program, you need to either purchase five
copies of the program or purchase a network license that specifically allows
five or more users.

Another benefit of networking is that networks enable computer users to
communicate with one another over the network. The most obvious way net-
works allow computer users to communicate is by passing messages back
and forth, using e-mail or instant-messaging programs. Networks also offer
other ways to communicate: For example, you can hold online meetings over
the network. Network users who have inexpensive video cameras (Webcams)
attached to their computers can have videoconferences. You can even play a
friendly game of Hearts over a network — during your lunch break, of course.

Servers and Clients

The network computer that contains the hard drives, printers, and other
resources that are shared with other network computers is a server. This

13
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term comes up repeatedly, so you have to remember it. Write it on the back
of your left hand.

Any computer that’s not a server is a client. You have to remember this term,
too. Write it on the back of your right hand.

Only two kinds of computers are on a network: servers and clients. Look at
your left hand and then look at your right hand. Don’t wash your hands until
you memorize these terms.

The distinction between servers and clients in a network has parallels in
sociology — in effect, a sort of class distinction between the “haves” and
“have-nots” of computer resources:

v Usually, the most powerful and expensive computers in a network are
the servers. There’s a good technical reason: Every user on the network
shares the server’s resources.

v The cheaper and less powerful computers in a network are the clients.
Clients are the computers used by individual users for everyday work.
Because clients’ resources don’t have to be shared, they don’t have to
be as fancy.

v Most networks have more clients than servers. For example, a network
with ten clients can probably get by with one server.

v In many networks, a clean line of demarcation exists between servers
and clients. In other words, a computer functions as either a server or a
client, and not both. For the sake of an efficient network, a server can’t
become a client, nor can a client become a server.

v Other (usually smaller) networks can be more evenhanded by allowing
any computer in the network to be a server and allowing any computer
to be both server and client at the same time.

Dedicated Servers and Peers

In some networks, a server computer is a server computer and nothing else.
It’s dedicated to the sole task of providing shared resources, such as hard
drives and printers, to be accessed by the network client computers. This
type of server is a dedicated server because it can perform no other task than
network services.

Some smaller networks take an alternative approach by enabling any com-
puter on the network to function as both a client and a server. Thus, any
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computer can share its printers and hard drives with other computers on the
network. And, while a computer is working as a server, you can still use that
same computer for other functions, such as word processing. This type of
network is a peer-to-peer network because all the computers are thought of as
peers, or equals.

Here are some points to ponder concerning the differences between dedi-
cated server networks and peer-to-peer networks while you’re walking the
dog tomorrow morning:

v Peer-to-peer networking features are built into Windows. Thus, if your
computer runs Windows, you don’t have to buy any additional software
to turn your computer into a server. All you have to do is enable the
Windows server features.

v The network server features that are built into desktop versions of
Windows (such as Windows XP and Vista) aren’t efficient because these
versions of Windows weren’t designed primarily to be network servers.

§‘\\'(,N\BEIf If you dedicate a computer to the task of being a full-time server, use a
Y special network operating system rather than the standard Windows
operating system. A network operating system, also known as a NOS, is
specially designed to handle networking functions efficiently.

¢ The most commonly used network operating systems are the
server versions of Windows.

At the time of publication, the current server version of Windows
was Windows Server 2003, and a newer version, probably to be
called Windows Server 2007, was on the way.

¢ Other network operating systems include Linux and Novell NetWare.

v Many networks are both peer-to-peer and dedicated-server networks at
the same time. These networks have

¢ At least one server computer that runs a NOS, such as Windows
Server 2003.

¢ Client computers that use the server features of Windows to share
\\3 their resources with the network.

v Besides being dedicated, your servers should also be sincere.

What Makes a Network Tick?

To use a network, you don’t really have to know much about how it works.
Still, you may feel a little bit better about using the network if you realize that

15



’ 6 Part I: Let's Network!

\\3

A\

it doesn’t work by voodoo. A network may seem like magic, but it isn’t. The
following list describes the inner workings of a typical network:

1 Network interface card: Inside any computer attached to a network is a

special electronic circuit card: the network interface card. The TLA for
network interface card is NIC.

Using your network late into the evening isn’t the same as watching
NIC at night. If the network is set up to use that time to update software
and back up data, the NIC has to be robust enough to handle all-day-all-
night use.

Although you can also use an external network interface that connects
to the computer by using the computer’s USB (universal serial bus) port,
most networked computers use a built-in network interface card.

Nearly all computers built these days have a network interface built into
the computer’s motherboard. This network interface is still commonly
called the NIC, even though it isn’t technically a separate card.

v Network cable: The network cable physically connects the computers.

It plugs into the network interface card on the back of your computer.

Nearly all networks now use a type of cable that looks something like
telephone cable. However, appearances can be deceiving. Most phone
systems are wired using a lower grade of cable that doesn’t work for net-
works. For a computer network, each pair of wires in the cable must be
twisted in a certain way. That’s why this type of cable is called twisted-
pair cable. (Standard phone cable doesn’t do the twist.)

For the complete lowdown on networking cables, refer to Chapter 5.

You can do away with network cable by creating a wireless network,
although that option has some challenges of its own. For more informa-
tion about wireless networking, see Chapter 9.

v Network switch: Networks built with twisted-pair cabling require one or

more switches. A switch is a box with a bunch of cable connectors. Each
computer on the network is connected by cable to the switch. The
switch, in turn, connects all the computers to each other.

In the early days of twisted-pair networking, devices known as hubs were
used rather than switches. The term hub is sometimes used to refer to
switches, but true hubs went out of style sometime around the turn of
the century.

v Network software: Of course, the software makes the network work. To

make any network work, a whole bunch of software has to be set up just
right. For peer-to-peer networking with Windows, you have to play with
the Control Panel to get networking to work. And, a network operating
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system (such as Windows Server 2003) requires a substantial amount of
tweaking to get it to work just right.

For more information about choosing which network software to use for
your network, refer to Chapter 7.

It’s Not a Personal Computer Anymore!

If  had to choose one point that [ want you to remember from this chapter
more than anything else, it’s this: After you hook up your personal computer
(PC) to a network, it’s not a “personal” computer anymore. You are now part
of a network of computers, and in a way, you’ve given up one of the key con-
cepts that made PCs so successful in the first place: independence.

I got my start in computers back in the days when mainframe computers
ruled the roost. Mainframe computers are big, complex machines that used to
fill entire rooms and had to be cooled with chilled water. My first computer
was a water-cooled Binford Power-Proc Model 2000. Argh, argh, argh. (I'm not
making up the part about the water. A plumber was often required to install a
mainframe computer. In fact, the really big ones were cooled by liquid nitro-
gen. | am making up the part about the Binford 2000.)

Mainframe computers required staffs of programmers and operators in white
lab coats just to keep them going. The mainframes had to be carefully man-
aged. A whole bureaucracy grew up around managing them.

Mainframe computers used to be the dominant computers in the workplace.
Personal computers changed all that: They took the computing power out of
the big computer room and put it on the user’s desktop, where it belongs. PCs
severed the tie to the centralized control of the mainframe computer. With a
PC, a user could look at the computer and say, “This is mine — all mine!”
Mainframes still exist, but they’re not nearly as popular as they once were.

Networks are changing everything all over again. In a way, it’s a change back
to the mainframe-computer way of thinking: central location, distributed
resources. True, the network isn’t housed in the basement and doesn’t have
to be installed by a plumber. But you can no longer think of “your” PC as your
own. You're part of a network — and, like the mainframe, the network has to
be carefully managed.

Here are several ways in which a network robs you of your independence:

+* You can’t just indiscriminately delete files from the network. They
may not be yours.

17
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v You're forced to be concerned about network security. For example, a
server computer has to know who you are before it lets you access its
files. So, you have to know your user ID and password to access the net-
work. This precaution prevents some 15-year-old kid from hacking his
way into your office network by using its Internet connection and steal-
ing all your computer games.

+ You may have to wait for shared resources. Just because Wally sends
something to Ward’s printer doesn’t mean that it immediately starts to
print. The Beav may have sent a two-hour print job before that. Wally
just has to wait.

+* You may have to wait for access to documents. You may try to retrieve
an Excel spreadsheet file from a network drive, only to discover that
someone else is using it. Like Wally, you just have to wait.

+ You don’t have unlimited storage space. If you copy a 600MB database
file to a server’s drive, you may get calls later from angry co-workers com-
plaining that no room is left on the server’s drive for their important files.

v Your files can become infected from viruses given to you by someone
over the network. You may then accidentally infect other network users.

+ You have to be careful about saving sensitive files on the server. If you
write an angry note about your boss and save it on the server’s hard
drive, your boss may find the memo and read it.

v The server computer must be up and running at all times. For exam-
ple, if you turn Ward’s computer into a server computer, Ward can’t turn
his computer off when he’s out of the office. If he does, you can’t access
the files stored on his computer.

1 If your computer is a server, you can’t just turn it off when you’re fin-
ished using it. Someone else may be accessing a file on your hard drive
or printing on your printer.

Why does Ward always get the best printer? If Leave It to Beaver were made
today,  would bet that the good printer would be on June’s computer.

The Network Administrator

Because so much can go wrong — even with a simple network — designating
one person as the network administrator is important. This way, someone is
responsible for making sure that the network doesn’t fall apart or get out of
control.

The network administrator doesn’t have to be a technical genius. In fact,
some of the best network administrators are complete idiots when it comes
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to technical stuff. What’s important is that the administrator is organized.
That person’s job is to make sure that plenty of space is available on the file
server, that the file server is backed up regularly, that new employees can
access the network, and other tasks.

The network administrator’s job also includes solving basic problems that
the users themselves can’t solve — and knowing when to call in an expert
when something really bad happens. It’s a tough job, but somebody’s got to
do it. Here are a few tips that might help:

v Part IV of this book is devoted entirely to the hapless network adminis-
trator. So, if you're nominated, read the chapters in that part. If you're
lucky enough that someone else is nominated, celebrate by buying her a
copy of this book.

v In small companies, picking the network administrator by drawing
straws is common. The person who draws the shortest straw loses and
becomes administrator.

v Of course, the network administrator can’t be a complete technical idiot.
I was lying about that. (For those of you in Congress, the word is testify-
ing.) I exaggerated to make the point that organizational skills are more
important than technical skills. The network administrator needs to
know how to do various maintenance tasks. Although this knowledge
requires at least a little technical know-how, the organizational skills are
more important.

What Have They Got That Vou Don’t Got?

With all this technical stuff to worry about, you may begin to wonder whether
you’re smart enough to use your computer after it’s attached to the network.
Let me assure you that you are. If you’re smart enough to buy this book
because you know that you need a network, you’re more than smart enough
to use the network after it’s put in. You're also smart enough to install and
manage a network yourself. It isn’t rocket science.

[ know people who use networks all the time. They’'re no smarter than you
are, but they do have one thing that you don’t have: a certificate. And so,
by the powers vested in me by the International Society for the Computer
Impaired, I present you with the certificate in Figure 1-2, confirming that
you've earned the coveted title Certified Network Dummy, better known as
CND. This title is considered much more prestigious in certain circles than
the more stodgy CNE or MCSE badges worn by real network experts.

Congratulations, and go in peace.
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|
Figure 1-2:
Your official
CND
certificate.
|

Certificate of Network Dumminess

This certifies that

has ascended to the Holy Order of
CERTIFIED NETWORK DUMMY
and is hereby entitled to
all the rights and privileges therein,
headaches and frustrations hitherto,
and Pizza and Jolt Cola wherever.
So let it be written, so let it be done.

Official
CND

Insignia Doug Lowe
Chairman, International Society of Certified

Network Dummies




Chapter 2
Life on the Network

In This Chapter

Using local resources and network resources
Playing the name game

Mapping network drives

Logging on to the network

Using shared folders

Using a network printer

Logging off the network

A fter you hook up your PC to a network, it’s not an island any more —
separated from the rest of the world like some kind of isolationist fanatic
waving a “Don’t tread on me” flag. The network connection changes your PC
forever. Now your computer is part of a system, connected to other com-
puters on the network. You have to worry about annoying network details,
such as using local and shared resources, logging on and accessing network
drives, using network printers, logging off, and who knows what else.

Oh, bother.
This chapter brings you up to speed on what living with a computer network

is like. Unfortunately, this chapter gets a little technical at times, so you may
need your pocket protector.

Distinguishing between Local Resources
and Network Resources

In case you don’t catch this statement in Chapter 1, one of the most impor-
tant differences between using an isolated computer and using a network
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computer lies in the distinction between local resources and network resources.
Local resources are items, such as hard drives, printers, and CD-ROM or DVD
drives, that are connected directly to your computer. You can use local
resources whether you're connected to the network or not. Network
resources, on the other hand, are the hard drives, printers, modems, and
CD-ROM or DVD drives that are connected to the network’s server com-
puters. You can use network resources only after your computer is con-
nected to the network.

The whole trick to using a computer network is to know which resources are
local resources (they belong to you) and which are network resources (they
belong to the network). In most networks, your C drive is a local drive. If a
printer is sitting next to your PC, it’s probably a local printer. You can do any-
thing you want with these resources without affecting the network or other
users on the network (as long as the local resources aren’t shared on the
network).

» You can'’t tell just by looking at a resource whether it’s a local resource
or a network resource. The printer that sits right next to your computer
is probably your local printer, but then again, it may be a network
printer. The same statement is true for hard drives: The hard drive in
your PC is probably your own, but it may be a network drive, which can
be used by others on the network.

v Because dedicated network servers are full of resources, you may say
that they’re not only dedicated (and sincere) but also resourceful. (Groan.
Sorry, this is yet another in a tireless series of bad computer-nerd puns.)

What's in a Name?

<W®

Just about everything on a computer network has a name: The computers
themselves have names, the people that use the computers have names, the
hard drives and printers that can be shared on the network have names, and
the network itself has a name. Knowing all the names used on your network
isn’t essential, but you do need to know some of them.

Here are some additional details about network names:

v Every person who can use the network has a username (sometimes
called a user ID). You need to know your username to log on to the net-
work. You also need to know the usernames of your buddies, especially
if you want to steal their files or send them nasty notes.

You can find more information about usernames and logging on in the
section “Logging On to the Network,” later in this chapter.
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1~ Letting folks on the network use their first names as their usernames
is tempting but not a good idea. Even in a small office, you eventually
run into a conflict. (And, what about Mrs. McCave — made famous by
Dr. Seuss — who had 23 children and named them all Dave?)

Create a consistent way of creating usernames. For example, you may
use your first name plus the first two letters of your last name. Then
Wally’s username is wallycl, and Beaver’s is beavercl. Or, you may
use the first letter of your first name followed by your complete last
name. Then Wally’s username is wcleaver, and Beaver’s is bcleaver.
(In most networks, capitalization doesn’t matter in usernames. Thus,
bcleaver is the same as BCleaver.)

v Every computer on the network must have a unique computer name.

You don’t have to know the names of all the computers on the network,
but it helps if you know your own computer’s name and the names of
any server computers you need to access.

The computer’s name is sometimes the same as the username of the
person who uses the computer, but that’s usually a bad idea because in
many companies, people come and go more often than computers. Some-
times the names indicate the physical location of the computer, such as
office-12 or back-room. Server computers often have names that
reflect the group that uses the server most, like acctng-server or
cad-server.

Some network nerds like to assign techie-sounding names, like
BL3K5-87a. And some like to use names from science fiction movies —
HAL, Colossus, M5, and Data come to mind. Cute names like Herbie
aren’t allowed. (However, Tigger and Pooh are entirely acceptable —
recommended, in fact. Tiggers like networks.)

Usually, the sensible approach to computer naming is to use names that
have numbers, such as computer001 or computer002.

v Network resources, such as shared disk folders and printers, have
names. For example, a network server may have two printers, named
laser and inkjet (to indicate the type of printer), and two shared disk
folders, named AccountingData and MarketingData.

v Server-based networks have a username for the network
administrator.

If you log on with a username that has administrator’s rights, you can
do anything you want: add new users, define new network resources,
change Wally’s password — anything. The administrator’s username is
usually something clever, such as Administrator.

23



2 4 Part I: Let's Network!

égN\BEﬁ v The network itself has a name.
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The Windows world has two basic types of networks:

e Domain networks are the norm for large corporate environments
that have dedicated servers with IT staff to maintain them.

e Workgroup networks are more common in homes or in small offices
that don’t have dedicated servers or IT staff.

A domain network is known by — you guessed it — a domain name. And
a workgroup network is identified by — drum roll, please — a workgroup
name. Regardless of which type of network you use, you need to know
this name to gain access to the network.

Logging On to the Network

To use network resources, you must connect your computer to the network,
and you must go through the supersecret process of logging on. The purpose
of logging on is to let the network know who you are so that it can decide
whether you're one of the good guys.

Logging on is a little bit like cashing a check — the process requires two
forms of identification:

v Your username: The name by which the network knows you.

Your username is usually some variation of your real name, like Beav for
the Beaver. Everyone who uses the network must have a username.

v Your password: A secret word that only you and the network know. If
you type the correct password, the network believes that you are who
you say you are.

Every user has a different password, and the password should be a secret.

In the early days of computer networking, you had to type a logon command
at a stark MS-DOS prompt and then supply your user ID and password.
Nowadays, the glory of Windows is that you get to log on to the network
through a special network logon dialog box that appears when you start your
< computer. Figure 2-1 shows the Windows XP version of this dialog box.

Here are some more logon points to ponder:
v The terms user ID and logon name are sometimes used instead of user-
name. They mean the same thing.

1 As long as we're talking about words that mean the same thing, log in
and log on mean the same thing, as do (respectively) log out and log off
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as ways of saying, “I'm outta here.” Although you see both out there in
the world, this book uses log on and log off throughout — and if there’s
any exception, the book says why and grouses about it a bit.

v As far as the network’s concerned, you and your computer aren’t the
same thing. Your username refers to you, not to your computer. That’s
why you have a username, and your computer has a computer name.
You can log on to the network by using your username from any com-
puter that’s attached to the network. Other users can log on at your
computer by using their own usernames.

When others log on at your computer by using their own usernames,
they can’t access any of your network files that are protected by your
password. However, they can access any local files that you haven’t pro-
tected. Be careful which people you allow to use your computer.

v+ Windows XP and Vista have a cool feature that displays icons for each of
the users registered on your computer. When this feature is enabled, you
can log on by clicking your name’s icon and then typing your password.

v If you're logging on to a domain network, the Windows XP Logon dialog
box has a field in which you can enter the domain name you want to log
on to. Normally, a suitable default value appears for the domain name,
so you can safely ignore this field. If not, your network administrator will
be happy to tell you how to enter this information.

v Windows Vista doesn’t include a field in which you can enter the domain
name. Instead, you must type the domain name before your username,
separated from it by a backslash. For example:

lowewriter\dlowe

Here, the domain name is 1lowewriter, and the username is dlowe.

v Your computer may be set up so that it logs you on automatically when-
ever you turn it on. In that case, you don’t have to type your username
and password. This setup makes the task of logging on more convenient
but takes the sport out of it. And, it’s a terrible idea if you're the least bit
worried about bad guys getting into your network or personal files.

v Guard your password with your life. I'd tell you mine, but then I'd have
to shoot you.

|
Flgure 2: Enter Network Password
You have to ml En tivark d for Microsoft Metworki
rker your network password For MICrosol etWoring.
enter your %i!
— Cancel
user lD and Uszer name; IDoug Lowe —!
password to
Passward: I|
access the
network.
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Understanding Shared Folders

\

Long ago, in the days Before Network (B.N.), your computer probably had
just one hard drive, known as C: drive. Maybe it had two — C: and D:. The
second drive might be another hard disk, or possibly a CD-ROM or DVD-ROM
drive. Even to this day, the descendants of those drives are physically
located inside your PC. They’re your local drives.

Now that you'’re on a network, however, you probably have access to drives
that aren’t located inside your PC but are located instead in one of the other
computers on the network. These network drives can be located on a dedi-
cated server computer or, in the case of a peer-to-peer network, on another
client computer.

In some cases, you can access an entire network drive over the network. But
in most cases, you can’t access the entire drive. Instead, you can access only
certain folders (directories, in old MS-DOS lingo) on the network drives. Either
way, the shared drives or folders are known in Windows terminology as
shared folders. A shared folder is commonly referred to as a network drive
because the shared folder can be accessed as though it were a separate
drive, complete with its own drive letter.

Shared folders can be set up with restrictions on how you can use them. For
example, you may be granted full access to some shared folders so that you
can copy files to or from them, delete files on them, or create or remove fold-
ers on them. On other shared folders, your access may be limited in certain
ways. For example, you may be able to copy files to or from the shared folder
but not delete files, edit files, or create new folders. You may also be asked to
enter a password before you can access a protected folder. The amount of
disk space you're allowed to use on a shared folder may also be limited. For
more information about file-sharing restrictions, refer to Chapter 17.

In addition to accessing shared folders that reside on other people’s com-
puters, you can designate your computer as a server to enable other network
users to access folders that you share. To find out how to share folders on
your computer with other network users, see Chapter 3.

Four Good Uses for a Shared Folder

After you know which shared network folders are available, you may wonder
what you’re supposed to do with them. This section describes four good uses
for a network folder.
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Store files that everybody needs

A shared network folder is a good place to store files that more than one user
needs to access. Without a network, you have to store a copy of the file on
everyone’s computer, and you have to worry about keeping the copies syn-
chronized (which you can’t do, no matter how hard you try). Or, you can
keep the file on a disk and pass it around. Or, you can keep the file on one
computer and play musical chairs — whenever someone needs to use the
file, he goes to the computer that contains the file.

On a network, you can keep one copy of the file in a shared folder on the net-
work, and everyone can access it.

Store your own files

You can also use a shared network folder as an extension of your own hard
drive storage. For example, if you filled up all the free space on your hard
drive with pictures, sounds, and movies that you downloaded from the
Internet, but the network server has billions and billions of gigabytes of free
space, you have all the drive space you need. Just store your files on the net-
work drive!

Here are a few guidelines for storing files on network drives:

v Using the network drive for your own files works best if the network
drive is set up for private storage that other users can’t access. That
way, you don’t have to worry about the nosy guy down in Accounting
who likes to poke around in other people’s files.

v Don’t overuse the network drive. Remember that other users have prob-
ably filled up their own hard drives, so they want to use the space on
the network drive, too.

1 Before you store personal files on a network drive, make sure that you
have permission. A note from your mom will do.

v On domain networks, a drive (typically drive H) is commonly mapped to
a user’s home folder. The home folder is a network folder that’s unique
for each user. You can think of it as a network version of My Documents.
If your network is set up with a home folder, you should use it rather
than My Documents for any important work-related files. That’s because
the home folder is usually included in the network’s daily backup sched-
ule. In contrast, most networks do not back up data you store in My
Documents.
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Make a pit stop for files on
their way to other users

“Hey, Wally, could you send me a copy of last month’s baseball stats?”

“Sure, Beav.” But how? If the baseball stats file resides on Wally’s local drive,
how does Wally send a copy of the file to Beaver’s computer? Wally can do it
by copying the file to a network folder. Then Beaver can copy the file to his
local hard drive.

Here are some tips to keep in mind when you use a network drive to
exchange files with other network users:

+» Remember to delete files that you saved to the network folder after
they’re picked up! Otherwise, the network folder quickly fills up with
unnecessary files.

v Create a folder on the network drive specifically intended for holding
files en route to other users. Name this folder PITSTOP or something
similar to suggest its function.

In many cases, it’s easier to send files to other network users by e-mail than
by using a network folder. Just send a message to the other network user and
attach the file you want to share. The advantage of sending a file by e-mail is
that you don’t have to worry about details like where to leave the file on the
server and who'’s responsible for deleting the file.

Back up your local hard drive

If enough drive space is available on the file server, you can use it to store
backup copies of the files on your hard drive. Just copy the files that you
want to back up to a shared network folder.

Obviously, if you copy all your data files to the network drive — and every-
body else follows suit — it can quickly fill up. Check with the network man-
ager before you start storing backup copies of your files on the server. The
manager may have already set up a special network drive that’s designed just
for backups. And, if you're lucky, your network manager may be able to set
up an automatic backup schedule for your important data so that you don’t
have to remember to back it up manually.

[ hope that your network administrator also routinely backs up the contents

of the network server’s disk to tape. (Yes, tape — see Chapter 21 for details.)

That way, if something happens to the network server, the data can be recov-
ered from the backup tapes.
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Oh, the Network Places Vou'll Go

.

|
Figure 2-2:
Browsing
the network
in Windows
Vista.
|

Windows enables you to access network resources, such as shared folders,
by browsing the network. In Windows XP, you do this by double-clicking the
My Network Places icon that resides on your desktop. In Windows Vista,
choose Network from the Start menu. Figure 2-2 shows the Vista version of
the network browser.
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The network shown in Figure 2-2 consists of just two computers, named
WKO07-001 and LSERVERO1, and a router named Linksys BEFW1154 V2/V3. You
can open either of the computers by double-clicking their icons to reveal a
list of shared resources available on the computer. For example, Figure 2-3
shows the resources shared by the LSERVERO1 computer.

You can also browse the network from any Windows application program. For
example, you may be working with Microsoft Word 2007 and want to open a
document file that’s stored in a shared folder on your network. All you have
to do is use the Open command to bring up the dialog box. (In Office 2003,
this command is on the File menu. In Office 2007, you'll find it by clicking the
Office button.) Choose Network in the list that appears in the pane on the left
side of the Open dialog box to browse the network, as shown in Figure 2-4.
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<® If you're using Windows 95 or Windows 98, My Network Places is referred to

as Network Neighborhood. When you call up the Network Neighborhood in
Windows 95 or Windows 98, you're immediately greeted by a list of com-
puters available on your network. You can then click one of the computers to
access its shared drives and folders.
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Mapping Network Drives

|
Figure 2-5:
The Map
Network
Drive dialog
box.
|

If you often access a particular shared folder, you may want to use the special
trick known as mapping to access the shared folder more efficiently. Mapping
assigns a drive letter to a shared folder. Then you can use the drive letter to
access the shared folder as though it were a local drive. In this way, you can
access the shared folder from any Windows program without having to
browse the network.

For example, you can map a shared folder named Data on the server named
LSERVERO1 Files to drive K on your computer. Then, to access files stored in
the shared Data folder, you look on drive K.

To map a shared folder to a drive letter in Windows Vista, follow these steps:

1. Choose Start~>Computer.
This step opens the Computer window.
2. Click the Map Network Drive button located on the toolbar.

This action summons the Map Network Drive dialog box, as shown in
Figure 2-5.

) %4 Map Network Drive

What network folder would you like to map?

Specify the drive letter for the connection and the folder that you want to connect to:

Drive: Z - |
Folder: ¥ Browse... |

Example: V\server\share

[¥] Reconnect at logon
Chinneet issin s different (es e

Connect to 3 Web site that vou can use to store vour documents and pictures.

Cancel
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|
Figure 2-6:
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3

3. Change the drive letter in the Drive drop-down list, if you want.

You probably don’t have to change the drive letter that Windows selects
(in Figure 2-5, drive Z). If you're picky, though, you can select the drive
letter from the Drive drop-down list.

4. Click the Browse button.

This step summons the dialog box, as shown in Figure 2-6.

Browse For Folder [éj

Select a shared network folder

EF Network
a8 | SERVEROL
4 Data
4 netlogon
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w0 Printers
1M WKO7-001

| Make New Folder ‘ | OK ] | Cancel

5. Use the Browse for Folder dialog box to find and select the shared
folder you want to use.

You can navigate to any shared folder on any computer in the network.
6. Click OK.

The Browse for Folder dialog box is dismissed, and you return to the
Map Network Drive dialog box (refer to Figure 2-5).

7. If you want this network drive to be automatically mapped each time
you log on to the network, select the Reconnect at Logon check box.

If you leave the Reconnect at Logon check box deselected, the drive
letter is available only until you shut down Windows or log off the net-
worKk. If you select this option, the network drive reconnects automati-
cally each time you log on to the network.

Be sure to select the Reconnect at Logon check box if you use the net-
work drive often.

8. Click OK.

You return to the Computer folder, as shown in Figure 2-7. Here, you can
see the newly mapped network drive.
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Your network administrator may have already set up your computer with one
or more mapped network drives. If so, you can ask her to tell you which net-
work drives have been mapped. Or, you can just open the Computer folder
(My Computer on Windows XP) and have a look.

Here are a few additional tips:

v If you're using Windows XP, the procedure for mapping a network drive
is similar to the one for Windows Vista. Start by opening My Computer
and choosing Tools=>Map Network drive. Then follow the preceding set
of steps starting at Step 3.

v~ Assigning a drive letter to a network drive is called mapping the drive, or
linking the drive, by network nerds. “Drive H is mapped to a network
drive,” they say.

v Network drive letters don’t have to be assigned the same way for every
computer on the network. For example, a network drive that’s assigned
drive letter H on your computer may be assigned drive letter Q on some-
one else’s computer. In that case, your drive H and the other computer’s
drive Q refer to the same data. This arrangement can be confusing. If
your network is set up this way, put pepper in your network administra-
tor’s coffee.

v Accessing a shared network folder through a mapped network drive is

much faster than accessing the same folder by browsing the network.
That’s because Windows has to browse the entire network to list all
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available computers whenever you browse the network. In contrast,
Windows doesn’t have to browse the network to access a mapped net-
work drive.

v If you select the Reconnect at Logon option for a mapped drive, you
receive a warning message if the drive isn’t available when you log on. In
most cases, the problem is that the server computer isn’t turned on.
Sometimes, however, this message is caused by a broken network con-
nection. For more information about fixing network problems such as
this one, refer to Chapter 19.

Using a Network Printer

Using a network printer is much like using a network hard drive: You can print
to a network printer from any Windows program by choosing the Print com-
mand to call up a Print dialog box from any program and choosing a network
printer from the list of available printers. (In Office XP, this command is under
the File menu. In Office 2007, you can reach it by clicking the Office button.)

Keep in mind, however, that printing on a network printer isn’t exactly the
same as printing on a local printer — you have to take turns. When you print
on a local printer, you're the only one using it. When you print to a network
printer, however, you are (in effect) standing in line behind other network
users, waiting to share the printer. This line complicates the situation in sev-
eral ways:

v~ If several users print to the network printer at the same time, the net-
work has to keep the print jobs separate from one another. If it didn’t, the
result would be a jumbled mess, with your 168-page report getting mixed
in with the payroll checks. That would be bad. Fortunately, the network
takes care of this situation by using the fancy print spooling feature.

+ Network printing works on a first-come, first-served basis (unless you
know some of the tricks that I discuss in Chapter 3). Invariably, when |
get in line at the hardware store, the person in front of me is trying to buy
something that doesn’t have a product code on it. I end up standing there
for hours waiting for someone in Plumbing to pick up the phone for a price
check. Network printing can be like that. If someone sends a two-hour
print job to the printer before you send your half-page memo, you have
to wait.

+ You may have access to a local printer and several network printers.
Before you were forced to use the network, your computer probably had
just one printer attached to it. You may want to print some documents
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on your cheap (oops, | mean local) inkjet printer but use the network
laser printer for important stuff. To do that, you have to find out how to
use your programs’ functions for switching printers.

Adding a network printer

Before you can print to a network printer, you have to configure your computer
to access the network printer that you want to use. From the Start menu, open
the Control Panel and then double-click the Printers icon. If your computer is
already configured to work with a network printer, an icon for the network
printer (see the icon in the margin) appears in the Printers folder. You can tell
a network printer from a local printer by the shape of the printer icon. Network
printer icons have a pipe attached to the bottom of the printer.

If you don’t have a network printer configured for your computer, you can add
one by using the Add Printer Wizard. Just follow these steps for Windows Vista:
1. Choose Start=>Control Panel and then double-click the Printers icon.

2. Click the Add a Printer button on the toolbar.
This step starts the Add Printer Wizard, as shown in Figure 2-8.

=5
S/ = Add Printer
Choose a local or network printer
2 Add a local printer
Use this option only if you don’t have a USB printer. (Windows automatically
installs USB printers when you plug them in.)
. % Add a network, wireless or Bluetooth printer !
H IMake sure that your computer is connected to the network, or that your Bluetooth :
or wireless printer is turned on.
Next | Cancel

3. Select the Add a Network, Wireless or Bluetooth Printer option.

The wizard searches the network for available printers and displays a
list of the printers it finds, as shown in Figure 2-9.
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3

|
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4. Click the printer you want to use.

If you can’t find the printer you want to use, ask your network adminis-
trator for the printer’s UNC path, which is the name used to identify the
printer on the network, or its IP address. Then click The Printer That I
Want Isn’t Listed and enter the UNC or IP address for the printer when
prompted.

y ®=  Add Printer

Select a printer

-_— Search again

@ The printer that I want isn't listed

Mext | Cancel

. Click Next to add the printer.

The wizard copies to your computer the correct printer driver for the
network printer. (You may be prompted to confirm that you want to add
the driver. If so, click Install Driver to proceed.)

The Add Printer Wizard displays a screen that shows the printer’s name
and asks whether you want to designate the printer as your default printer.

6. If you want, designate the printer as your default printer.

7. Click Next to continue.

A final confirmation dialog box is displayed.

. Click Finish.

You're done!

Many network printers, especially newer ones, are connected directly to the
network by using a built-in Ethernet card. Setting up these printers can be
tricky. You may need to ask the network administrator for help in setting
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up this type of printer. (Some printers that are connected directly to the net-
work have their own Web addresses, such as Printer.CleaverFamily.
com. If that’s the case, you can often set up the printer in a click or two: Use
your Web browser to go to the printer’s Web page and then click a link that
lets you install the printer.)

Printing to a network printer

After you install the network printer in Windows, printing to the network
printer is a snap. You can print to the network printer from any Windows pro-
gram by using the Print command to summon the Print dialog box, found
under the File menu in Office 2003 or the Office button in Office 2007. For
example, Figure 2-10 shows the Print dialog box for WordPad — the free text-
editing program that comes with Windows. The available printers are listed
near the top of this dialog box. Choose the network printer from this list and
then click OK to print your document. That’s all there is to it!

o= Print L_Jé&-
General
Select Printer
% Add Printer = Microsoft XPS Documer
= Fax
BB acer]et 4100 Series B[ on LSERVERAT
% hp psc 1310 series
4 [ 1 »
Status:  Ready | Prirt to file | Preferences |
Location
Commert | Fing Prirer
Page Range
@Al Mumber of copies: 1
Pages: 1-65535 Collate
213123
Enter either a single page number or 3 single 1= 1=
page range. For example, 5-12
Pt | [ Cancel || oy |

Playing with the print queue

After you send your document to a network printer, you usually don’t have to
worry about it. You just go to the network printer and — voila/ — your
printed document is waiting for you.
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That’s what happens in the ideal world. In the real world, where you and |
live, all sorts of things can happen to your print job between the time you
send it to the network printer and the time it prints:

v+ You discover that someone else already sent a 50-trillion-page report
ahead of you that isn’t expected to finish printing until the national debt
is paid off.

v The price of a framis valve suddenly goes up by $2, rendering foolish the
recommendations you made in your report.

v Your boss calls and tells you that his brother-in-law will be attending the
meeting, so won’t you please print an extra copy of the proposal for him.
Oh, and a photocopy won'’t do. Originals only, please.

v You decide to take lunch, so you don’t want the output to print until you
get back.

Fortunately, your print job isn’t totally beyond your control just because you
already sent it to the network printer. You can easily change the status of
jobs that you already sent. You can change the order in which jobs print,
hold a job so that it doesn’t print until you say so, or cancel a job.

You can probably make your network print jobs do other tricks, too — such
as shake hands, roll over, and play dead. But the basic tricks — hold, cancel,
and change the print order — are enough to get you started.

To play with the printer queue, open the Control Panel (choose Start=>
Control Panel) and click Printers. Then double-click the icon for the printer
that you want to manage. A window similar to the one shown in Figure 2-11
appears. You can see the bad news: Some clown named dlowe has just
started a 308-page report from Microsoft Word. You have to wait for this
report to finish before you can print your little 1-page memo.

= HP LaserJet 4100 Series PCL on LSERVEROL = ]
Printer Document  View
Document Mame Status Owner Pages Size
I @] Microsoft Word - Really Long Report Printing dlowe 308 234 KB
Figure 2-11:
Managing a
print queue. |- i
1 document(s) in queue
|

To manipulate the print jobs that appear in the print queue or in the printer
itself, use these tricks:

v To temporarily stop a job from printing: Select the job and choose the
Document=>Pause Printing command. Choose the same command again
to release the job from its state of frustration and print it out, already.
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v To delete a print job: Select the job and choose the Document=>
Cancel Printing command.

v To stop the printer: Choose the Printer~>Pause Printing command. To
resume, choose the command again.

1 To delete all print jobs: Choose the Printer=>Purge Print Documents
command.

v To cut to the front of the line: Drag to the top of the list the print job
that you want to print.

All these tips apply to only your own print jobs. Unfortunately, you can’t
capriciously delete other people’s print jobs.

The best thing about Windows printer management is that it shelters you from
the details of working with different network operating systems. Whether

you print on a NetWare printer, a Windows 2003 network printer, or a shared
Windows printer, the Printer window icon manages all print jobs in the

same way.

Logging Off the Network

MBER
“&
&

After you finish using the network, you should log off. Logging off the net-
work makes the network drives and printers unavailable. Your computer is
still physically connected to the network (unless you cut the network cable
with pruning shears; it’s a bad idea — don’t do it!), but the network and its
resources are unavailable to you.

Here are a few other tips to keep in mind when you log off:

v After you turn off your computer, you're automatically logged off the net-
work. After you start your computer, you have to log on again.

Logging off the network is a good idea if you're going to leave your com-
puter unattended for a while. As long as your computer is logged in to
the network, anyone can use it to access the network. And, because
unauthorized users can access it under your user ID, you get the blame
for any damage they do.

»* In Windows, you can log off the network by clicking the Start button and
choosing the Log Off command. This process logs you off the network
without restarting Windows:

¢ In Windows XP, you can reach this command directly from the
Start menu.

¢ In Windows Vista, click Start and then click the right-facing arrow
that appears next to the little padlock icon.
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Chapter 3
More Ways to Use Your Network

In This Chapter

Transforming your computer into a network server

Sharing folders with network users
Using the Public Folder in Windows Vista
Sharing your printer

Using Microsoft Office on a network
Working with offline files

C hapter 2 introduces you to the basics of using a network: logging on,
accessing data on shared network folders, printing, and logging off. In
this chapter, we go beyond these basics. You'll find out how to turn your
computer into a server that shares its own files and printers, how to use one
of the most popular network computer applications — e-mail — and how to
work with Office on a network.

Sharing Vour Stuff

As you probably know, networks consist of two types of computers: client
computers and server computers. In the economy of computer networks,
client computers are the consumers — the ones that use network resources,
such as shared printers and disk drives. Servers are the providers — the ones
that offer their own printers and hard drives to the network so that the client
computers can use them.

This chapter shows you how to turn your humble Windows client computer
into a server computer so that other computers on your network can use
your printer and any folders that you decide you want to share. In effect,
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your computer functions as both a client and a server at the same time.
A couple of examples show how:

v It’s a client when you send a print job to a network printer or when you
access a file stored on another server’s hard drive.

v It's a server when someone else sends a print job to your printer or
accesses a file stored on your computer’s hard drive.

Enabling File and Printer
Sharing (Windows XP)

Before you can share your files or your printer with other network users, you
must set up a Windows feature known as File and Printer Sharing. Without
this feature installed, your computer can be a network client but not a server.
This section shows you how to enable this feature for Windows XP. For
Windows Vista, refer to the next section, “Enabling File and Printer Sharing
(Windows Vista).”

If you're lucky, the File and Printer Sharing feature is already set up on your
computer. To find out, double-click the My Computer icon on your desktop.
Select the icon for your C drive and then click File on the menu bar to reveal
the File menu. If the menu includes a Sharing command, File and Printer
Sharing is already set up, so you can skip the rest of this section. If you can’t
find a Sharing command on the File menu, you have to install File and Printer
Sharing before you can share a file or printer with other network users.

To enable File and Printer Sharing on a Windows XP system, follow these steps:

1. From the Start menu, choose Settings=>Control Panel.
The Control Panel comes to life.

2. Double-click the Network icon.
The Network dialog box appears, as shown in Figure 3-1.

3. Click the File and Print Sharing button.
This action summons the File and Print Sharing dialog box.

4. Click the File and Print Sharing options you want to enable for your
computer.

The first option enables you to share your files with other network
users; the second allows you to share your printer. To share both your
files and your printer, select both check boxes.
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5. Click OK to dismiss the File and Print Sharing dialog box.
You return to the Network dialog box.
6. Click OK to dismiss the Network dialog box.

The Network dialog box vanishes, and a Copy Progress dialog box
appears and lets you know that Windows is copying the files required to
enable File and Print Sharing. If you're prompted to insert the Windows
CD-ROM, do so with a smile.

After all the necessary files have been copied, you see a dialog box
informing you that you must restart your computer for the new settings
to take effect.

7. Click Yes to restart your computer.

Your computer shuts down and then restarts. Your computer may take a
minute or so to restart, so be patient. When your computer comes back
to life, you're ready to share files or your printer.

While you’re working in the Network dialog box, don’t mess around with any
of the other network settings. You can safely change the File and Print
Sharing options, but you should leave the rest of the settings in the Network
dialog box well enough alone.
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Enabling File and Printer Sharing
(Windows Vista)

To enable file and printer sharing in Windows Vista, follow these steps:

1. Choose Start~>Network.
This step opens the Network folder.
2. Click the Network and Sharing Center button on the toolbar.

This step opens the Network and Sharing Center, as shown in Figure 3-2.
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3. Click File Sharing.

This step reveals the controls that enable you to activate file sharing, as
shown in Figure 3-3.

4. Select the Turn On File Sharing option and then click Apply.
This file sharing feature is activated.
5. Select the Printer Sharing option.
This step reveals the controls that enable you to activate printer sharing.
6. Select the Turn On Printer Sharing option and then click Apply.
This file sharing feature is activated.
7. Close the Network and Sharing Center folder.

You'’re done; you can now share your files and printers.
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Sharing a Folder

To enable other network users to access files that reside on your hard drive,
you must designate a folder on the drive as a shared folder. Note that you can
also share an entire drive, if you so desire. If you share an entire drive, other
network users can access all the files and folders on the drive. If you share a
folder, network users can access only those files that reside in the folder you
share. (If the folder you share contains other folders, network users can
access files in those folders, too.)

QNING/ Don’t share an entire hard drive, unless you want to grant everyone on the
Y network the freedom to sneak a peek at every file on your hard drive. Instead,
you should share just the folder or folders containing the specific documents
that you want others to be able to access. For example, if you store all your
Word documents in the My Documents folder, you can share your My Docu-
ments folder so that other network users can access your Word documents.

Sharing a folder in Windows XP

To share a folder on a Windows XP computer, follow these steps:

1. Double-click the My Computer icon on your desktop.

The My Computer window comes to center stage.
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2. Select the folder that you want to share.

Click the icon for the drive that contains the folder you want to share,
and then find the folder itself and click it.

3. Choose the Filew>Sharing and Security command.

The Properties dialog box for the folder that you want to share appears.
Notice that the sharing options are grayed out.

4. Select the Share This Folder on the Network option.

After you select this option, the rest of the sharing options come alive,
as shown in Figure 3-4.

s . I .
If you prefer, you can skip Steps 2 through 4. Instead, just right-click the
folder you want to share and then choose Sharing and Security from the
pop-up menu that appears.
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5. Change the share name if you don’t like the name that Windows
proposes.

The share name is the name that other network users use to access the
shared folder. You can give it any name you want, but the name can be
no more than 12 characters long. Uppercase and lowercase letters are
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treated the same in a share name, so the name My Documents is the
same as MY DOCUMENTS.

Windows proposes a share name for you, based on the actual folder
name. If the folder name has 12 or fewer characters, the proposed share
name is the same as the folder name. If the folder name is longer than
12 characters, however, Windows abbreviates it. For example, the name
Multimedia Files becomes MULTIMEDIA F.

If the name that Windows chooses doesn’t make sense or seems cryptic,
you can change the share name to something better. For example, |
would probably use MEDIA FILES rather than MULTIMEDIA F.

. If you want to allow other network users to change the files in this

folder, select the Allow Network Users to Change My Files check box.

If you leave this option deselected, other network users can open your
files, but they can’t save any changes they make.

. Click OK.

The Properties dialog box vanishes, and a hand is added to the icon for
the folder to show that the folder is shared.

If you change your mind and decide that you want to stop sharing a folder,
double-click the My Computer icon, select the folder or drive that you want
to stop sharing, and choose the Filem>Sharing command to summon the
Properties dialog box. Deselect the Share This Folder on the Network check
box and then click OK.

Sharing a folder in Windows Vista

To share a folder in Windows Vista, follow these steps:

1. Choose Start~>Computer.

The Computer folder comes to center stage.

2. Select the folder that you want to share.

Click the icon for the drive that contains the folder you want to share,
and then find the folder itself and click it.

3. Click the Sharing button on the toolbar.

The File Sharing dialog box appears, as shown in Figure 3-5.

b7
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4. Click the arrow in the drop-down list and choose Everyone, and then
click Add.

This action designates that anyone on your network can access the
shared folder.

If you prefer, you can limit access to just certain users. To do so, select
each person you want to grant access to and then click Add.

5. Select the level of access you want to grant each user.
You can choose from three levels of access:

* Reader: A reader can open files but can’t modify or create new
files or folders.

¢ Contributor: A contributor can add files to the share but can
change or delete only her own files.

¢ Co-owner: A co-owner has full access to the shared folder. He can
create, change, or delete any file in the folder.

6. Click Share.

The dialog box shown in Figure 3-6 is displayed to confirm that the
folder has been shared.

Using the Public Folder in Windows Vista

Windows Vista introduces a new way of sharing files on the network: the
Public folder. The Public folder is simply a folder that’s designated for public
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access. Files you save in this folder can be accessed by other users on the
network and by any user who logs on to your computer.

Before you can use the Public folder, you must enable it by following these
steps:
1. Choose Start=>Network.
This step brings up the Network folder.
2. Click the Network and Sharing Center button on the toolbar.
This step brings up the Network and Sharing Center. (Refer to Figure 3-2.)
3. Select the Public Folder Sharing option.

This step reveals the controls that enable you to activate Public folder
sharing. You have three options for sharing the Public folder:

¢ Turn on sharing so that anyone with network access can open
files. This option shares the Public folder as read-only, so other
users can open files but can’t modify or delete them or create their
own files.

¢ Turn on sharing so that anyone with network access can open,
change, or create files. This option grants full access to the Public
folder.

¢ Turn off sharing. This option turns off Public folder sharing.

=
@ 2 File Sharing
Your folder is shared.
You may £-mzil these links to notify people that you have shared these files, or copy the links onto the
Windows clipboard, where you can paste them into any program you choose,
| Shared Data (\\WKO07-001)
catl, \\WKO7-001\Shared Data
Show me all the network shares on this computer.
Done
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4. Select the level of sharing you want to use and then click Apply.
The Public Folder sharing feature is activated.
5. Close the Network and Sharing Center folder.
You're done; you can now share your files and printers.
After you enable Public folder sharing, you can access the Public folder on
your own computer by choosing Startz>Computer and then clicking the

Public icon in the pane on the left side of the window. This action opens the
Public folder, as shown in Figure 3-7.
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As you can see, the Public folder includes several predefined subfolders
designed for sharing documents, downloaded files, music, pictures, and
videos. You can use these subfolders if you want, or you can create your own
subfolders to help organize the data in your Public folder.

To access the Public folder of another computer, use the techniques
described in Chapter 2 to either browse to the Public folder or map it to a
network drive.

Sharing a Printer

Sharing a printer is much more traumatic than sharing a hard drive. When
you share a hard drive, other network users access your files from time to
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time. When they do, you hear your drive click a few times, and your com-
puter may hesitate for a half-second or so. The interruptions caused by other
users accessing your drive are sometimes noticeable, but rarely annoying.

When you share a printer, you get to see Murphy’s Law in action: Your co-
worker down the hall is liable to send a 140-page report to your printer just
moments before you try to print a 1-page memo that has to be on the boss’s
desk in two minutes. The printer may run out of paper or, worse, jam during
someone else’s print job — and you're expected to attend to the problem.

Although these interruptions can be annoying, sharing your printer makes a
lot of sense in some situations. If you have the only decent printer in your
office or workgroup, everyone will bug you to let them use it anyway. You
may as well share the printer on the network. At least this way, they won’t
line up at your door to ask you to print their documents for them.

Sharing a printer in Windows XP

The following procedure shows you how to share a printer in Windows XP:

1. From the Start menu, choose Printers and Faxes.

The Printers and Faxes folder appears, as shown in Figure 3-8. In this
example, the Printers folder lists a single printer, named HP PSC 750.

","
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Figure 3-8: other Places
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2. Select the printer that you want to share.

Click the icon for the printer to select the printer.
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3. Choose Filec>Sharing.

You're right: This command doesn’t make sense. You're sharing a printer,
not a file, but the Sharing command is on the File menu. Go figure.

When you choose the Filec>Sharing command, the Properties dialog box
for the printer appears.

4. Select the Share This Printer option.

5. Change the share name if you don’t like the name suggested by

Windows.

Other computers use the share name to identify the shared printer, so
choose a meaningful or descriptive name.

6. Click OK.

You return to the Printers folder, where a hand is added to the printer icon to
show that the printer is now a shared network printer.

To take your shared printer off the network so that other network users can’t
access it, follow Steps 1 through 3 in the preceding set of steps to open the
Printer Properties dialog box. Select the Do Not Share This Printer option and
then click OK. The hand disappears from the printer icon, to indicate that the
printer is no longer shared.

Sharing a printer in Windows Vlista

To share a printer in Windows Vista, follow these steps:

1.

From the Start menu, choose Control Panel, and then double-click the
Printers icon.

The Printers folder appears.

. Right-click the printer that you want to share and choose Sharing.

The Properties dialog box for the printer appears with the Sharing tab
selected, as shown in Figure 3-9. Notice that the options for sharing the
printer are disabled.

. Click the Change Sharing Options button.

Because Windows Vista’s is annoyingly suspicious of what you’re doing,
a dialog box appears, asking for your permission to change the printer
sharing settings.

. Click Continue.

You return to the Properties dialog box, this time with the printer shar-
ing options enabled.

. Select the Share This Printer option.
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6. Change the share name if you don’t like the name suggested by
Windows.

Because other computers will use the share name to identify the shared
printer, pick a descriptive name.

7. Click OK.

You return to the Printers folder. The icon for the printer is modified to
indicate that it has been shared.

To take your shared printer off the network so that other network users can’t
access it, follow Steps 1 through 6 in the preceding set of steps. Uncheck the
Share This Printer check box and then click OK.

Using Microsoft Office on a Network

Microsoft Office is far and away the most popular suite of application pro-
grams used on personal computers, and it includes the most common types
of application programs used in an office: a word processing program (Word),
a spreadsheet program (Excel), a presentation program (PowerPoint), and

an excellent e-mail program (Outlook). Depending on the version of Office
you purchase, you may also get a database program (Access), a Web-site
development program (FrontPage), a desktop publishing program (Publisher),
a set of Ginsu knives (KnifePoint), and a slicer and dicer (ActiveSalsa).

This section describes the networking features of Microsoft Office System
2007, the latest and greatest version of Office. Most of these features also
work with previous versions of Office.
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To get the most from using Office on a network, you should purchase the
Microsoft Office Resource Kit. The Office Resource Kit, also known as ORK,
contains information about installing and using Office on a network and comes
with a CD that has valuable tools. If you don’t want to purchase the ORK, you
can view it online and download the ORK tools from the Microsoft TechNet
Web site (www.microsoft.com/technet). Nanoo-nanoo, earthling.

Installing Office on a network —
some options

You need to make some basic decisions when you prepare to install Microsoft
Office on a network. In particular, here are some possible approaches to
installing Microsoft Office on your network clients:

»* You can simply ignore the fact that you have a network and purchase a
separate copy of Office for each user on the network. Then you can
install Office from the CD on each computer. This option works well if

* Your network is small.

¢ Each computer has ample disk space to hold the necessary
Office files.

¢ Each computer has its own CD-ROM drive.

v On a larger network, you can use the Office Setup program in Administra-
tive Setup mode. This option lets you create a special type of setup on a
network server disk from which you can install Office on network com-
puters. Administrative Setup enables you to control the custom features
selected for each network computer and reduce the amount of user
interaction required to install Office on each computer.

If you choose to use Administrative Setup, you can use the Network
Installation Wizard, which comes with the Office Resource Kit. The
Network Installation Wizard lets you customize settings for installing
Office on client computers. For example, you can choose which Office
components to install, provide default answers to yes/no questions that
Setup asks the user while installing Office, and select the amount of
interaction you want the Setup program to have with the user while
installing Office.

No matter which option you choose for installing Office on your network, you
must purchase either a copy of Office or a license to install Office for every
computer that uses Office. Purchasing a single copy of Office and installing it
on more than one computer is illegal.
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Figure 3-10:
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Accessing network files

Opening a file that resides on a network drive is almost as easy as opening

a file on a local drive. All Office programs use the File>Open command to
summon the Open dialog box, as shown in its Excel incarnation in Figure 3-10.
(The Open dialog box is nearly identical in other Office programs.)
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To access a file that resides on a network volume that’s mapped to a drive
letter, all you have to do is use the drop-down list at the top of the dialog box
to select the network drive. If the network volume isn’t mapped to a drive,
click Folders near the lower-left corner of the Open dialog box, select Network,
and then browse to the file you want to open.

You can map a network drive directly from the Open dialog box by navigating
to the folder you want to map, right-clicking the folder, and choosing Map
Network Drive.

If you try to open a file that another network user has opened already, Office
tells you that the file is already in use and offers to let you open a read-only
version of the file. You can read and edit the read-only version, but Office
doesn’t let you overwrite the existing version of the file. You have to use the
Save As command instead to save your changes to a new file.

Using workgroup templates

A template isn’t a place of worship, although an occasional sacrifice to the
Office gods may make your computing life a bit easier. Rather, a template is a
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special type of document file that holds formatting information, boilerplate text,
and other customized settings that you can use as the basis for new documents.

Three Office programs — Word, Excel, and PowerPoint — enable you to spec-
ify a template whenever you create a new document. When you create a new
document in Word, Excel, or PowerPoint by choosing the File>"New command,
you see a dialog box that lets you choose a template for the new document.

Office comes with a set of templates for the most common types of documents.
These templates are grouped under the various tabs that appear across the
top of the New dialog box.

In addition to the templates that come with Office, you can create your own
templates in Word, Excel, and PowerPoint. Creating your own templates is
especially useful if you want to establish a consistent look for documents pre-
pared by your network users. For example, you can create a Letter template
that includes your company’s letterhead, or a Proposal template that
includes a company logo.

Office enables you to store templates in two locations. Where you put them
depends on what you want to do with them:

v The User Templates folder on each user’s local disk drive: If a particu-
lar user needs a specialized template, put it here.

v The Workgroup Templates folder on a shared network drive: If you
have templates that you want to make available to all network users on
the network server, put them here. This arrangement still allows each
user to create templates that aren’t available to other network users.

When you use both a User Templates folder and a Workgroup Templates
folder, Office combines the templates from both folders and lists them in
alphabetical order in the New dialog box. For example, the User Templates
folder may contain templates named Blank Document and Web Page, and

the Workgroup Templates folder may contain a template named Company
Letterhead. In this case, three templates appear in the New dialog box, in this
order: Blank Document, Company Letterhead, and Web Page.

To set the location of the User Templates and Workgroup Templates folders,
follow these steps in Microsoft Word:

1. Click the Office button and then click Word Options.
The Word Options dialog box opens.
2. Click the Advanced tab.

The Advanced options appear.
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3. Scroll down to the General section and then click the File Locations
button.

The File Locations dialog box appears, as shown in Figure 3-11.

File Locations |i‘—i_hJ
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File types: Location:
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Startup Ci\o.. WMicrosoft\Word\STARTUP
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Figure 3-11:
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4. Double-click the Workgroup Templates item.
This step opens a dialog box that lets you browse to the location of your
template files.
5. Browse to the template files and then click OK.
You return to the File Locations dialog box.
6. Click OK to dismiss the File Locations dialog box.
You return to the Word Options dialog box.
7. Click OK again.
The Word Options dialog box is dismissed.
QP Although the User Templates and Workgroup Templates settings affect Word,

Excel, and PowerPoint, you can change these settings only from Word. The
Options dialog boxes in Excel and PowerPoint don’t show the User Templates
or Workgroup Templates options.

When you install Office, the standard templates that come with Office are
copied into a folder on the computer’s local disk drive, and the User Templates
option is set to this folder. The Workgroup Templates option is left blank. You
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can set the Workgroup Templates folder to a shared network folder by click-
ing Network Templates, clicking the Modify button, and specifying a shared
network folder that contains your workgroup templates.

Networking an Access database

If you want to share a Microsoft Access database among several network
users, you should be aware of a few special considerations. Here are the
more important ones:

v When you share a database, more than one user may try to access the
same record at the same time. This situation can lead to problems if two
or more users try to update the record. To handle this potential traffic
snarl, Access locks the record so that only one user at a time can update
it. Access uses one of three methods to lock records:

¢ Edited Record: This method locks a record whenever a user
begins to edit a record. For example, if a user retrieves a record in
a form that allows the record to be updated, Access locks the
record while the user edits it so that other users can’t edit the
record until the first record is finished.

No Locks: This method doesn’t really mean that the record isn’t
locked. Instead, No Locks means that the record isn’t locked until a
user writes a change to the database. This method can be confus-
ing to users because it enables one user to overwrite changes
made by another user.

All Records: All Records locks an entire table whenever a user
edits any record in the table.

v Access lets you split a database so that the forms, queries, and reports
are stored on each user’s local disk drive, but the data itself is stored on
a network drive. This feature can make the database run more efficiently
on a network, but it’s a little more difficult to set up. (To split a database,
use the Tools>Database Utilitiesz>Database Splitter command.)

v Access includes built-in security features that you should use if you
share an Access database from a Windows client computer, such as one
running Windows XP or Windows Vista. If you store the database on a
domain server, you can use the server’s security features to protect the
database.

v Access automatically refreshes forms and datasheets every 60 seconds.
That way, if one user opens a form or datasheet and another user
changes the data a few seconds later, the first user sees the changes
within one minute. If 60 seconds is too long (or too short) an interval,
you can change the refresh rate by using the Advanced tab in the
Options dialog box.
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Working with Offline Files

Desktop computers are by nature stationary beasts. As a result, they’re almost
always connected to their networks. Notebook computers, however, are more
transitory. If you have a notebook computer, you're likely to tote it around
from place to place. If you have a network at work, you probably connect to
the network when you’re at work. But then you take the notebook computer
home for the weekend, where you aren’t connected to your network.

Of course, your boss wants you to spend your weekends working, so you
need a way to access your important network files while you're away from
the office and disconnected from the network. That’s where the offline files
feature comes in. It lets you access your network files even while you're dis-
connected from the network.

It sounds like magic, but it isn’t really. Imagine how you would work away
from the network without this feature. You simply copy the files you need to
work on to your notebook computer’s local hard disk. Then, when you take
the computer home, you work on the local copies. When you get back to the
office, you connect to the network and copy the modified files back to the
network server.

That’s essentially how the offline files feature works, except that Windows
does all the copying automatically. Windows also uses smoke and mirrors to
make it look like the copies are actually on the network, even though you're
not connected to the network. For example, if you map a drive (drive M, for
example) and make it available offline, you can still access the offline copies
of the file on the M drive. That’s because Windows knows that when you
aren’t connected to the network, it should redirect drive M to its local copy
of the drive M files.

The main complication of working with offline files, of course, is what hap-
pens when two or more users want to access the same offline files. Windows
can attempt to straighten that mess out for you, but it doesn’t do a great job
of it. Your best bet is to not use the offline files feature with network resources
that other users may want available offline too. In other words, it’s okay to
make your home drive available offline because that drive is accessible only
to you. But I don’t recommend making shared network resources available
offline, unless they’re read-only resources that don’t contain files you intend
to modify.

Using the offline files feature is easy:

v In Windows Vista, open the Computer folder, right-click the mapped net-
work drive you want to make available offline, and then choose Always
Available Offline.

v In Windows XP, open My Computer, right-click the mapped drive, and
choose Make Available Offline.
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|
Figure 3-12:
Offline file
properties.
|

If you don’t want to designate an entire mapped drive for offline access, you
can designate individual folders within a mapped drive by using the same
technique: Right-click the folder, and then choose Always Available Offline
(Windows Vista) or Make Available Offline (Windows XP).

When you first designate a drive or folder as available offline, Windows
copies all the files on the drive or folder to local storage. Depending on how
many files are involved, this process can take awhile, so plan accordingly.

After you designate a drive as available offline, Windows takes care of the
rest. Each time you log on or off the network, Windows synchronizes your
offline files. Windows compares the time stamp on each file on both the
server and the local copy and then copies any files that have changed.

Here are a few other thoughts to consider about offline files:

v If you want, you can force Windows to synchronize your offline files by
right-clicking the drive or folder and choosing Sync.

v The Properties dialog box for mapped drives includes an Offline Files
tab, as shown in Figure 3-12.

v Employers love the offline files feature because it encourages their
employees to work at home during evenings and weekends. In fact,
every time you use the offline files feature to work at home, your boss
sends Bill Gates a nickel. That’s how he got so rich.
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Part i

Building Your Own
Network

The 5th Wave By Rich Tennant

ORICATENNANT

“That’s it ! We’re getting a wireless network
for the house.”



In this part . . .

ou discover how to build a network yourself, which

includes planning it and installing it. And you find out
what choices are available for cable types, network oper-
ating systems, and all the other bits and pieces that you
have to contend with.

Yes, some technical information is included in these
chapters. Fear not! I bring you tidings of great joy! Lo, a
working network is at hand, and you — yea, even you —
can design it and install it yourself.




Chapter 4
Planning Your Network

In This Chapter

Creating a network plan

Taking stock of your computer stock

Making sure that you know why you need a network
Making the three basic network decisions you can’t avoid
Using a starter kit

Looking at a sample network

Okay, so you're convinced that you need to network your computers.
What now? Do you stop by Computers-R-Us on the way to work, install
the network before morning coffee, and expect the network to be fully opera-
tional by noon?

I don’t think so.

Networking your computers is just like any other worthwhile endeavor: To do
it right requires a bit of planning. This chapter helps you think through your
network before you start spending money. It shows you how to come up with
a networking plan that’s every bit as good as the plan that a network consul-
tant would charge $1,000 for.

This book is already saving you money!

Making a Network Plan

Before you begin any networking project, whether it’s a new network installa-
tion or an upgrade of an existing network, first make a detailed plan. If you
make technical decisions too quickly, before studying all the issues that
affect the project, you'll regret it. You’'ll discover too late that a key applica-
tion doesn’t run over the network, that the network has unacceptably slow
performance, or that key components of the network don’t work together.
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Here are some general thoughts to keep in mind while you create your net-
work plan:

+* Don’t rush the plan. The most costly networking mistakes are the ones
you make before you install the network. Think things through and con-
sider alternatives.

v Write down the network plan. The plan doesn’t have to be a fancy, 500-
page document. If you want to make it look good, pick up a %4-inch three-
ring binder — big enough to hold your network plan with room to spare.

v Ask someone else to read your network plan before you buy anything.
Preferably, ask someone who knows more about computers than you do.

v Keep the plan up-to-date. If you add to the network, dig up the plan,
dust it off, and update it.

P “The best-laid schemes of mice and men gang oft agley, and leave us not but
grief and pain for promised joy.” Robert Burns lived a couple hundred years
before computer networks, but his famous words ring true. A network plan
isn’t chiseled in stone. If you discover that something doesn’t work the way
you thought it would, that’s okay. You can always adjust your plan for unfore-
seen circumstances.

Being Purposeful

One of the first steps in planning your network is making sure that you under-
stand why you want the network in the first place. Here are some of the more
common reasons for needing a network, all of them quite valid:

v My co-worker and I exchange files using a flash drive just about every
day. With a network, we could trade files without using the flash drive.

v 1 don’t want to buy everyone a printer when I know that the one we have
now just sits there taking up space most of the day. Wouldn’t buying a
network be better than buying a printer for every computer?

v [ want to provide an Internet connection for all my computers. Many net-
works, especially smaller ones, exist solely for the purpose of sharing an
Internet connection.

v Someone figured out that we’re destroying seven trees a day by printing
interoffice memos on paper, so we want to give the rainforest a break by
setting up an e-mail system and trying to print less of the routine stuff.

It won’t work! One of the inescapable laws of business is that the more
you try to eliminate paperwork, the more paperwork you end up creating.
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v Business is so good that one person typing in orders eight hours each
day can’t keep up. With a network, I can have two people entering
orders, and I don’t have to pay overtime to either person.

v My brother-in-law just put in a network at his office, and I don’t want him
to think that I'm behind the times.

Make sure that you identify all the reasons why you think you need a network
and then write them down. Don’t worry about winning the Pulitzer Prize for
your stunning prose. Just make sure that you write down what you expect a
network to do for you.

If you were making a 500-page networking proposal, you would place the
description of why a network is needed in a tabbed section labeled Justification.
In your %-inch network binder, file the description under Purpose.

When you consider the reasons why you need a network, you may conclude
that you don’t need a network after all. That’s okay. You can always use the
binder for your stamp collection.

Taking Stock

One of the most challenging parts of planning a network is figuring out how
to work with the computers you already have — how do you get from here to
there? Before you can plan how to get “there,” you have to know where “here”
is: Take a thorough inventory of your current computers.

What you need to know

You need to know the following information about each of your computers:

v~ The processor type and, if possible, its clock speed: Hope that all your
computers are 2GHz Pentium 4s or better. But in most cases, you find a
mixture of computers — some new, some old, some borrowed, some
blue. You may even find a few archaic pre-Pentium computers, which
should be converted to beehives as soon as possible.

You can’t usually tell what kind of processor a computer has just by look-
ing at the computer’s case. Most computers, however, display the proces-
sor type when you turn them on or reboot them. If the information on
the startup screen scrolls too quickly for you to read it, try pressing the
Pause key to freeze the information. After you finish reading it, press the
Pause key again so that your computer can continue booting.
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v The size of the hard drive and the arrangement of its partitions: In
Windows, you can find out the size of your computer’s hard drive by
opening the My Computer window, right-clicking the drive icon, and
choosing the Properties command from the shortcut menu that appears.
Figure 4-1 shows the Properties dialog box for a 149GB hard drive that
has 137GB of free space.

& Local Disk (C:) Properties @
_Security | Previous Versions | Quota
General Tools | Hadwae |  Shamg
|
& |
Figure 4-1:
The Type. Local Disk
. Fle system:  NTFS
Properties =
. Used space 12,384 706 560 bytes  115GB
(1Ialoghb0)d( . Free space 147,654,201, 344 bytes 137GB
or a har
driVe ShOWS Capachy 160,038,907,904 bytes 143GB
the drive’s
total
capacity v [ Disk G
and the
amount Of Compress this drive to save disk space
free space 7| Index this drive for faster searching
available on
the drive. o) o)
|

If your computer has more than one hard drive or partition, Windows
lists an icon for each drive or partition in the My Computer window. Jot
down the size and amount of free space available on each of the drives.
(A partition is a section of a hard drive that’s treated as though it were a
separate drive. But that won’t be on the test.)

v The amount of memory: In Windows, you can find out this information
easily enough by right-clicking the My Computer desktop icon and
choosing the Properties command. The amount of memory on your
computer appears in the dialog box that appears. For example, Figure
4-2 shows the System Properties dialog box for a computer running
Windows XP Professional with 2GB of RAM.

v~ The version of the operating system that’s installed: You can determine
the version by checking the System Properties dialog box. For example,
Figure 4-2 shows the System Properties dialog box for a computer run-
ning Windows Vista Business Edition.
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v~ The type of network interface installed in the computer: To find out
the exact name of the network interface, open the Control Panel and
double-click the System icon. Then click the Hardware tab and click the
Device Manager button. This action opens the Device Manager dialog
box, as shown in Figure 4-3. In this case, you can see that the computer’s
network interface is an Intel(R) Pro/100 VE Network Connection.
A\ . . .
The Device Manager is also useful for tracking down other hardware
devices attached to the computer or for checking which device drivers
are being used for the computer’s devices.
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v The network protocols that are in use: To determine this information,
open the Control Panel, double-click the Network Connections icon
to open the Network Connections dialog box, and then right-click the
network connection and choose the Properties command.

v The kind of printer, if any, that’s attached to the computer: Usually,
you can tell just by looking at the printer itself. You can also tell by
examining the Printers and Faxes folder.

v Any other devices connected to the computer: A CD, DVD, or CD-RW
drive? Scanner? Zip or Jaz drive? Tape drive? Video camera? Battle
droid? Hot tub?

1 Whether driver and installation disks are available: Hopefully, you can
locate the disks or CDs required by hardware devices, such as the net-
work card, printers, and scanners. If not, you may be able to locate the
drivers on the Internet.

v Which software is used on the computer: Microsoft Office? QuickBooks?
AutoCAD? Make a complete list and include version numbers.

Programs that gather information for you

Gathering information about your computers is a lot of work if you have more
than a few computers to network. Fortunately, several available software
programs can automatically gather the information for you. These programs
inspect various aspects of a computer, such as the CPU type and speed,
amount of RAM, and size of the computer’s hard drives. Then they show the
information on the screen and give you the option of saving the information
to a hard drive file or printing it.

Windows comes with just such a program: Microsoft System Information. This
program gathers and prints information about your computer. You can start
Microsoft System Information by choosing Start=>Programs=Accessories=
System Tools=>System Information.

When you fire up Microsoft System Information, you see the window shown
in Figure 4-4, which displays basic information about your computer, such as
your version of Microsoft Windows, the processor type, the amount of memory
on the computer, and the free space on each of the computer’s hard drives.
You can obtain more detailed information by clicking any of the following
options on the left side of the window: Hardware Resources, Components,
Software Environment, or Applications.
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To Dedicate, or Not to Dedicate:
That Is the Question

One of the most basic questions that a network plan must answer is whether
the network will have one or more dedicated servers or whether it will rely
completely on peer-to-peer networking, with no single computer acting as a
dedicated server. If the only reason for purchasing your network is to share a
printer and exchange an occasional file, you may not need a dedicated server
computer. In that case, you can create a peer-to-peer network by using the
computers you already have. However, all but the smallest networks benefit
from having a separate, dedicated server computer.

Here are a few points to ponder regarding dedicated versus nondedicated
servers:

v Using a dedicated server computer makes the network faster, easier to
work with, and more reliable. Consider what happens when the user of
a server computer, which doubles as a workstation, decides to turn off
the computer, not realizing that someone else is accessing files on her
hard drive.

» You don’t necessarily have to use your biggest and fastest computer as
your server computer. I've seen networks where the slowest computer on
the network is the server. This is especially true when the server is mostly
used to share a printer or to store a small number of shared files. If you
need to buy a computer for your network, consider promoting one of your
older computers to be the server and using the new computer as a client.
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Looking at Different Types of Servers

Assuming that your network will require one or more dedicated servers, you
should consider which types of servers the network needs. In some cases, a
single server computer can fill one or more of these roles. Whenever pos-
sible, try to limit each server computer to a single server function.

File servers

File servers provide centralized disk storage that can be conveniently shared
by client computers on the network. The most common task of a file server is
to store shared files and programs. For example, the members of a small
workgroup can use disk space on a file server to store their Microsoft Office
documents.

File servers must ensure that two users don’t try to update the same file at
the same time. The file servers do this by locking a file while a user updates
the file so that other users can’t access the file until the first user finishes.
For document files (for example, word processing or spreadsheet files), the
whole file is locked. For database files, the lock can be applied just to the por-
tion of the file that contains the record or records being updated.

Print servers

Sharing printers is one of the main reasons that many small networks exist.
Although it isn’t often necessary to do so, you can dedicate a server com-
puter for use as a print server, whose sole purpose is to collect information
being sent to a shared printer by client computers and print it in an orderly
fashion.

v A single computer may double as both a file server and a print server,
but performance is better if you use separate print and file server
computers.

v With an inexpensive inkjet printer running about $100 or less, just giving
each user his own printer is tempting. However, you get what you pay
for. Rather than buy a cheap inkjet printer for each user, you may be
better off buying one good laser printer and sharing it.

Web servers

A Web server is a server computer that runs software that enables the com-
puter to host an Internet Web site. The two most popular Web server programs
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are Microsoft IIS (Internet Information Services) and Apache, an open-source
Web server program managed by the Apache Software Foundation.

Mail servers

A mail server is a server computer that handles the network’s e-mail needs.
It’s configured with e-mail server software, such as Microsoft Exchange
Server. Your mail-server software must be compatible with your e-mail pro-
gram; Exchange Server, for example, is designed to work with Microsoft
Outlook, the e-mail client software that comes with Microsoft Office.

Database servers

A database server is a server computer that runs database software, such as
Microsoft SQL Server 2005. Database servers are usually used along with cus-
tomized business applications, such as accounting or marketing systems.

Choosing a Server Operating System

If you determine that your network needs one or more dedicated servers, the
next step is to determine what network operating system those servers should
use. If possible, all the servers should use the same NOS so you don’t find

yourself awash in the conflicting requirements of different operating systems.

Although you can choose from many network operating systems, from a prac-
tical point of view, your choices are limited to the following:

v Windows Server 2003 (or its forthcoming replacement, Windows
Server 2007)

v Novell NetWare

v Linux or another version of UNIX

For more information, see Chapter 7.

Planning the Infrastructure

You also need to plan the details of how you'll connect the computers in the
network. You have to determine which network topology the network will
use, which type of cable will be used, where the cable will be routed, and
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which other devices — most likely, network switches and perhaps a router —
will be needed.

Although you have many cabling options to choose from, you’ll probably use
Cat5e or better UTP for most — if not all — of the desktop client computers
on the network. However, you have many questions to answer beyond this
basic choice:

v Where will you place workgroup switches — on a desktop somewhere
within the group or in a central wiring closet?

v How many client computers will you place on each switch, and how
many switches will you need?

v If you need more than one switch, which type of cabling will you use to
connect the switches to one another?

For more information about network cabling, see Chapter 5.

If you're installing new network cable, don’t scrimp on the cable itself.
Because installing network cable is a labor-intensive task, the cost of the
cable itself is a small part of the total cable-installation cost. And, if you
spend a little extra to install higher-grade cable now, you don’t have to
replace the cable in a few years when it’s time to upgrade the network.

Drawing Diagrams

One of the most helpful techniques for creating a network plan is to draw a
picture of it. The diagram can be a detailed floor plan, showing the actual
location of each network component. This type of diagram is sometimes
called a physical map. If you prefer, the diagram can be a logical map, which is
more abstract and Picasso-like. Anytime you change the network layout,
update the diagram. Also include a detailed description of the change, the
date that the change was made, and the reason for the change.

You can diagram very small networks on the back of a napkin, but if the net-
work has more than a few computers, use a drawing program to help you
create the diagram. One of the best programs for this purpose is Microsoft
Visio, as shown in Figure 4-5.

Here’s a rundown of some of the features that make Visio useful:
v Smart shapes and connectors maintain the connections you draw

between network components, even if you rearrange the layout of the
components on the page.
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v Stencils provide dozens of useful shapes for common network
components — not just client and server computers, but also routers,
hubs, switches, and just about anything else you can imagine. If you're
picky about the diagrams, you can even purchase stencil sets that have
accurate drawings of specific devices, such as Cisco routers or IBM

mainframe computers.

» You can add information to each computer or device in the diagram, such
as the serial number or physical location. Then you can quickly print an
inventory that lists this information for each device in the diagram.

v You can easily create large diagrams that span multiple pages.

Sample Network Plans

In what’s left of this chapter, | present some network plans drawn from real-
life situations. These examples illustrate many of the network-design issues I
cover earlier in this chapter. The stories you’re about to read are true. The
names have been changed to protect the innocent.

|
Figure 4-5:
Using Visio
to create

a network
diagram.
|
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Building a small network: California
Sport Surface, Inc.

California Sport Surface, Inc. (CSS) is a small company specializing in the
installation of outdoor sports surfaces, such as tennis courts, running tracks,
and football fields. CSS has an administrative staff of just four employees who
work out of a home office. The company has three computers:

v A brand-new Dell desktop computer running Windows XP Home Edition,
shared by the president (Mark) and vice president (Julie) to prepare pro-
posals and marketing brochures, handle correspondence, and do other
miscellaneous chores. This computer has a built-in 10/100 Mbps
Ethernet network port.

v An older Gateway computer running Windows 98 Second Edition, used
by the bookkeeper (Erin), who uses QuickBooks to handle the com-
pany’s accounting needs. This computer doesn’t have a network port.

v A notebook that runs Windows XP Media Edition, used by the company’s
chief engineer (Daniel), who often takes it to job sites to help with
engineering needs. This computer has a built-in 10/100/1000 Mbps
Ethernet port.

The company owns just one printer, a moderately priced inkjet printer that’s
connected to Erin’s computer. The computers aren’t networked, so whenever
Mark, Julie, or Daniel needs to print something, that person must copy the
file to a diskette and give it to Erin, who then prints the document. The com-
puter shared by Mark and Julie is connected to the Internet by using a resi-
dential DSL connection.

The company wants to install a network to support these three computers.
Here are the primary goals of the network:

v Provide shared access to the printer so that users don’t have to
exchange diskettes to print their documents.

v Provide shared access to the Internet connection so that users can
access the Internet from any of the computers.

v Allow for the addition of another desktop computer, which the company
expects to purchase within the next six months, and potentially another
notebook computer. (If business is good, the company hopes to hire
another engineer.)

v The network should be intuitive to the users and shouldn’t require any
extensive upkeep.
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CSS’s networking needs can be met with the simple peer-to-peer network dia-
grammed in Figure 4-6.

Here’s what the network requires:

v A 10/100 Mbps Ethernet adapter card for the Gateway computer, which
is the only computer that doesn’t have a network port. (A better alterna-
tive is to replace this computer with a newer computer that runs
Windows Vista and has a built-in network interface.)

v A combination DSL router and 4-port 10/100 Mbps switch, such as the
LinkSys BEFSR41W or the Belkin F5D5231-4. The company may outgrow
this device when it adds a laptop, but if and when that happens, another
4- or 8-port 10/100 Mbps switch can be added then.

v The firewall features of the DSL router need to be enabled to protect the
network from Internet hackers.

v File and Printer Sharing needs to be activated on Erin’s computer, and
the printer needs to be shared.

Printer

DSL router/
10/100Mbps switch

DSL modem

The Internet
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Connecting two networks: Creative
Course Development, Inc.

Creative Course Development, Inc. (CCD) is a small educational publisher
located in central California that specializes in integrated math and science
curriculums for primary and secondary grades. The company publishes a
variety of course materials, including textbooks, puzzle books, and CD-ROM
software.

CCD leases two adjacent office buildings, separated only by a small court-
yard. The creative staff, which consists of a dozen writers and educators,
works in Building A. The sales, marketing, and administrative staff — all six
employees of it — works in Building B.

The product development and marketing staff has 14 relatively new personal
computers, all running Windows XP Professional, and a server computer run-
ning Windows 2000 Server. These computers are networked by a 100 Mbps
UTP network, which utilizes a single 24-port 100 Mbps switch. A fractional T1
line that’s connected to the network through a small Cisco router provides
Internet access.

The administrative staff has a hodgepodge of computers, some running
Windows 98 Second Edition, some running Windows XP, and one still running
Windows 95. The staff has a small Windows NT server that meets everyone’s
needs. The older computers have 10BaseT network cards; the newer ones
have 10/100 Mbps cards. However, the computers are all connected to a fairly
old 10 Mbps Ethernet hub with 12 ports. Internet access is provided by an
ISDN connection.

Both groups are happy with their computers and networks. The problem is
that the networks can’t communicate with each other. For example, the mar-
keting team in Building A relies on daily printed reports from the sales system
in Building B to keep track of sales, and employees frequently go to the other
building to follow up on important sales or to look into sales trends.

Although several solutions to this problem exist, the easiest is to bridge
the networks with a pair of wireless switches. To do this, CCD will purchase
two wireless access points: one to be plugged into the 100 Mbps switch in
Building A and the other to be plugged into the hub in Building B. After the
access points are configured, the two networks will function as a single net-
work. Figure 4-7 shows a logical diagram for the completed network.
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Although the wireless solution to this problem sounds simple, a number of
complications still need to be dealt with — specifically:

v Depending on the environment, the wireless access points may have
trouble establishing a link between the buildings. It may be necessary to
locate the devices on the roof. In that case, CCD will have to spend a
little extra money for weatherproof enclosures.

v Because the wireless access point in Building A will be connected to a
switch rather than to a hub, the switch will provide some degree of isola-
tion between the networks. As a result, overall network performance
shouldn’t be affected.

/7
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v Before the networks were connected, each network had its own DHCP
server to assign IP addresses to users as needed. Unfortunately, both
DHCP servers have the same local IP address (192.168.0.1). When the
networks are combined, one of these DHCP servers will have to be
disabled.

v In addition, both networks had their own Internet connections. With
the networks bridged, CCD can eliminate the ISDN connection. Users in
both buildings can get their Internet access by using the shared T1
connection.

v The network administrator also has to determine how to handle directory
services for the network. Previously, each network had its own domain.
With the networks bridged, CCD may opt to keep these domains separate,
or it may decide to merge them into a single domain. (Doing so requires
considerable work, so it will probably leave the domains separate.)

Improving network performance:
DCH Accounting

DCH Accounting is an accounting firm that has grown in two years from 15 to
35 employees, all located in one building. Here’s the lowdown on the existing
network:

v The network consists of 35 client computers and three servers running
Windows 2000 Server.
v The 35 client computers all run Windows XP Professional.

v The client computers all have 10/100 Mbps Ethernet interfaces; a few
have 10/100/1000 interfaces.

v The servers have 10/100 Mbps cards.

v All offices in the building are wired with Category 5 wiring to a central
wiring closet, where a small equipment rack holds two 24-port
10BaseT hubs.

v Internet access is provided through a T1 connection with a Cisco 1700
router.

Lately, network performance has been noticeably slow, particularly Internet
access and large file transfers between client computers and the servers.
Users have started to complain that sometimes the network seems to crawl.
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The problem is twofold:

v The network has outgrown the old 10BaseT hubs. All network traffic
must flow through them, and they’re limited to the speed of 10 Mbps. As
a result, the new computers with the 10/100 Mbps Ethernet cards are
connecting to the network at 10 Mbps, not at 100 Mbps. In addition, the
hubs treat the entire network as a single Ethernet segment. With 35
users, the network is saturated.

v The network has outgrown the capabilities of Windows 2000 Server.
The server computers themselves are old, and the operating system is
outdated.

The performance of this network can be dramatically improved in two steps:

1. Upgrade the network infrastructure.

Replace the old network hubs with three 24-port 10/100/1000 Mbps
switches.

2. Replace the aging servers with faster servers running Windows
Server 2003.

The network is reconfigured, as shown in Figure 4-8.

y The Internet

Cisco 1700 C‘J} V

24-port 10/100 Switch

24-port 10BaseT Hub

24-port 10BaseT Hub
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Chapter 5

Oh, What a Tangled Web We
Weave: Cables, Adapters,
and Other Stuff

In This Chapter
Getting a whiff of Ethernet
Checking out the different types of network cable
Installing twisted-pair cable
Working with hubs and switches
Installing network interface cards
Adding professional touches to your cabling

Mulling over other devices (such as repeaters, bridges, and routers)

Cable is the plumbing of your network. In fact, working with network
cable is a lot like working with pipe: You have to use the right pipe
(cable), the right valves and connectors (switches and routers), and the
right fixtures (network interface cards).

Network cables have one more advantage over pipes: You don’t get wet when
they leak.

This chapter tells you far more about network cables than you probably need
to know. [ introduce you to Ethernet, the most common system of network
cabling for small networks. Then you find out how to work with the cables
used to wire an Ethernet network. You also find out how to install a network
interface card, which enables you to connect the cables to your computer.

What Is Ethernet?

Ethernet is a standardized way of connecting computers to create a network.
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Worthless filler about network topology

A networking book wouldnt be complete without
the usual textbook description of the three basic
network topologies. One type of network topol-
ogy is a bus, in which network nodes (that is,

A ringis very much like a bus except with no end
to the line: The last node on the line is connected
to the first node, forming an endless loop.

A third type of topology is a star:

computers) are strung together in a line, like this:

O O

A busis the simplest type of topology, but it has
some drawbacks. If the cable breaks some-
where in the middle, the whole network breaks.

)
N4

)
N4

)
N4

A second type of topology is the ring:

In a star network, all the nodes are connected
to a central hub. In effect, each node has an
independent connection to the network, so a
break in one cable doesn't affect the others.

Ethernet networks are based on a bus design.
However, fancy cabling tricks make an Ethernet
network appear to be wired like a star when
twisted-pair cable is used.

You can think of Ethernet as a kind of municipal building code for networks:
It specifies what kind of cables to use, how to connect the cables, how long
the cables can be, how computers transmit data to one another by using the
cables, and more.

Although Ethernet is now the overwhelming choice for networking, that wasn’t
always the case. In ye olde days, Ethernet had two significant competitors:

+~ Token Ring: This IBM standard for networking is still in some organiza-
tions (especially where IBM mainframe or midrange systems are in use).

v ARCnet: This standard is still commonly used for industrial network
applications, such as building automation and factory robot control.
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But the vast majority of business networks use Ethernet. You can purchase
inexpensive Ethernet components and cables at almost any store that sells
electronics. It’s really the only choice for new networks — small or large.

Here are a few tidbits you're likely to run into at parties where the conversa-
tion is about Ethernet standards:

v~ Ethernet is a set of standards for the infrastructure on which a network
is built. All the network operating systems that I discuss in this book —
including all versions of Windows, NetWare, Linux, and Macintosh OS/X —
can operate on an Ethernet network. If you build your network on a solid
Ethernet base, you can change network operating systems later.

v~ Ethernet is often referred to by network gurus as 802.3 (pronounced
“eight-oh-two-dot-three”), which is the official designation used by the
IEEE (pronounced “eye-triple-e,” not “aieeee!”), a group of electrical engi-
neers who wear bow ties and have nothing better to do than argue all
day long about things like inductance and cross-talk — and it’s a good
thing they do. If not for them, you couldn’t mix and match Ethernet
components made by different companies.

v The original vintage Ethernet transmits data at a rate of 10 million bits
per second, or 10 Mbps. (Mbps is usually pronounced “megabits per
second. ”) Because 8 bits are in a byte, that translates into roughly 1.2
million bytes per second. In practice, Ethernet can’t move information
that fast because data must be transmitted in packages of no more than
1,500 bytes, called packets. So, 150KB of information has to be split into
100 packets.

Ethernet’s transmission speed has nothing to do with how fast electrical
signals move on the cable. The electrical signals travel at about 70 per-
cent of the speed of light, or as Captain Picard would say, “Warp factor
point-seven-oh.”

v The newer version of Ethernet, and now the most common, is Fast
Ethernet, or 100 Mbps Ethernet, moves data ten times as fast as normal
Ethernet. Because Fast Ethernet moves data at a whopping 100 Mbps
and uses twisted-pair cabling, it’s often called 100BaseT (and sometimes
100BaseTX).

v An even faster version of Ethernet, known as Gigabit Ethernet, is also
available. Gigabit Ethernet components were once expensive enough
that they were used only for speed-critical parts of the network, such as
connecting servers to the network switches. However, gigabit Ethernet
has dropped in price enough that many desktop computers are con-
nected to the network at gigabit speed.

v Most networking components that you can buy these days support both 10
Mbps and 100 Mbps Ethernet. These components are called 10/100 Mbps
components because they support both speeds. Network components that
support all three speeds are called 10/100/1000 Mbps components.
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All about Cable

|
Figure 5-1:
Twisted-pair
cable.
|

A\

Although you can use wireless technology to create networks without cables,
most networks still use cables to physically connect each computer to the net-
work. Over the years, various types of cables have been used with Ethernet
networks. Almost all networks are now built with twisted-pair cable. In this
type of cable, pairs of wires are twisted around each other to reduce electrical
interference. (You almost need a PhD in physics to understand why twisting
the wires helps to reduce interference, so don’t feel bad if this concept doesn’t
make sense.)

You may encounter other types of cable in an existing network; for example, on
older networks, you may encounter two types of coaxial cable (also known as
coax, pronounced “COE-ax”). The first type resembles television cable and is
known as RG-58 cable. The second type is a thick, yellow cable that used to be
the only type of cable used for Ethernet. You may also encounter fiber-optic
cables that span long distances at high speeds or thick twisted-pair bundles
that carry multiple sets of twisted-pair cable between wiring closets in a large
building. Most networks, however, use simple twisted-pair cable.

Twisted-pair cable is sometimes called UTP. (The U stands for unshielded, but
“twisted-pair” is the standard name.) Figure 5-1 shows a twisted-pair cable.

=

When you use UTP cable to construct an Ethernet network, you connect the
computers in a star arrangement, as Figure 5-2 illustrates. In the center of this
star is a device called a switch. Depending on the model, Ethernet hubs enable
you to connect from 4 to 48 computers (or more) by using twisted-pair cable.

In the UTP star arrangement, if one cable goes bad, only the computer attached
to that cable is affected. The rest of the network continues to chug along.
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Wally's computer
June’s computer

Figure 5-2:
A network
cabled with
twisted-pair
cable. Ward’s computer
— Twisted-pair cable

Beaver's computer

Cable categories

Twisted-pair cable comes in various grades called cafegories. These categories
are specified by the ANSI/EIA Standard 568. (ANSI stands for American
National Standards Institute; EIA stands for Electronic Industries Association).
The standards indicate the data capacity — or bandwidth — of the cable.
Table 5-1 lists the various categories of twisted-pair cable.

Although higher-category cables are more expensive, the real cost of installing
Ethernet cabling is the labor required to pull the cables through the walls. You
should never install anything less than Category 5e cable. And, if at all pos-

sible, invest in Category 6 cable, to allow for future upgrades to your network.

To sound like the cool kids, say “Cat 6” rather than “Category 6.”

Table 5-1 Twisted-Pair Cable Categories
Category Maximum Data Rate Intended Use

1 1 Mbps Voice only

2 4 Mbps 4 Mbps Token Ring

3 16 Mbps 10BaseT Ethernet

4 20 Mbps 16 Mbps Token Ring

(continued)
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Table 5-1 (continued)

Category Maximum Data Rate Intended Use
5 100 Mbps (2-pair) 100BaseT Ethernet
1000 Mbps (4-pair) 1000BaseTX
5e 1000 Mbps (2-pair) 1000BaseT
6 1000 Mbps (2-pair) 1000BaseT and faster broadband
applications
6a 10000 Mbps (2-pair) Future standard that will provide for

10 Gbps Ethernet

What's with the pairs?

Most twisted-pair cable has four pairs of wires, for a total of eight wires.
Standard Ethernet uses only two of the pairs, so the other two pairs are
unused. You may be tempted to save money by purchasing cable with just
two pairs of wires, but that’s a bad idea. If a network cable develops a prob-
lem, you can sometimes fix it by switching over to one of the extra pairs. If
you use two-pair cable, though, you don’t have any spare pairs to use.

Don’t use the extra pairs for some other purpose, such as a voice line or a
second data line. The electrical “noise” in the extra wires can interfere with
your network.

To shield or not to shield

Unshielded twisted-pair cable, or UTP, is designed for normal office environ-
ments. When you use UTP cable, you must be careful not to route cable close to
fluorescent light fixtures, air conditioners, or electric motors (such as automatic
door motors or elevator motors). UTP is the least expensive type of cable.

In environments that have a lot of electrical interference (such as factories),
you may want to use shielded twisted-pair cable, also known as STP. Because
STP can be as much as three times more expensive than regular UTP, you don’t
want to use STP unless you have to. With a little care, UTP can withstand the
amount of electrical interference found in a normal office environment.

Most STP cable is shielded by a layer of aluminum foil. For buildings with
unusually high amounts of electrical interference, the more expensive
braided-copper shielding offers even more protection.
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When to use plenum cable

The outer sheath of shielded and unshielded twisted-pair cable comes
in two kinds:

v PVC cable is the most common and least expensive type.

v Plenum cable is a special type of fire-retardant cable designed for use
in the plenum space (definition coming right up) of a building. Plenum
cable has a special Teflon coating that not only resists heat but also
gives off fewer toxic fumes if it does burn. Unfortunately, plenum cable
costs more than twice as much as ordinary PVC cable.

vQ.\\\NG! Most local building codes require plenum cable when the wiring is installed
in the building’s plenum space (a compartment that’s part of the building’s
air-distribution system, usually the space above a suspended ceiling or under
a raised floor).

<® The area above a suspended ceiling is not a plenum space if both the delivery
and return lines of the air-conditioning and heating systems are ducted.
Plenum cable is required only if the air-conditioning and heating systems
are not ducted. When in doubt, have the local inspector look at your facility
before you install cable.

Sometimes solid, sometimes stranded

The actual copper wire that comprises the cable comes in two varieties: solid
and stranded. Your network will have some of each:

v In stranded cable, each conductor is made from a bunch of very small
wires that are twisted together. Stranded cable is more flexible than
solid cable, so it doesn’t break as easily. However, stranded cable is
more expensive than solid cable and isn’t very good at transmitting
signals over long distances. Stranded cable is best used for patch cables
(such as patch panels to hubs and switches).

QWP Strictly speaking, the cable that connects your computer to the wall jack
is a station cable — not a patch cable — but it’s an appropriate use for
stranded cable. (It’s not technically correct, but most people refer to
the cables that connects a computer to a wall jack as a patch cable.)

v In solid cable, each conductor is a single, solid strand of wire. Solid cable
is less expensive than stranded cable and carries signals farther, but it
isn’t very flexible. If you bend it too many times, it breaks. Normally you
find solid cable in use as permanent wiring within the walls and ceilings
of a building.
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Installation guidelines

The hardest part of installing network cable is the physical task of pulling the
cable through ceilings, walls, and floors. This job is just tricky enough that I
recommend you don’t attempt it yourself, except for small offices. For large
jobs, hire a professional cable installer. You may even want to hire a profes-
sional for small jobs if the ceiling and wall spaces are difficult to access.

Keep these pointers in mind if you install cable yourself:

v You can purchase twisted-pair cable in prefabricated lengths, such as
50 feet, 75 feet, and 100 feet. You can also special-order prefabricated
cables in any length you need. But attaching connectors to bulk cable
isn’t very difficult.

Use prefabricated cables only for very small networks and only when
you don’t need to route the cable through walls or ceilings.

v Always use a bit more cable than you need, especially if you're running
cable through walls. For example, when you run a cable up a wall, leave
a few feet of slack in the ceiling above the wall. That way, you have
plenty of cable if you need to make a repair later on.

v When running cable, avoid sources of interference, such as fluorescent
lights, big motors, and X-ray machines.

Fluorescent lights are the most common source of interference for
cables behind ceiling panels. Give light fixtures a wide berth. Three feet
should do it.

v The maximum allowable cable length between the hub and the computer
is 100 meters (about 328 feet).

v If you must run cable across the floor where people walk, cover the
cable so no one trips over it. Cable protectors are available at most
hardware stores.

v When running cables through walls, label each cable at both ends. Most
electrical supply stores carry pads of cable labels that are perfect for
the job. These pads contain 50 sheets or so of precut labels with letters
and numbers. They look much more professional than wrapping a loop
of masking tape around the cable and writing on the tape with a marker.

Alternatively, you can just write directly on the label with a permanent
marker.

v If you're installing cable in new construction, label each end of the cable
at least three times, leaving about a foot of space between the labels.
The drywallers or painters will probably spray mud or paint all over
your cables, making the labels difficult to find.
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v When several cables come together, tie them with plastic cable ties.
Avoid masking tape if you can; the tape doesn’t last, but the sticky glue
stuff does. It’s a mess a year later. Cable ties are available at electrical
supply stores.

v Cable ties have all sorts of useful purposes. Once, on a backpacking trip,
[ used a pair of cable ties to attach an unsuspecting buddy’s hat to a
high tree limb. He wasn’t impressed with my innovative use of the cable
ties, but my other hiking companions were.

\\J

v When you run cable above suspended ceiling panels, use cable ties, hooks,
or clamps to secure the cable to the ceiling or to the metal frame that sup-
ports the ceiling tiles. Don’t just lay the cable on top of the panels.

The tools you need

Of course, to do a job right, you must have the right tools:

v~ Start with a basic set of computer tools, which you can get for about
$15 from any computer store and most office-supply stores. These kits
include socket wrenches and screwdrivers to open your computers and
\\3 insert adapter cards.

The computer tool kit probably contains everything you need if
e All your computers are in the same room.
¢ You're running the cables along the floor.
* You're using prefabricated cables.

If you don’t have a computer tool kit, make sure that you have several
flat-head and Phillips screwdrivers of various sizes.

v If you're using bulk cable and plan on attaching your own connectors, you
also need the following tools in addition to the basic computer tool kit:

¢ Wire cutters: You need big ones for coax, smaller ones work for
twisted-pair cable. For yellow cable, you need the Jaws of Life.

¢ A crimp tool: You need the crimp tool to attach the connectors to
the cable. Don’t use a cheap $25 crimp tool. A good crimp tool
\x&“\BE” costs $100 and will save you many headaches in the long run.

When you crimp, you mustn’t scrimp.

e Wire stripper: You need this tool only if the crimp tool doesn’t
include a wire stripper.
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v If you plan on running cables through walls, you need these additional
tools:

e A hammer.

¢ A keyhole saw. This one is useful if you plan on cutting holes
through walls to route your cable.

e A flashlight.

¢ A ladder.

¢ Someone to hold the ladder.
¢ Possibly a fish tape.

A fish tape is a coiled-up length of stiff metal tape. To use it, you
feed the tape into one wall opening and fish it toward the other
opening, where a partner is ready to grab it when the tape arrives.
Next, your partner attaches the cable to the fish tape and yells
something like “Let ’er rip!” or “Bombs away!” Then you reel in the
fish tape and the cable along with it. (You can find fish tape in the
electrical section of most well-stocked hardware stores.)

If you plan on routing cable through a concrete subfloor, you need to rent a
jackhammer and a backhoe and hire someone to hold a yellow flag while you
work. Better yet, find some other route for the cable.

Pinouts for twisted-pair cables

Each pair of wires in a twisted-pair cable is one of four colors: orange, green,
blue, or brown. The two wires that make up each pair are complementary:
one is white with a colored stripe; the other is colored with a white stripe.
For example, the orange pair has an orange wire with a white stripe (the
orange wire) and a white wire with an orange stripe (the white/orange wire).
Likewise, the blue pair has a blue wire with a white stripe (the blue wire) and
a white wire with a blue stripe (the white/blue wire).

When you attach a twisted-pair cable to a modular connector or jack, you
must match up the right wires to the right pins. It’s harder than it sounds;
you can use any of several different standards to wire the connectors. To
confuse matters further, you can use one of the two popular standard ways
of hooking up the wires: EIA/TIA 568A or EIA/TIA 568B, also known as AT&T
258A. Both these wiring schemes are shown in Table 5-2.

It doesn’t matter which of these wiring schemes you use, but pick one and
stick with it. If you use one wiring standard on one end of a cable and the
other standard on the other end, the cable doesn’t work.
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Table 5-2 Pin Connections for Twisted-Pair Cable

Pin Function EIA/TIA 568A EIA/TIA568B
AT&T 258A

1 Transmit + White/Green White/orange wire

2 Transmit — Green Orange wire

3 Receive + White/Orange White/green wire

4 Unused Blue Blue wire

5 Unused White/Blue White/blue wire

6 Receive - Orange Green wire

7 Unused White/Brown White/brown wire

8 Unused Brown Brown wire

The 10BaseT and 100BaseT standards use only two of the four pairs, connected
to Pins 1, 2, 3, and 6. One pair transmits data; the other receives data. The only
difference between the two wiring standards is which pair transmits and which
receives. In the EIA/TIA 568A standard, the green pair is used for transmit and
the orange pair is used for receive. In the EIA/TIA 568B and AT&T 258A stan-
dards, the orange pair is used for transmit and the green pair for receive.

If you want, you can get away with connecting only Pins 1, 2, 3, and 6.
However, [ suggest that you connect all four pairs, as indicated in Table 5-2.

R]-45 connectors

RJ-45 connectors for twisted-pair cables aren’t too difficult to attach if you
have the right crimping tool. The only trick is making sure that you attach
each wire to the correct pin and then pressing the tool hard enough to ensure
a good connection.

Here’s the procedure for attaching an RJ-45 connector:

1. Cut the end of the cable to the desired length.
Make sure that you make a square cut — not a diagonal cut.

2. Insert the cable into the stripper portion of the crimp tool so that the
end of the cable is against the stop.

Squeeze the handles and slowly pull out the cable, keeping it square.
This strips off the correct length of outer insulation without puncturing
the insulation on the inner wires.
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Figure 5-3:
Attaching

an RJ-45
connector
to twisted-
pair cable.
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3. Arrange the wires so that they lie flat and line up according to Table 5-2.

You have to play with the wires a little bit to get them to lay out in the
right sequence.

. Slide the wires into the pinholes on the connector.

Double-check to make sure all the wires are slipped into the correct
pinholes.

. Insert the plug and wire into the crimping portion of the tool and then

squeeze the handles to crimp the plug.

Squeeze it tight!

. Remove the plug from the tool and double-check the connection.

You're done!

Here are a few other points to remember when dealing with RJ-45 connectors
and twisted-pair cable:

v The pins on the RJ-45 connectors aren’t numbered.

You can tell which is Pin 1 by holding the connector so that the metal
conductors are facing up, as shown in Figure 5-3. Pin 1 is on the left.

v Some people wire 10BaseT cable differently — using the green-and-white

pair for Pins 1 and 2, and the orange-and-white pair for Pins 3 and 6.
Doing it this way doesn’t affect the operation of the network (the net-
work is color blind) as long as the connectors on both ends of the cable
are wired the same way!

v If you're installing cable for a Fast Ethernet system, be extra careful to

follow the rules of Category 5 cabling. Among other things, make sure
that you use Category 5 components throughout. The cable and all the
connectors must be up to Category 5 specs. When you attach the con-
nectors, don’t untwist more than half an inch of cable. And, don’t try to
stretch the cable runs beyond the 100-meter maximum. When in doubt,
have cable for a 100 Mbps Ethernet system professionally installed.

12345612 Pin connections:
% Pin 1 - White/Orange
NN Pin 2 - Orange/White

SN Pin 3 - White/Green
SN
\@\ Pin 6 - Green/White
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Crossover cables

A crossover cable can directly connect two devices without a hub or switch.
You can use a crossover cable to connect two computers directly to each
other, but crossover cables are more often used to daisy-chain hubs and
switches to each other.

If you want to create your own crossover cable, you must reverse the wires
on one end of the cable, as shown in Table 5-3. This table shows how you
should wire both ends of the cable to create a crossover cable. Connect one
of the ends according to the Connector A column and the other according to
the Connector B column.

Note that you don’t need to use a crossover cable if one of the switches or

hubs that you want to connect has a crossover port, usually labeled Uplink

or Daisy-chain. If the hub or switch has an Uplink port, you can daisy-chain it

by using a normal network cable. For more information about daisy-chaining

hubs and switches, see the section “Hubs and Switches,” later in this chapter.
< If you study Table 5-3 long enough and then compare it with Table 5-2, you
may notice that a crossover cable is a cable that’s wired according to the
568A standard on one end and the 568B standard on the other end.

Table 5-3 Creating a Crossover Cable
Pin Connector A Connector B
1 White/Green White/orange
2 Green Orange

3 White/Orange White/green
4 Blue Blue

5 White/Blue White/blue

6 Orange Green

7 White/Brown White/brown
8 Brown Brown

Wall jacks and patch panels

If you want, you can run a single length of cable from a network hub or switch
in a wiring closet through a hole in the wall, up the wall to the space above
the ceiling, through the ceiling space to the wall in an office, down the wall,
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Figure 5-4:
Using wall

through a hole, and all the way to a desktop computer. That’s not a good
idea. For example, every time someone moves the computer or even cleans
behind it, the cable will get moved a little bit. Eventually, the connection will
fail and the RJ-45 plug will have to be replaced. Then the cables in the wiring
closet will quickly become a tangled mess.

The alternative is to put a wall jack in the wall at the user’s end of the cable
and connect the other end of the cable to a patch panel. Then the cable itself
is completely contained within the walls and ceiling spaces. To connect a
computer to the network, you plug one end of a patch cable (properly called
a station cable) into the wall jack and plug the other end into the computer’s
network interface. In the wiring closet, you use a patch cable to connect the
wall jack to the network hubs or switches. Figure 5-4 shows how this arrange-
ment works.

Connecting a twisted-pair cable to a wall jack or a patch panel is similar to
connecting it to an RJ-45 plug. However, you don’t usually need any special
tools. Instead, the back of the jack has a set of slots that you lay each wire
across. You then snap a removable cap over the top of the slots and press it
down. This action forces the wires into the slots, where little metal blades
pierce the insulation and establish the electrical contact.

When you connect the wire to a jack or a patch panel, be sure to untwist as
little of the wire as possible. If you untwist too much of the wire, the signals
that pass through the wire may become unreliable.

Patch panel

N[/ 7]
Hub

jacks and K==

patch
panels.
|

Modular
wall jacks
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When you use twisted-pair cable to wire a network, you don’t plug the com-
puters into each other. Instead, each computer plugs into a separate device
called a hub. Years ago, hubs were expensive devices — expensive enough
that most do-it-yourself networkers who were building small networks opted
for coax cable rather than twisted-pair because networks wired with coax
cable don’t require hubs.

Nowadays, the cost of hubs has dropped so much that the advantages of
using twisted-pair cabling outweigh the hassle and cost of using hubs. With
twisted-pair cabling, you can more easily add new computers to the network,
move computers, find and correct cable problems, and service the comput-
ers that you need to remove from the network temporarily.

Hubs or switches?

A switch is simply a more sophisticated type of hub.

Because the cost of switches has come down dramatically in the past few
years, new networks are built with switches rather than hubs. (You probably
have to find a hub at a garage sale or on eBay.) If you have an older network
that uses hubs and seems to run slowly, you can probably improve the net-
work’s speed by replacing the older hubs with newer switches.

Switches are more efficient than hubs, but not just because they're faster:

v In a hub, every packet that arrives at the hub on any of its ports is auto-
matically sent out on every other port. The hub has to do this because it
doesn’t keep track of which computer is connected to each port.

Suppose that Wally’s computer is connected to Port 1 on an 8-port hub
and Ward’s computer is connected to Port 5. If Ward’s computer sends a
packet of information to Wally’s computer, the hub receives the packet
on Port 1 and then sends it out on Ports 2 through 8. All the computers
connected to the hub get to see the packet and determine whether the
packet was intended for them.

v A switch keeps track of which computer is connected to each port.

If Wally’s computer on Port 1 sends a packet to Ward’s computer on Port
5, the switch receives the packet on Port 1 and then sends the packet
out only on Port 5. This system is faster and also improves the security
of the system because other computers aren’t shown packets that aren’t
meant for them.

95
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Ten base what?

The |EEE, in its infinite wisdom, has decreed that
the following names shall be used to designate

v 10BaseT: Unshielded twisted-pair cable
(UTP).

the various types of cable used with 802.3 net-
works (in other words, with Ethernet):

+* 10Baseb: Old-fashioned thick coaxial cable
(the yellow stuff)

The letter Tin 10BaseT stands for twisted.

In each name, the number 70 means that the
cable operates at 10 Mbps, and Base means that
the cable is used for baseband networks as
opposed to broadband networks. (Don’t ask.) Of
these three official monikers, 10BaseT is the only
one used frequently; 10Base5 and 10Base2 are
usually just called thick and thin, respectively.

The number 5in 10Baseb is the maximum
length of a yellow cable segment: 500 meters.

10Base2: Thin coaxial cable (Thinnet).

The number 2 in 10Base2 stands for 200
meters, which is about the 185-meter maxi-
mum segment length for Thinnet cable. (For
engineers, the IEEE is an odd bunch; | didn't
know that the word about could be part of
an engineer’s vocabulary.)

Fast Ethernet running over 10BaseT cabling
uses the designation 100BaseT.

Working with switches

You need to know only a few details when working with switches. Here they are:

v Installing a switch is usually very simple. Just plug in the power cord
and then plug in patch cables to connect the network.

v Each port on the switch has an RJ-45 jack and a single LED indicator,
labeled Link, that lights up when a connection is made on the port.

If you plug one end of a cable into the port and the other end into a com-
puter or other network device, the Link light should come on. If it doesn’t,
something is wrong with the cable, the hub or switch port, or the device
on the other end of the cable.

v Each port may have an LED indicator that flashes to indicate network
activity.
If you stare at a switch for a while, you can find out who uses the
network most by noting which activity indicators flash the most.

v The ports may also have a collision indicator that flashes whenever a
packet collision occurs on the port.
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It’s perfectly acceptable for the collision indicator to flash now and then,
but if it flashes a lot, you may have a problem with the network:
e Usually, the flashing means that the network is overloaded and
should be segmented with a switch to improve performance.
¢ In some cases, the flashing may be caused by a faulty network
node that clogs the network with bad packets.
Daisy-chaining switches
If a single switch doesn’t have enough ports for your entire network, you can
connect switches by daisy-chaining them, as shown in Figure 5-5. If one of the
switches has an uplink port, you can use a normal patch cable to connect the
uplink port to one of the regular ports on the other hub or switch. If neither
device has an uplink port, use a crossover cable to connect them. (For
instructions on making a crossover cable, see the section, “Crossover
cables,” earlier in this chapter.)
N
\: :
|
Figure 5-5:
You can
daisy-chain
hubs or
switches
together.
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On many newer switches, each port on the switch can automatically detect
whether it is connected to another switch. In that case, you don’t have to use
special uplink ports or crossover cables. You can use a standard patch cable
to connect the switches by using any available port.

You can often increase the overall performance of your network by using two
(or more) connections between switches. For example, you may use two
patch cables to create two connections between a pair of switches.

Keep in mind these two simple rules when daisy-chaining hubs:

v The number of hubs that you can chain together is limited:
¢ For 10BaseT networks, don’t connect more than three hubs together.
¢ For 100BaseT, you can chain only two hubs together.

You can get around this rule by using stackable hubs (hubs with a special
cable connector that connects two or more hubs so that they function
as a single hub). Stackable hubs are a must for large networks.

v The cable to daisy-chain a 100BaseT hub can’t be longer than 5 meters.

If your building is prewired and has a network jack near each desk, you can use
a small hub or switch to connect two or more computers to the network by
using a single jack. Just use one cable to plug the daisy-chain port of the hub
into the wall jack and then plug each computer into one of the hub’s ports.

Network Interface Cards

Every computer that connects to your network must have a network inter-
face. Most new computers come with a built-in network interface. But you
may need to add a separate network interface card to older computers that
don’t have built-in interfaces. The following sections show you what you
need to know to purchase and install a network interface card.

Picking a network interface card

You can buy inexpensive network interface cards at any computer supply
store, and most large office supply stores also carry them. The following
pointers should help you pick the right card for your system:
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v The network interface cards that you use must have a connector that
matches the type of cable you use. If you plan on wiring your network with
Thinnet cable, make sure that the network cards have a BNC connector.
For twisted-pair wiring, make sure that the cards have an RJ-45 connector.

1 Some network cards provide two or three connectors. I see them in
every combination: BNC and AUI, RJ-45 and AUI, BNC and RJ-45, and all
three. AUI connectors are pretty much obsolete. As for BNC connectors,
get them only if your network has existing coax wiring. If it doesn't,
cards that have just RJ-45 connectors are adequate.

v Most newer network cards are designated as 10/100/1000 Mbps cards,
which means that they work at 10 Mbps, 100 Mbps, or 1000 Mbps. These
cards automatically detect the network speed and switch accordingly.
Ah, progress.

v When you purchase a network card, make sure that you get one that’s
compatible with your computer. Many older computers can accommo-
date cards designed for the standard 16-bit ISA bus. Newer computers
can accommodate cards that use the PCI bus. If your computer supports
PCI, purchase a PCI card. PCI cards are not only faster than ISA cards but
are also easier to configure. Use ISA cards only for older computers that
can’t accommodate PCI cards.

v Network cards can be a bit tricky to set up. Each different card has its own
nuances. You can simplify your life a bit if you use the same card for every
computer in your network. Try not to mix and match network cards.

v Some computers come with network interfaces built in. In that case, you
don’t have to worry about adding a network card.

Installing a network card

Installing a network interface card is a manageable task, but you have to be
willing to roll up your sleeves. If you've installed one adapter card, you've
installed them all. In other words, installing a network interface card is just
like installing a modem, a new video controller card, a sound card, or any
other type of card. If you've ever installed one of these cards, you can prob-
ably install a network interface card blindfolded.

Here’s the step-by-step procedure for installing a network interface card:

QWNG/ 1. Shut down Windows and then turn off the computer and unplug it.
Q.
S Never work in your computer’s insides with the power on or the power

cord plugged in!
2. Remove the cover from your computer.

Figure 5-6 shows the screws that you must typically remove to open the
cover. Put the screws someplace where they won’t wander off.
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Remove these screws

(T e [ I Sy
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|
Figure 5-6:
Removing o
your o
computer’s PR @
cor |0 e e @ ) ¢
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3. Find an unused expansion slot inside the computer.
The expansion slots are lined up in a neat row near the back of the
computer; you can’t miss 'em:
e Most newer computers have at least two slots known as PCI slots.
e Many older computers also have several slots known as ISA slots.
\P
) You can distinguish ISA slots from PCI slots by noting the size of
the slots. PCI slots are smaller than ISA slots, so you can’t acciden-
tally insert a PCI card in an ISA slot or vice versa.
¢ Some computers also have other types of slots — mainly VESA and
WNG/ EISA slots.

Standard ISA or PCI networking cards don’t fit into these types of
slots, so don’t try to force them.

"%

4. When you find the right type of slot that doesn’t have a card in it,
remove the metal slot protector from the back of the computer’s chassis:

a. If a small retaining screw holds the slot protector in place, remove
the screw and keep it in a safe place.

b. Pull out the slot protector.

W c. Put the slot protector in a box with all your other old slot protectors.
After a while, you collect a whole bunch of slot protectors. Keep
them as souvenirs, or use them as Christmas-tree ornaments.

5. Insert the network interface card into the slot.

Line up the connectors on the bottom of the card with the connectors in
the expansion slot and then press the card straight down. Sometimes you
have to press uncomfortably hard to get the card to slide into the slot.

6. Secure the network interface card with the screw you remove in Step 4.

7. Put the computer’s case back together.
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Network starter kits

Often, the easiest way to buy the equipmentthat &~ One 4-port Ethernet 100 Mbps switch
you need to build a network is to purchase a
network starter kit. A typical network starter kit
includes everything that you need to network
two computers. To add computers, you pur- ¢~ Software for the cards
chase add-on kits that include everything you
need to add one computer to the network.

v Two 25-foot-long 10BaseT twisted-pair
cables

v Instructions

This kit should set you back about $75. It con-

nects two of the three computers. To connect

the third computer, purchase an add-on kit that

includes a 10/100 auto-switching PCI Ethernet

card, another 25-foot-long twisted-pair cable,

v~ Two 10/100 Mbps auto-switching PCI Ethernet ~ software, and instructions — all for about $40.
cards

Suppose that you want to network three com-
puters in a small office. You can start with a two-
computer network starter kit, which includes
these items:

\NG/
V?‘“

Watch out for the loose cables inside the computer. You don’t want to
pinch them with the case as you slide it back on.

Secure the case with the screws you remove in Step 2.
8. Turn the computer back on.

If you're using a Plug and Play card with Windows, the card is configured
automatically after you start the computer again.

If you're working with an older computer or an older network interface
card, you may need to run an additional software installation program.
See the installation instructions that come with the network interface
card for details.

Other Network Devices

In addition to network interface cards, cables, and hubs or switches, some
networks may require one or more of the devices described in the following
sections.

Repeaters

A repeater is a gizmo that gives your network signals a boost so that the sig-
nals can travel farther. It’s kind of like the Gatorade stations in a marathon.
As the signals travel past the repeater, they pick up a cup of Gatorade, take a
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sip, splash the rest of it on their heads, toss the cup, and hop in a cab when
they’re sure that no one is looking.

You need a repeater when the total length of a single span of network cable is
larger than the maximum allowed for your cable type:

Cable Maximum Length
10Base2 (coaxial) 185 meters or 606 feet
10/100BaseT (twisted-pair) 100 meters or 328 feet

For coaxial cable, the cable lengths given here apply to cable segments — not
to individual lengths of cable. A segment is the entire run of cable from one
terminator to another and may include more than one computer. In other
words, if you connect ten computers with 25-foot lengths of thin coaxial
cable, the total length of the segment is 225 feet. (Made you look! Only nine
cables are required to connect ten computers — that’s why it’s not 250 feet.)

For 10BaseT or 100BaseT cable, the 100-meter length limit applies to the cable
that connects a computer to the hub or the cable that connects hubs to each
other when hubs are daisy-chained with twisted-pair cable. In other words, you
can connect each computer to the hub with no more than 100 meters of cable,
and you can connect hubs to each other with no more than 100 meters of cable.

Figure 5-7 shows how you can use a repeater to connect two groups of com-
puters that are too far apart to be strung on a single segment. When you use
a repeater like this, the repeater divides the cable into two segments. The
cable length limit still applies to the cable on each side of the repeater.

Ponder these points when you lie awake tonight thinking about repeaters:

v Repeaters are used only with Ethernet networks wired with coaxial
cable; twisted-pair networks don’t use repeaters.

Actually, that’s not quite true: twisted-pair does use repeaters. It’s just
that the repeater isn’t a separate device. In a twisted-pair network, the
switch is a multiport repeater. That’s why the cable used to attach each
computer to the switch is considered a separate segment.

v Some 10/100BaseT switches have a BNC connector on the back. This
BNC connector is a Thinnet repeater that enables you to attach a full
185-meter Thinnet segment. The segment can attach other computers,
10BaseT hubs, or a combination of both.

v A basic rule of Ethernet life is that a signal can’t pass through more than
three repeaters on its way from one node to another.

You can have more than three repeaters or switches. If you do, you have
to carefully plan the network cabling so that the three-repeater rule isn’t
violated.
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v A two-port 10Base2 repeater costs about $200. (Sheesh! I guess that’s
one of the reasons few people use coaxial cable anymore.)

v Repeaters are legitimate components of a by-the-book Ethernet network.
They don’t extend the maximum length of a single segment; they just
enable you to tie two segments together.

Vg,\\\'\‘G! Beware of the little black boxes that claim to extend the segment limit
S beyond the 185-meter limit for Thinnet or the 100-meter limit for
10/100BaseT cable. These products usually work, but playing by the
rules is better.

[B] [EEEsERE] [8]
Hub

|
Figure 5-7:
Using a
repeater.
|

Bridges

A bridge is a device that connects two networks. Bridges are used to partition
one large network into two smaller networks for performance reasons.
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Think of a bridge as a kind of smart repeater. Repeaters listen to signals
coming down one network cable, amplify them, and send them down the
other cable. They do this blindly, paying no attention to the content of the
messages they repeat.

In contrast, a bridge is a little smarter about the messages that come down
the pike. For starters, most bridges can listen to the network and automati-
cally figure out the address of each computer on both sides of the bridge.
Then the bridge can inspect each message that comes from one side of the
bridge and broadcast it on the other side of the bridge, but only if the mes-
sage is intended for a computer that’s on the other side.

This key feature enables bridges to partition a large network into two smaller,
more efficient networks. Bridges work best in networks that are highly segre-

gated. For example, your network may consist of two distinct groups of users:
the Marketing department and the Accounting department, each with its own
servers.

A bridge lets you partition this network so that the Marketing side of the net-
work isn’t bogged down by Accounting, and vice versa. The bridge automati-
cally learns which computers are on each side of the bridge and forwards
messages from the one side to the other only when necessary. The overall
performance of both networks improves, although the performance of any
network operation that has to travel over the bridge slows down a bit.

Here are a few additional thoughts to consider about bridges:

v Some bridges can translate the messages from one format to another.

For example, if the Marketing folks build their network with Ethernet and
the accountants use Token Ring, a bridge can tie the two together.

v You can get a basic bridge to partition two Ethernet networks for about
$500. More-sophisticated bridges can cost $5,000 or more.

Routers

A router is like a bridge, but with a key difference: Bridges use actual hard-
ware addresses (known as MAC addresses) to tell which network node each
message is sent to so that it can forward the message to the appropriate seg-
ment. However, a bridge can’t look inside the message to see what type of
information is being sent. A router can. As a result, routers work at a higher
level than bridges. Thus, routers can perform additional tasks, such as filter-
ing packets based on their content. (Many routers also have built-in bridging
functions, so routers are often used as bridges.)
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You can configure a network with several routers that can work cooperatively
together. For example, some routers can monitor the network to determine the
most efficient path for sending a message to its ultimate destination. If a part of
the network is extremely busy, a router can automatically route messages along
a less-busy route. In this respect, the router is kind of like a traffic reporter flying
in a helicopter. The router knows that the 101 is bumper to bumper all the way
through Sunnyvale, so it sends the message on the 280 instead.

\\J

Here’s some additional information about routers:

v Routers used to be expensive and used only on large networks.
However, the price of small routers has dropped substantially in recent
years, so they’re now becoming common even on small networks.

v The functional distinctions between bridges and routers — and switches
and hubs, for that matter — get blurrier all the time. Multifunction routers
(which combine the functions of routers, bridges, hubs, and switches) are
often used to handle some chores that used to require separate devices.

v Some routers are nothing more than computers with delusions of
grandeur — along with several network interface cards and special
software to perform the router functions.

v Routers can also connect networks that are geographically distant from
each other by using a phone line (using modems) or ISDN.

v One of the main reasons for using routers is to connect a LAN to the
Internet. Figure 5-8 shows a router used for this purpose.

|
Figure 5-8:
Using a
router to
connect a
LAN to the
Internet.
|

Router
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Chapter 6
Dealing with TCP/IP

In This Chapter

Getting a handle (or two) on the binary system

Digging into IP addresses

Finding out how subnetting works

Understanding private and public IP addresses

Looking at network address translation
Finding out how DHCP works
Understanding how DNS works

\NG/
vg&\

' CP/IP is the basic profocol by which computers on a network talk to
each other. Without TCP/IP, networks wouldn’t work. In this chapter,
[ introduce you to the most important concepts of TCP/IP.

This chapter is far and away the most technical chapter in this book. It helps
you examine the binary system, the details of how IP addresses are con-
structed, how subnetting works, and how two of the most important TCP/IP
services — DHCP and DNS — work. You don’t need to understand every
detail in this chapter to set up a simple TCP/IP network. However, the more
you understand the information in this chapter, the more TCP/IP will start to
make sense. Be brave.

Understanding Binary

Before you can understand the details of how TCP/IP — in particular, [P —
addressing works, you need to understand how the binary numbering system
works because binary is the basis of IP addressing. If you already understand
binary, please skip right over this section to the next main section, “Introducing
[P Addresses.” | don’t want to bore you with stuff that’s too basic.
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Counting by ones

The binary counting system uses only two numerals: 0 and 1. In the decimal
system to which most people are accustomed, you use ten numerals:
through 9. In an ordinary decimal number, such as 3,482, the rightmost digit
represents ones; the next digit to the left, tens; the next, hundreds; the next,
thousands; and so on. These digits represent powers of ten: first 10° (which is
1); next, 10' (10); then 10?(100); then 10°(1,000); and so on.

In binary, you have only two numerals rather than ten, which is why binary
numbers look somewhat monotonous, as in 110011, 101111, and 100001.

The positions in a binary number (called bits rather than digits) represent
powers of two rather than powers of ten: 1, 2, 4, 8, 16, 32, and so on. To figure
the decimal value of a binary number, you multiply each bit by its correspond-
ing power of two and then add the results. The decimal value of binary 10101,
for example, is calculated as follows:

28— ] = 1
+0 _2'=0_ 2 = 0
+1 _2°=1 _ 4 = 4
+0_2=0_ 8= 0
+1 _2*=1 _ 16 = _16

1

Fortunately, a computer is good at converting a number between binary and
decimal — so good, in fact, that you’re unlikely ever to need to do any conver-
sions yourself. The point of knowing binary isn’t to be able to look at a number,
such as 1110110110110, and say instantly, “Ah! Decimal 7,606!” (If you could do
that, Barbara Walters would probably interview you, and they would even
make a movie about you — starring Dustin Hoffman and a vintage Buick.)

Instead, the point is to have a basic understanding of how computers store
information and — most important — to understand how the hexadecimal
counting system works (which is described in the following section).

Here are some of the more interesting characteristics of binary and how the
system is similar to and differs from the decimal system:

v The number of bits allotted for a binary number determines how large
that number can be. If you allot eight bits, the largest value that number
can store is 11111111, which happens to be 255 in decimal.

v To quickly determine how many different values you can store in a
binary number of a given length, use the number of bits as an exponent
of two. An eight-bit binary number, for example, can hold 2* values.
Because 2° is 256, an 8-bit number can have any of 256 different values —
which is why a byte, which is eight bits, can have 256 different values.
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v This powers-of-two concept is why computers don’t use nice, even,
round numbers in measuring such values as memory or disk space. A
value of 1K, for example, isn’t an even 1,000 bytes — it’s 1,024 bytes
because 1,024 is 2'°. Similarly, 1MB isn’t an even 1,000,000 bytes but
rather is 1,048,576 bytes, which happens to be 2.

Doing the logic thing

One of the great things about binary is that it is very efficient at handling spe-
cial operations called logical operations. Four basic logical operations exist,
although additional operations are derived from the basic four operations.
Three of the operations — AND, OR, and XOR — compare two binary digits
(bits). The fourth (NOT) works on just a single bit.

The following list summarizes the basic logical operations:

v AND: An AND operation compares two binary values. If both values are 1,
the result of the AND operation is 1. If one or both of the values are 0, the
result is 0.

v OR: An OR operation compares two binary values. If at least one of the
values is 1, the result of the OR operation is 1. If both values are 0, the
result is 0.

»* XOR: An XOR operation compares two binary values. If exactly one of
them is 1, the result is 1. If both values are 0 or if both values are 1, the
result is 0.

v NOT: The NOT operation doesn’t compare two values. Instead, it simply
changes the value of a single binary value. If the original value is 1, NOT
returns 0. If the original value is 0, NOT returns 1.

Logical operations are applied to binary numbers that have more than
one binary digit by applying the operation one bit at a time. The easiest
way to do this manually is to

1. Line one of the two binary numbers on top of the other.
2. Write the result of the operation beneath each binary digit.

The following example shows how you calculate 10010100 AND
11011101:

10010100
AND 11011101
10010100

As you can see, the result is 10010100.
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Introducing 1P Addresses

An [P address is a number that uniquely identifies every host on an IP net-
work. IP addresses operate at the Network layer of the TCP/IP protocol stack,
so they’re independent of lower-level Data Link layer MAC addresses, such as
Ethernet MAC addresses.

I[P addresses are 32-bit binary numbers, which means that, theoretically,

a maximum of something in the neighborhood of 4 billion unique host
addresses can exist throughout the Internet. You’d think that’d be enough,
but TCP/IP places certain restrictions on how IP addresses are allocated.
These restrictions severely limit the total number of usable IP addresses,

and about half of the total available IP addresses have already been assigned.
However, new techniques for working with IP addresses have helped to allevi-
ate this problem, and a new standard for 128-bit IP addresses (known as IPv6)
is on the verge of winning acceptance.

Networks and hosts

IP stands for Internet Protocol, and its primary purpose is to enable communica-
tions between networks. As a result, a 32-bit IP address consists of two parts:

v The network ID (or network address): Identifies the network on which a
host computer can be found.

+~ The host ID (or host address): Identifies a specific device on the network
indicated by the network ID.

Most of the complexity of working with IP addresses has to do with figuring
out which part of the complete 32-bit [P address is the network ID and which
part is the host ID. The original IP specification uses the address classes
system to determine which part of the IP address is the network ID and
which part is the host ID. A newer system, known as classless IP addresses, is
rapidly taking over the address classes system. You come to grips with both
systems later in this chapter.

The dotted-decimal dance

IP addresses are usually represented in a format known as dotted-decimal
notation. In dotted-decimal notation, each group of eight bits, known as an
octet, is represented by its decimal equivalent. For example, consider the
following binary IP address:

11000000101010001000100000011100
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The dotted-decimal equivalent to this address is
192.168.136.28

Here, 192 represents the first eight bits (11000000); 168, the second set of
eight bits (10101000); 136, the third set of eight bits (10001000); and 28, the
last set of eight bits (00011100). This is the format in which you usually see
[P addresses represented.

Classifying 1P Addresses

When the original designers of the IP protocol created the IP addressing
scheme, they could have assigned an arbitrary number of IP address bits for
the network ID. The remaining bits would then be used for the host ID. For
example, the designers may have decided that half of the address (16 bits)
would be used for the network and the remaining 16 bits would be used for
the host ID. The result of that scheme would be that the Internet could have a
total of 65,536 networks and each of those networks could have 65,536 hosts.

In the early days of the Internet, this scheme probably seemed like several
orders of magnitude more than would ever be needed. However, the IP
designers realized from the start that few networks would actually have tens
of thousands of hosts. Suppose that a network of 1,000 computers joins the
Internet and is assigned one of these hypothetical network IDs. Because that
network uses only 1,000 of its 65,536 host addresses, more than 64,000 IP
addresses would be wasted.

As a solution to this problem, the idea of IP address classes was introduced.
The IP protocol defines five different address classes: A, B, C, D, and E. Each of
the first three classes, A through C, uses a different size for the network ID and
host ID portion of the address. Class D is for a special type of address called a
multicast address. Class E is an experimental address class that isn’t used.

The first four bits of the IP address are used to determine into which class a
particular address fits:
v~ If the first bit is a zero, the address is a Class A address.

v If the first bit is one and the second bit is zero, the address is a Class B
address.

v If the first two bits are both one and the third bit is zero, the address is a
Class C address.

v~ If the first three bits are all one and the fourth bit is zero, the address is
a Class D address.

v If the first four bits are all one, the address is a Class E address.
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Because Class D and E addresses are reserved for special purposes, I focus
the rest of this discussion on Class A, B, and C addresses. Table 6-1 summa-
rizes the details of each address class.

Table 6-1 IP Address Classes

Class Address Starting Length of Number of Number of
Range Bits Network ID  Networks  Hosts

A 1-126.x.y.2 0 8 126 16,777,214
128-191.xyz 10 16 16,384 65,534

C 192-223x.yz 110 24 2,097,152 254

Class A addresses

Class A addresses are designed for very large networks. In a Class A address,
the first octet of the address is the network ID, and the remaining three
octets are the host ID. Because only eight bits are allocated to the network ID,
and the first of these bits is used to indicate that the address is a Class A
address, only 126 Class A networks can exist in the entire Internet. However,
each Class A network can accommodate more than 16 million hosts.

Only about 40 Class A addresses are assigned to companies or organizations.
The rest are either reserved for use by the IANA (Internet Assigned Numbers
Authority) or are assigned to organizations that manage IP assignments for
geographic regions, such as Europe, Asia, and Latin America.

Just for fun, Table 6-2 lists some of the better-known Class A networks. You
probably recognize many of them. In case you’re interested, you can find

a complete list of all the Class A address assignments at www.iana.org/
assignments/ipv4-address-space.

Table 6-2 Some Well-Known Class A Networks
Net Description Net Description
3 General Electric Company 20 Computer Sciences
Corporation
6 Army Information Systems 22,26, Defense Information
Center 29,30 Systems Agency

9 IBM 34 Halliburton
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Net Description Net Description

1 DoD Intel Information Systems 38 Performance Systems
International

12 AT&T Bell Laboratories 40 Eli Lilly and Company

13 Xerox Corporation 43 Japan Inet

15 Hewlett-Packard Company 45 Interop Show Network

16 Digital Equipment Corporation 47 Bell-Northern Research

17 Apple Computer, Inc. 48 Prudential Securities Inc.

18 MIT 54 Merck and Co., Inc.

19 Ford Motor Company 56 U.S. Postal Service

Class B addresses

In a Class B address, the first two octets of the IP address are used as the net-
work ID, and the second two octets are used as the host ID. Thus, a Class B
address comes close to my hypothetical scheme of splitting the address
down the middle, using half for the network ID and half for the host ID. It isn’t
identical to this scheme, however, because the first two bits of the first octet
are required to be 10, to indicate that the address is a Class B address. Thus,
a total of 16,384 Class B networks can exist. All Class B addresses fall within
therange 128 .x.y.zto 191.x.y.z. Each Class B address can accommo-
date more than 65,000 hosts.

The problem with Class B networks is that even though they’re much smaller
than Class A networks, they still allocate far too many host IDs. Very few net-
works have tens of thousands of hosts. Thus, the careless assignment of
Class B addresses can lead to a large percentage of the available host
addresses being wasted on organizations that don’t need them.

Class C addresses

In a Class C address, the first three octets are used for the network ID, and
the fourth octet is used for the host ID. With only eight bits for the host ID,
each Class C network can accommodate only 254 hosts. However, with 24

network ID bits, Class C addresses allow for more than 2 million networks.
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What about IPv6?

Most of the current Internet is based on version
4 of the Internet Protocol, also known as IPv4.
IPv4 has served the Internet well for more than
20 years. However, the growth of the Internet
has put a lot of pressure on IPv4’s limited 32-bit
address space. This chapter describes how
IPv4 has evolved to make the best possible use
of 32-bit addresses, but eventually all the
addresses will be assigned — the IPv4 address
space will be filled to capacity. When that hap-
pens, the Internet will have to migrate to the
next version of IP, known as IPv6.

IPv6 is also called /P next generation, or IPng,
in honor of the favorite television show of most
Internet gurus, Star Trek: The Next Generation.

IPv6 offers several advantages over IPv4, but
the most important is that it uses 128 bits for
Internet addresses rather than 32 bits. The
number of host addresses possible with 128 bits

is a number so large that it would make Carl
Sagan proud. It doesn't just double or triple the
number of available addresses. Just for the fun
of it, here's the number of unique Internet
addresses provided by IPv6:

340,282,366,920,938,463,463,374,607,431,768,
211,456

This number is so large that it defies understand-
ing. If the IANA had been around at the creation
of the universe and started handing out IPv6
addresses at a rate of one per millisecond, it
would now, 15 billion years later, have not yet allo-
cated even 1 percent of the available addresses.

Unfortunately, the transition from IPv4 to IPv6
has been a slow one. Thus, the Internet will
continue to be driven by IPv4 for at least a few
more years.

The problem with Class C networks is that they’re too small. Although few
organizations need the tens of thousands of host addresses provided by a
Class B address, many organizations need more than a few hundred. The
large discrepancy between Class B networks and Class C networks led to

the development of subnetting, which is described in the next section.

Subnetting

Subnetting is a technique that lets network administrators use the 32 bits

available in an IP address more efficiently by creating networks that aren’t
limited to the scales provided by Class A, B, and C IP addresses. With subnet-
ting, you can create networks with more realistic host limits.

Subnetting provides a more flexible way to designate which portion of an IP
address represents the network ID and which portion represents the host ID.
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With standard IP address classes, only three possible network ID sizes exist:
8 bits for Class A, 16 bits for Class B, and 24 bits for Class C. Subnetting lets
you select an arbitrary number of bits to use for the network ID.

Two reasons compel us to use subnetting. The first is to allocate the limited
[P address space more efficiently. If the Internet were limited to Class A, B,

or C addresses, every network would be allocated 254, 65,000, or 16 million

IP addresses for host devices. Although many networks with more than 254
devices exist, few (if any) exist with 65,000, let alone 16 million. Unfortunately,
any network with more than 254 devices would need a Class B allocation and
probably waste tens of thousands of IP addresses.

The second reason for subnetting is that even if a single organization has
thousands of network devices, operating all those devices with the same net-
work ID would slow the network to a crawl. The way TCP/IP works dictates
that all the computers with the same network ID must be on the same physi-
cal network. The physical network comprises a single broadcast domain,
which means that a single network medium must carry all the traffic for the
network. For performance reasons, networks are usually segmented into
broadcast domains that are smaller than even Class C addresses provide.

Subnets

A subnet is a network that falls within another (Class A, B, or C) network.
Subnets are created by using one or more of the Class A, B, or C host bits
to extend the network ID. Thus, rather than the standard 8-, 16-, or 24-bit
network ID, subnets can have network IDs of any length.

Figure 6-1 shows an example of a network before and after subnetting has
been applied. In the unsubnetted network, the network has been assigned
the Class B address 144.28.0. 0. All the devices on this network must
share the same broadcast domain.

In the second network, the first four bits of the host ID are used to divide

the network into two small networks, identified as subnets 16 and 32. To the
outside world (that is, on the other side of the router), these two networks
still appear to be a single network identified as 144.28.0. 0. For example,
the outside world considers the device at 144.28.16.22 to belong to the
144.28.0.0 network. As a result, a packet sent to this device is delivered to
the router at 144.28.0.0. The router then considers the subnet portion of
the host ID to decide whether to route the packet to subnet 16 or subnet 32.

115
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|
Figure 6-1:
A network
before and
after
subnetting.
|
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Subnet masks

For subnetting to work, the router must be told which portion of the host ID
to use for the subnet’s network ID. This little sleight of hand is accomplished
by using another 32-bit number, known as a subnet mask. Those IP address
bits that represent the network ID are represented by a 1 in the mask, and
those bits that represent the host ID appear as a 0 in the mask. As a result, a
subnet mask always has a consecutive string of ones on the left, followed by
a string of zeros.

For example, the subnet mask for the subnet, as shown in Figure 6-1, where
the network ID consists of the 16-bit network ID plus an additional 4-bit
subnet ID, would look like this:

11111111 11111111 11110000 00000000

In other words, the first 20 bits are ones; the remaining 12 bits are zeros.
Thus, the complete network ID is 20 bits in length, and the actual host ID
portion of the subnetted address is 12 bits in length.

To determine the network ID of an IP address, the router must have both
the IP address and the subnet mask. The router then performs a bitwise
operation called a logical AND on the IP address to extract the network ID.
To perform a logical AND, each bit in the IP address is compared to the
corresponding bit in the subnet mask. If both bits are 1, the resulting bit in
the network ID is set to 1. If either of the bits is 0, the resulting bit is set to 0.
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For example, here’s how the network address is extracted from an IP address
using the 20-bit subnet mask from the previous example:

144 . 28 . 16 . 17
IP address: 10010000 00011100 00100000 00001001
Subnet mask: 111131111 131311311 11110000 00000000
Network ID: 10010000 00011100 00100000 00000000
144 . 28 . 16 . 0

Thus, the network ID for this subnet is 144.28.16.0.

The subnet mask itself is usually represented in dotted-decimal notation. As a
result, the 20-bit subnet mask used in the previous example would be repre-
sented as 255.255.240.0:

Subnet mask: 11111111 11111111 11111111 11111111
255 . 255 . 240 . 0

Don’t confuse a subnet mask with an IP address. A subnet mask doesn’t rep-
resent any device or network on the Internet. It’s just a way of indicating
which portion of an IP address should be used to determine the network ID.
(You can spot a subnet mask right away because the first octet is always 255,
and 255 isn’t a valid first octet for any class of IP address.)

The great subnet roundup

You should know about a few additional restrictions that are placed on
subnet masks — in particular:

v The minimum number of network ID bits is eight. As a result, the first
octet of a subnet mask is always 255.

v The maximum number of network ID bits is 30. You have to leave at least
two bits for the host ID portion of the address, to allow for at least two
hosts. If you used all 32 bits for the network ID, that would leave no bits
for the host ID. Obviously, that doesn’t work. Leaving just one bit for the
host ID doesn’t work, either. That’s because a host ID of all ones is
reserved for a broadcast address — and all zeros refers to the network
itself. Thus, if you used 31 bits for the network ID and left only one for
the host ID, host ID 1 would be used for the broadcast address and host
ID 0 would be the network itself, leaving no room for actual hosts. That’s
why the maximum network ID size is 30 bits.

v Because the network ID is always composed of consecutive bits set to 1,
only nine values are possible for each octet of a subnet mask (including
counting 0). For your reference, these values are listed in Table 6-3.
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Table 6-3 The Eight Subnet Octet Values
Binary Octet Decimal Binary Octet Decimal
00000000 0 11111000 248
10000000 128 11111100 252
11000000 192 11111110 254
11100000 224 mmm 255
11110000 240

Private and public addresses

Any host with a direct connection to the Internet must have a globally unique
[P address. However, not all hosts are connected directly to the Internet.
Some are on networks that aren’t connected to the Internet. Some hosts

are hidden behind firewalls, so their Internet connection is indirect.

Several blocks of IP addresses are set aside just for this purpose — for use on
private networks that aren’t connected to the Internet or to use on networks
hidden behind a firewall. Three such ranges of addresses exist, as summa-
rized in Table 6-4. Whenever you create a private TCP/IP network, use IP
addresses from one of these ranges.

Table 6-4 Private Address Spaces

CIDR Subnet Mask Address Range

10.0.0.0/8 255.0.0.0 10.0.0.1-10.255.255.254
172.16.0.0/12 255.255.240.0 172.16.1.1-172.31.255.254
192.168.0.0/16 255.255.0.0 192.168.0.1-192.168.255.254

Understanding Network
Address Translation

Many firewalls use a technique called nefwork address translation (or NAT) to
hide the actual IP address of a host from the outside world. When that’s the
case, the NAT device must use a globally unique IP to represent the host to
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the Internet; behind the firewall, however, the host can use any IP address it
wants. As packets cross the firewall, the NAT device translates the private IP
address to the public IP address and vice versa.

One of the benefits of NAT is that it helps to slow down the rate at which the
IP address space is assigned. That’s because a NAT device can use a single
public IP address for more than one host. It does this by keeping track of out-
going packets so that it can match up incoming packets with the correct host.
To understand how this process works, consider this sequence of steps:

1. A host whose private address is 192.168.1.100 sends a request to
216.239.57.99, which happens to be www.google.com. The NAT
device changes the source IP address of the packet to 208.23.110.22,
the IP address of the firewall. That way, Google will send its reply back to
the firewall router. The NAT records that 192.168.1.100 sent a request
t0216.239.57.99.

2. Now another host, at address 192.168.1.107, sends a request to
207.46.134.190, which happens to be www.microsoft.com. The
NAT device changes the source of this request to 208.23.110.22 so
that Microsoft will reply to the firewall router. The NAT records that
192.168.1.107 sent a request to 207.46.134.190.

3. A few seconds later, the firewall receives a reply from 216.239.57.99.
The destination address in the reply is 208.23.110.22, the address of
the firewall. To determine to whom to forward the reply, the firewall
checks its records to see who is waiting for a reply from
216.239.57.99. It discovers that 192.168.1.100 is waiting for that
reply, so it changes the destination address to 192.168.1.100 and
sends the packet on.

Actually, the process is a little more complicated than that because it’s very
likely that two or more users may have pending requests from the same
public IP. In that case, the NAT device uses other techniques to figure out to
which user each incoming packet should be delivered.

Configuring Your Network for DHCP

Every host on a TCP/IP network must have a unique IP address. Each host
must be properly configured so that it knows its I[P address. When a new host
comes online, it must be assigned an IP address within the correct range of
addresses for the subnet — one that’s not already in use. Although you can
manually assign IP addresses to each computer on your network, that task
quickly becomes overwhelming if the network has more than a few computers.

That’s where DHCP, the Dynamic Host Configuration Protocol, comes
into play. DHCP automatically configures the IP address for every host
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on a network, thus ensuring that each host has a valid, unique IP address.
DHCP even automatically reconfigures IP addresses as hosts come and go.
As you can imagine, DHCP can save a network administrator many hours of
tedious configuration work.

In this section, you discover the ins and outs of DHCP: what it is, how it
works, and how to set it up.

Understanding DHCP

DHCP allows individual computers on a TCP/IP network to obtain their con-
figuration information — in particular, their IP addresses — from a server.
The DHCP server keeps track of which IP addresses have already been
assigned so that when a computer requests an IP address, the DHCP servers
offer it an IP address that isn’t already in use.

The alternative to DHCP is to assign each computer on your network a static
IP address:

v~ Static IP addresses are okay for networks with a handful of computers.

v For networks with more than a few computers, using static IP addresses
is a huge mistake. Eventually, some poor, harried administrator (guess
who) will make the mistake of assigning two computers the same IP
address. Then you have to manually check each computer’s I[P address
to find the conflict. DHCP is a must for any but the smallest networks.

Although the primary job of DHCP is to assign IP addresses, DHCP provides
more configuration information than just the IP address to its clients. The
additional configuration information is referred to as DHCP options. The fol-
lowing list describes some common DHCP options that can be configured by
the server:

v Router address, also known as the default gateway address

v Expiration time for the configuration information

v Domain name

v DNS server address
v WINS server address

DHCP servers

A DHCP server can be a server computer located on the TCP/IP network.
Fortunately, all modern server operating systems have a built-in DHCP server
capability. To set up DHCP on a network server, all you have to do is enable
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the server’s DHCP function and configure its settings. In the section,
“Managing a Windows Server 2003 DHCP Server,” later in this chapter, I
show you how to configure a DHCP server for Windows 2003.

A server computer running DHCP doesn’t have to be devoted entirely to
DHCP unless the network is very large. For most networks, a file server can
share duty as a DHCP server, especially if you provide long leases for your IP
addresses. (I explain the idea of leases later in this chapter.)

Many multifunction routers also have built-in DHCP servers. So, if you don’t
want to burden one of your network servers with the DHCP function, you can
enable the router’s built-in DHCP server. An advantage of allowing the router
to be your network’s DHCP server is that you rarely need to power down a
router. In contrast, you occasionally need to restart or power down a file
server to perform system maintenance, to apply upgrades, or to do some
needed troubleshooting.

Most networks require only one DHCP server. Setting up two or more servers
on the same network requires that you carefully coordinate the IP address
ranges (known as scopes) for which each server is responsible. If you acci-
dentally set up two DHCP servers for the same scope, you may end up with
duplicate address assignments if the servers attempt to assign the same IP
address to two different hosts. To prevent this situation from happening, set
up just one DHCP server unless your network is so large that one server can’t
handle the workload.

Understanding scopes

A scope is simply a range of IP addresses that a DHCP server is configured
to distribute. In the simplest case, where a single DHCP server oversees IP
configuration for an entire subnet, the scope corresponds to the subnet.
However, if you set up two DHCP servers for a subnet, you can configure
each one with a scope that allocates only one part of the complete subnet
range. In addition, a single DHCP server can serve more than one scope.

You must create a scope before you can enable a DHCP server. When you
create a scope, you can provide it with these properties:
v A scope name, which helps you to identify the scope and its purpose.

v A scope description, which lets you provide additional details about the
scope and its purpose.

v A starting IP address for the scope.
+ An ending IP address for the scope.
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v A subnet mask for the scope. You can specify the subnet mask with
dotted decimal notation or with Classless Inter Domain Routing (CIDR)
notation.

+* One or more ranges of excluded addresses. These addresses aren’t
assigned to clients. (For more information, see the section, “Feeling
excluded?,” later in this chapter.)

» One or more reserved addresses. These addresses are always assigned
to particular host devices. (For more information, see the section,
“Reservations suggested,” later in this chapter.)

v The lease duration, which indicates how long the host is allowed to use
the IP address. The client attempts to renew the lease when half of the
lease duration has elapsed. For example, if you specify a lease duration
of eight days, the client attempts to renew the lease after four days have
passed. The host then has plenty of time to renew the lease before the
address is reassigned to some other host.

v The router address for the subnet.
This value is also known as the default gateway address.

v The domain name and the IP address of the network’s DNS servers and
WINS servers.

Feeling excluded?

We all feel excluded once in a while. With a wife and three daughters, [ know
how that feels. Sometimes, however, being excluded is a good thing. In the
case of DHCP scopes, exclusions can help you to prevent IP address conflicts
and can enable you to divide the DHCP workload for a single subnet among
two or more DHCP servers.

An exclusion is a range of addresses not included in a scope but falling within
the range of the scope’s starting and ending addresses. In effect, an exclusion
range lets you punch a hole in a scope: The IP addresses that fall within the
hole aren’t assigned.

Here are a couple of reasons to exclude IP addresses from a scope:

v The computer that runs the DHCP service itself must usually have a
static IP address assignment. As a result, the address of the DHCP
server should be listed as an exclusion.

+ You may want to assign static IP addresses to your other servers. In
that case, each server IP address should be listed as an exclusion.

Reservations are often a better solution to this problem, as described in
the next section.
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Reservations suggested

In some cases, you may want to assign a specific IP address to a particular
host. One way to do this is to configure the host with a static IP address so
that the host doesn’t use DHCP to obtain its IP configuration. However, two
major disadvantages to that approach exist:

1 TCP/IP configuration supplies more than just the IP address. If you
use static configuration, you must manually specify the subnet mask,
default gateway address, DNS server address, and other configuration
information required by the host. If this information changes, you have
to change it not only at the DHCP server but also at each host that you
configured statically.

+ You must remember to exclude the static IP address from the
DHCP server’s scope. Otherwise, the DHCP server doesn’t know
about the static address and may assign it to another host. Then
comes the problem: You have two hosts with the same address on
your network.

A better way to assign a fixed IP address to a particular host is to create

a DHCP reservation. A reservation simply indicates that whenever a particu-
lar host requests an IP address from the DHCP server, the server should
provide it the address that you specify in the reservation. The host doesn’t
receive the IP address until the host requests it from the DHCP server, but
whenever the host does request IP configuration, it always receives the
same address.

To create a reservation, you associate the IP address that you want assigned
to the host with the host’s MAC address. Accordingly, you need to get the
MAC address from the host before you create the reservation:

v Usually, you can get the MAC address by running the command
ipconfig /all from a command prompt.

v~ If TCP/IP has not yet been configured on the computer, you can get
the MAC address by choosing the System Information command:

Choose Start>All Programst>Accessories=>System Toolst>System
Information.

If you set up more than one DHCP server, be sure to specify the same
reservations on each server. If you forget to repeat a reservation on one
of the servers, that server may assign the address to another host.
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How long to lease?

One of the most important decisions that you make when you configure a
DHCP server is the length of time to specify for the lease duration. The default
value is eight days, which is appropriate in many cases. However, you may
encounter situations in which a longer or shorter interval may be appropriate.

v The more stable your network, the longer the lease duration can safely
exist. If you only periodically add new computers to your network (or
replace existing computers), you can safely increase the lease duration
past eight days.

v The more volatile the network, the shorter the lease duration should be.
For example, you may have a wireless network in a university library,
used by students who bring their laptop computers into the library to
work for a few hours at a time. For this network, a duration as short as
one hour may be appropriate.

Don’t configure your network to allow leases of infinite duration. Although
some administrators feel that this duration cuts down the workload for
the DHCP server on stable networks, no network is permanently stable.
Whenever you find a DHCP server that’s configured with infinite leases,
look at the active leases. | guarantee that you'll find IP leases assigned to
computers that no longer exist.

Managing a Windows Server
2003 DHCP Server

The exact steps to follow when you configure and manage a DHCP server
depend on the network operating system or router you're using. The follow-
ing procedures show you how to work with a DHCP server in Windows Server
2003. The procedures for other operating systems are similar.

If you haven'’t already installed the DHCP server on the server, open the
Manage Your Server application (choose Starte>Administrative Tools=>
Manage Your Server), click Add or Remove a Role, select DHCP Server from
the list of roles, click Next, and then complete the New Scope Wizard to
create the first scope for the DHCP server. This wizard asks you to enter a
name and description for the scope. Then it asks for the basic IP address
range information for the scope, as shown in Figure 6-2.

After you enter the starting and ending IP addresses for the range and the
subnet mask used for your network, click Next. The wizard then asks for any
[P addresses you want to exclude from the scope, the lease duration (the
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default is 8 days), the IP address of your gateway router, the domain name for
your network, and the IP addresses for the DNS servers you want the client
computers to use. After you complete the wizard, the DHCP server is prop-
erly configured. It doesn’t start running, however, until you authorize it, as

described in the next section.

New Scope Wizard

IP Address Range
‘You define the scope address range by identifying a set of congecutive [P
addresses.

=

Enter the range of addresses that the scope distributes
StartIP address; | 192.768. 1 . 1

EndIP address: | 194.168. 1 254

10z and how many bits to use for the host [D. 'You can specify the subnet mask by
length ar as an IP address.

Length: 24 |

Subret mask: 265286286, O

A subnet mask defines how many bits of an IP address to use for the network./subnet
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Cancel

After you set up a DHCP server, you can manage it from the DHCP manage-
ment console by choosing Starte>Administrative Tools=>"DHCP or by clicking
Manage This DHCP Server from the Manage Your Server application. Either
way, the DHCP management console appears, as shown in Figure 6-3.
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From the DHCP console, you have complete control over the DHCP server’s
configuration and operation. The following paragraphs summarize some of
the things you can do from the DHCP console:

v Authorize the DHCP server, which allows it to begin assigning client
IP addresses: To authorize a server, select the server, choose Action=
Manage Authorized Servers, and click Authorize.

v Add another scope: Right-click the server in the tree and choose the
New Scope command from the menu that appears. This action opens
the New Scope Wizard so that you can create a new scope.

v Activate or deactivate a scope: Right-click the scope in the tree and
choose the Activate or Deactivate command.

1 Change scope settings: Right-click the scope and choose the Properties
command. This action opens the Scope Properties dialog box, which lets
you change the scope’s starting and ending IP addresses, subnet mask,
and DNS configuration.

v Change the scope exclusions: Click Address Pool under the scope in
the tree. This action lists each range of addresses that’s included in the
scope. You can add or delete a range by right-clicking the range and
choosing the Delete command from the menu that appears. You can also
add a new exclusion range by right-clicking Address Pool in the tree and
choosing Add New Exclusion from the pop-up menu.

1 View or change reservations: Click Reservations in the tree.

1 View a list of the addresses that are currently assigned: Click Address
Leases in the tree.

Configuring a Windows DHCP Client

Configuring a Windows client for DHCP is easy. The DHCP client is included
automatically when you install the TCP/IP protocol, so all you have to do is
configure TCP/IP to use DHCP. To do this, open the Network Properties dialog
box by choosing Network or Network Connections in the Control Panel
(depending on which version of Windows the client is running). Then select
the TCP/IP protocol and click the Properties button. This action opens the
TCP/IP Properties dialog box, as shown in Figure 6-4. To configure the com-
puter to use DHCP, select the Obtain an IP Address Automatically and Obtain
DNS Server Address Automatically check boxes.
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Using DN'S

DNS, which stands for domain name system, is the TCP/IP facility that lets
you use names rather than numbers to refer to host computers. Without DNS,
you’d buy books from 207.171.182.16 rather than from www.amazon. com,
you’d sell your used furniture at 66.135.192. 87 rather than on www. ebay.
com, and you’d search the Web at 216.239.51.100 rather than at www.
google.com.

| Advanced... |

Understanding how DNS works and how to set up a DNS server is crucial to
setting up and administering a TCP/IP network. The rest of this chapter intro-
duces you to the basics of DNS, including how the DNS naming system works
and how to set up a DNS server.

Domains and domain names

To provide a unique DNS name for every host computer on the Internet, DNS
uses a time-tested technique: divide and conquer. DNS uses a hierarchical
naming system that’s similar to the way folders are organized hierarchically
on a Windows computer. Instead of folders, however, DNS organizes its
names into domains. Each domain includes all the names that appear
directly beneath it in the DNS hierarchy.

For example, Figure 6-5 shows a small portion of the DNS domain tree. At the
top of the tree is the root domain, which is the anchor point for all domains.
Directly beneath the root domain are four top-level domains, named edu, com,
org, and gov.
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|

Figure 6-5:
DNS names.
|

LoweWriter.com domain

serverl.LoweWriter.com.

In reality, many more top-level domains than this exist in the Internet’s
root domain. In fact, at the time I wrote this, there were more than 87 million
of them.

Beneath the com domain in Figure 6-5 is another domain named LoweWriter,
which happens to be my own, personal domain. (Pretty clever, eh?) To com-
pletely identify this domain, you have to combine it with the name of its
parent domain (in this case, com) to create the complete domain name:
LoweWriter.com. Notice that the parts of the domain name are separated
from each other by periods, which are pronounced “dot.” As a result, when
you read this domain name, you should pronounce it “LoweWriter dot com.”

Beneath the LoweWriter node are four host nodes, named doug, debbie,
serverl, and printerl. These nodes correspond to three computers and

a printer on my home network. You can combine the host name with the
domain name to get the complete DNS name for each of my network’s hosts.
For example, the complete DNS name for my server is serverl.LoweWriter.
com. Likewise, my printer is printerl.LoweWriter.com.

Here are a few additional details that you need to remember about DNS names:

v DNS names aren’t case sensitive. As a result, LoweWriter and
Lowewriter are treated as the same name, as are LOWEWRITER,
LOWEwriter, and LoWeWrItEr. When you use a domain name, you can
use capitalization to make the name easier to read, but DNS ignores the
difference between capital and lowercase letters.
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v The name of each DNS node can be up to 63 characters long (not includ-
ing the dot) and can include letters, numbers, and hyphens. No other
special characters are allowed.

v A subdomain is a domain that’s beneath an existing domain. For exam-
ple, the com domain is a subdomain of the root domain. Likewise,
LoweWriter is a subdomain of the com domain.

v DNS is a hierarchical naming system that’s similar to the hierarchical
folder system used by Windows. However, one crucial difference exists
between DNS and the Windows naming convention. When you construct
a complete DNS name, you start at the bottom of the tree and work your
way up to the root. Thus, doug is the lowest node in the name doug.
LoweWriter.com. In contrast, Windows paths are the opposite: They
start at the root and work their way down. For example, in the path
\Windows\System32\dns, dns is the lowest node.

v The DNS tree can be up to 127 levels deep. However, in practice, the DNS
tree is pretty shallow. Most DNS names have just three levels (not count-
ing the root), and although you sometimes see names with four or five
levels, you rarely see more levels than that.

v~ Although the DNS tree is shallow, it’s very broad. In other words, each of
the top-level domains has a huge number of second-level domains imme-
diately beneath it. For example, at the time [ wrote this book, the com
domain had more than two million second-level domains beneath it.

Fully qualified domain names

If a domain name ends with a trailing dot, that trailing dot represents the
root domain, and the domain name is said to be a fully qualified domain

name (also known as an FQDN). A fully qualified domain name is also called
an absolute name. A fully qualified domain name is unambiguous because it
identifies itself all the way back to the root domain. In contrast, if a domain
name doesn’t end with a trailing dot, the name may be interpreted in the con-
text of some other domain. Thus, DNS names that don’t end with a trailing
dot are relative names.

This concept is similar to the way relative and absolute paths work in
Windows. For example, if a path begins with a backslash, such as \Windows\
System32\dns, the path is absolute. However, a path that doesn’t begin with
a backslash, such as System32\dns, uses the current folder as its starting
point. If the current folder happens to be \Windows, \Windows\System32\
dns and System32\dns refer to the same location.

In many cases, relative and fully qualified domain names are interchangeable
because the software that interprets them always interprets relative names in
the context of the root domain. That’s why, for example, you can type www.
wiley.com — without the trailing dot — rather than www.wiley.com. to go
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to the Wiley home page in a Web browser. Some applications, such as DNS
servers, may interpret relative names in the context of a domain other than
the root.

Working with the Windows DNS Server

|
Figure 6-6:
The
Configure a
DNS Server
Wizard.

The procedure for installing and managing a DNS server depends on the net-
work operating system you’re using. This section is specific to working with a
DNS server in Windows 2003. Working with BIND in a Linux or Unix environ-
ment is similar but without the help of a graphical user interface.

You can install the DNS server on Windows Server 2003 from the Manage
Your Server application. (Choose Start=>Administrative Tools=>Manage Your
Server.) Click the Add or Remove a Role link, select DNS Server from the list
of server roles, and then click Next to install the DNS server. The Configure a
DNS Server Wizard appears, as shown in Figure 6-6. This wizard guides you
through the process of configuring the first zone for your DNS server.

Configure a DNS Server Wizard ﬂ

Welcome to the Configure a DNS
Server Wizard
This wizard helps you configure a DMS server by creating

forward and reverse lookup zones and by specifying raot
hints and forwarders,

Befare continuing, review the DNS checklists.

Far more infarmation about configuring DMS, click Help.

To continue, dick Mext,

= Barl Mext = Cancel Help

After you set up a DNS server, you can manage the DNS server from the DNS
management console. Here, you can perform common administrative tasks,
such as adding additional zones, changing zone settings, or adding A or MX
records to an existing zone. The DNS management console hides the details
of the resource records from you, thus allowing you to work with a friendly

graphical user interface instead.

To add a new host (that is, an A record) to a zone, right-click the zone in the
DNS management console and choose the Add New Host command. This
action opens the New Host dialog box, as shown in Figure 6-7.
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This dialog box lets you specify the following information:

v Name: The host name for the new host.
v IP Address: The host’s IP address.

v Create Associated Pointer (PTR) Record: Automatically creates a PTR
record in the reverse lookup zone file. Select this option if you want to
allow reverse lookups for the host.

v~ Allow Any Authenticated User to Update: Select this option if you want
to allow other users to update this record or other records with the
same host name. You should usually leave this option unchecked.

v Time to Live: The TTL value for this record.

You can add other records, such as MX or CNAME records, in the same way.

Configuring a Windows DNS Client

Client computers don’t need much configuration to work properly with
DNS. The client must have the address of at least one DNS server. Usually,
this address is supplied by DHCP, so if the client is configured to obtain
its IP address from a DHCP server, it also obtains the DNS server address
from DHCP.

To configure a client computer to obtain the DNS server location from DHCP,
open the Network Properties dialog box by choosing Network or Network
Connections in the Control Panel (depending on which version of Windows
the client is running). Then select the TCP/IP protocol and click the
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Properties button. This action summons the TCP/IP Properties dialog box,
as shown in Figure 6-8:

v To configure the computer to use DHCP, select the Obtain an [P
Address Automatically and the Obtain DNS Server Address
Automatically options.

v~ If the computer doesn’t use DHCP, you can use this same dialog box to
manually enter the IP address of your DNS server.

Internet Protocol (TCP/IP) Properties @@
General | Altemate Conliguration
You can get [P seltings assigned automatically if your network supports
this capahility. Otherwize, you need to ask your network administratar for
the appropriate [P settings.
(0) Use the following IP address:
|
Figure 6-8:
Configuring
a Windows
. (%) Dbtain DNS server address automatically
clientto
L. (0 Use the following DNS server addresses:
obtain its
address
from
DHCP8m.
|




Chapter 7
Setting Up a Server

In This Chapter

Thinking about the different ways to install a network operating system
Getting ready for the installation
Installing a network operating system

Figuring out what to do after you install the network operating system

One of the basic choices that you must make before you proceed any fur-
ther in building your network is to decide which network operating
system (NOS) to use as the foundation for your network. This chapter begins
with a description of several important features found in all network operat-
ing systems. Next, it provides an overview of the advantages and disadvan-
tages of the most popular network operating systems.

Of course, your work doesn’t end with the selection of an NOS. You must then
install and configure the NOS to get it working. This chapter provides an
overview of what’s involved with installing and configuring the most popular
NOS choice, Windows Server 2003.

Network Operating System Features

All network operating systems must provide certain core functions, such as
connecting to other computers on the network, sharing files and other
resources, and providing for security. In the following sections, I describe
some core NOS features in general terms.

Network support

It goes without saying that a network operating system should support net-
works. (I can picture Mike Myers in his classic Saturday Night Live role as
Linda Richman, host of Coffee Talk, saying “I'm getting a little verklempt . . .
talk amongst yourselves . . . I'll give you a topic: Network operating systems
do not network, nor do they operate. Discuss.”)
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That requires a range of technical capabilities:

v A network operating system must support a wide variety of nefworking
protocols to meet the needs of its users.

A large network typically consists of a mixture of various versions of
Windows, as well as Macintosh and Linux computers. As a result, the
server may need to simultaneously support TCP/IP, NetBIOS, and
AppleTalk protocols.

1 Many servers have more than one network interface card installed. In
that case, the NOS must be able to support multiple network connections:

¢ [deally, the NOS should be able to balance the network load among
its network interfaces.

e If one of the connections fails, the NOS should be able to seam-
lessly switch to another connection.

v Most network operating systems include a built-in capability to function
as a router that connects two networks.

The NOS router functions should also include firewall features to keep
unauthorized packets from entering the local network.

File-sharing services

One of the most important functions of a network operating system is to share
resources with other network users. The most common resource that’s shared
is the server’s file system — organized disk space that a network server must
be able to share (in whole or in part) with other users. In effect, those users
can treat the server’s disk space as an extension of their own computers’ disk
space.

The NOS allows the system administrator to determine which portions of the
server’s file system to share.

Although an entire hard drive can be shared, it isn’t commonly done. Instead,
individual directories or folders are shared. The administrator can control
which users are allowed to access each shared folder.

Because file sharing is the reason many network servers exist, network oper-
ating systems have more sophisticated disk management features than are
found in desktop operating systems. For example, most network operating
systems can manage two or more hard drives as though they were a single
drive. In addition, most can create a mirror — an automatic backup copy of
a drive — on a second drive.
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Multitasking

Only one user at a time uses a desktop computer; however, multiple users
simultaneously use server computers. As a result, a network operating
system must provide support for multiple users who access the server
remotely via the network.

At the heart of multiuser support is multitasking — a technique that slices
processing time microthin and juggles the pieces lightning fast among run-
ning programs. It’s how an operating system can execute more than one pro-
gram (a fask or a process) at a time. Multitasking operating systems are like
the guy who used to spin plates balanced on sticks on the old Ed Sullivan
Show. He’d run from plate to plate, trying to keep them all spinning so that
they wouldn’t fall off the sticks. To make it challenging, he’d do it blindfolded
or riding on a unicycle. Substitute programs for the plates and file manage-
ment for the unicycle, and there you are.

Although multitasking creates the appearance that two or more programs are
executing on the computer at the same time, in reality a computer with a
single processor can execute only one program at a time. The operating
system switches the CPU from one program to another to create the appear-
ance that several programs are executing simultaneously, but at any given
moment, only one of the programs is processing commands. The others are
patiently waiting their turns. (However, if the computer has more than one
CPU, the CPUs can execute programs simultaneously — but that’s another
kettle of fish.)

To see multitasking in operation on a Windows Server 2003 computer, press
Ctrl+Alt+Delete to bring up the Windows Task Manager and then click the
Processes tab. This displays all tasks that are active on the computer, as
shown in Figure 7-1.

Directory services

Directories are everywhere — and were, even in the days when they were all
hard copy. When you needed to make a phone call, you looked up the number
in a phone directory. When you needed to find the address of a client, you
looked her up in your Rolodex. And then there were the nonbook versions:
When you needed to find the Sam Goody store at a shopping mall (for exam-
ple), you looked for the mall directory — usually, a lighted sign showing
what was where.
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Networks have directories, too, providing information about the resources
that are available on the network — such as users, computers, printers,
shared folders, and files. Directories are an essential part of any network
operating system.

In early network operating systems (such as Windows NT 3.1 and NetWare
3.X), each server computer maintained its own directory database — a file
that contained an organized list of the resources available just on that server.
The problem with that approach was that network administrators had to
maintain each directory database separately. That wasn’t too bad for net-
works with just a few servers, but maintaining the directory on a network
with dozens or even hundreds of servers was next to impossible.

In addition, early directory services (programs that made the directory data-
bases usable) were application specific. For example, a server had one direc-
tory database for user logons, another for file sharing, and yet another for
e-mail addresses. Each directory had its own tools for adding, updating, and
deleting directory entries.

The most popular modern directory service is Active Directory, which is stan-
dard with Windows-based server operating systems. Active Directory provides
a single directory of all network resources. It drops the old-style 15-character
domain and computer names that were used by Windows NT Server in favor
of Internet-style DNS-style names, such as Marketing.MyCompany .com Or
Sales.YourCompany .com. Figure 7-2 shows the Active Directory Users and
Computers tool, which is used to manage Active Directory user and computer
accounts on Windows Server 2003.
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Security services

All network operating systems must provide some measure of security to
protect the network from unauthorized access. Hacking seems to be the
national pastime these days. With most computer networks connected to the
Internet, anyone anywhere in the world can — and probably will — try to
break into your network.

The most basic type of security is handled through user accounts, which grant
individual users the right to access the network resources and govern which
resources the user can access. User accounts are secured by passwords;
therefore, good password policy is a cornerstone of any security system.
Most network operating systems give you some standard tools for maintain-
ing network security:

v~ Establish password policies, such as requiring that passwords have a
minimum length and include a mix of letters and numerals.

v Set passwords to expire after a certain number of days. Doing so
forces network users to change their passwords frequently.

v Encrypt network data. A data-encryption capability scrambles data
before it’s sent over the network or saved on disk, making unauthorized
use a lot more difficult.
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\P . .
) Good encryption is the key to setting up a virtual private network, or

VPN, which enables network users to securely access a network from a
remote location by using an Internet connection.

1~ Issue digital certificates. These special codes are used to ensure that
users are who they say they are and files are what they claim to be.

Understanding Windows
Server 2003 Versions

The current version of Windows for network servers is Windows Server 2003.
Windows Server 2003 builds on Windows 2000 Server, with many new fea-
tures. Here are just a few of its new features:

v A new and improved version of Active Directory with tighter security, an
easier-to-use interface, and better performance.

v A better and easier-to-use system-management interface: the Manage
My Server window. On the flip side — for those who prefer brute-force
commands — Windows Server 2003 includes a more comprehensive set
of command-line management tools than is offered by Windows 2000
Server. Of course, the familiar Microsoft Management Console tools from
Windows 2000 Server are still there.

v A built-in Internet firewall to secure your Internet connection.

v A new version of the Microsoft Web server, Internet Information Services
11S) 6.0.

Windows Server 2003 comes in several versions — four, to be specific:

v Windows Server 2003, Standard Edition: This is the basic version of
Windows 2003. If you're using Windows Server 2003 as a file server or to
provide other basic network services, this version is the one you use.

Standard Edition can support servers with up to four processors and
4GB of RAM.

v Windows Server 2003, Web Edition: This version of Windows 2003 is
optimized for use as a Web server.

1 Windows Server 2003, Enterprise Edition: Designed for larger net-
worKks, this version can support servers with up to eight processors,
32GB of RAM, server clusters, and advanced features designed for high
performance and reliability.

v Windows Server 2003, Datacenter Edition: This is the most powerful ver-
sion of Windows 2003, with support for servers with 64 processors, 64GB
of RAM, and server clusters, as well as advanced fault-tolerance features
designed to keep the server running for mission-critical applications.
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The pricing for Windows Server 2003 is based on the number of clients that
will use each server. Each server must have a server license — and an appro-
priate number of client licenses. When you buy Windows Server 2003, you get
a server license and (depending on the size of your network) a bundle of 5,
10, or 25 client licenses. You can then purchase additional client licenses 5 or
20 at a time. Table 7-1 lists the prices for the various types of Windows Server
2003 and client licenses.

Table 7-1 Windows 2003 Server Pricing

Product Price
Windows Server 2003, 5 clients $999
Windows Server 2003, 10 clients $1,199
Windows Server 2003 Enterprise Edition, 25 clients $3,999
Client license 5-pack $199
Client license 20-pack $799
Windows Server 2003, Web Edition $399

Other Server Operating Systems

Although Windows Server 2003 is the most popular choice for network oper-
ating systems, it isn’t the only available choice. The following sections briefly
describe two other server choices: Linux and the Macintosh OS X Server.

Linux

Perhaps the most interesting operating system now available is Linux. The
free Linux operating system is based on Unix, a powerful network operating
system often used on large networks. Linux was started by Linus Torvalds,
who thought it’d be fun to write a version of Unix in his free time — as a hobby:.
He enlisted help from hundreds of programmers throughout the world, who
volunteered their time and efforts via the Internet. Today, Linux is a full-featured
version of Unix; its users consider it to be as good as or better than Windows.
In fact, almost as many people now use Linux as use Macintosh computers.

Linux offers the same networking benefits of Unix and can be an excellent
choice as a server operating system.

Apple Mac 0S X Server

All the other server operating systems I describe in this chapter run on Intel-
based PCs with Pentium or Pentium-compatible processors. But what about
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Macintosh computers? After all, Macintosh users need networks, too. For
Macintosh networks, Apple offers a special network server operating system
known as Mac OS X Server. Mac OS X Server has all the features you expect in
a server operating system: file and printer sharing, Internet features, e-mail,
and others.

The Many Ways to Install a
Network Operating System

Regardless of which network operating system you choose to use for your
network servers, you can use any of several common ways to install the
NOS software on the server computer. The following sections describe these
alternatives.

Full install versus upgrade

One of your basic NOS installation choices is whether you want to perform a
full installation or an upgrade installation. In some cases, you may be better
off performing a full installation even if you're installing the NOS on a computer
that already has an earlier version of the NOS installed. Here are your choices:

v If you're installing the NOS on a brand-new server, you're performing a
full installation that installs the operating system and configures it with
default settings.

v If you're installing the NOS on a server computer that already has a server
operating system installed, you can perform an upgrade installation that
replaces the existing operating system with the new one but retains as
many of the settings as possible from the existing operating system.

v You can also perform a full installation on a computer that already has
an operating system installed. In that case, you have these two options:

¢ Delete the existing operating system.

e Perform a multiboot installation, which installs the new server oper-
ating system alongside the existing operating system. When you
restart the computer, you can choose which operating system you
want to run.

@“\NG! Although multiboot installation may sound like a good idea, it’s fraught
with peril. I suggest that you avoid the multiboot option unless you have
a specific reason to use it. For more information about multiboot setups,
see the nearby sidebar “Giving multiboot the boot.”
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v You can’t upgrade a client version of Windows to a server version.
Instead, you must perform either

e A full installation, which deletes the existing Windows operating
system.

e A multiboot installation, which leaves the existing client Windows
intact.

Either way, you can preserve existing data on the Windows computer
when you install the server version.

Installation over the network

Normally, you install the NOS directly from the distribution discs on the
server’s CD-ROM drive. However, you can also install the operating system
from a shared drive located on another computer, if the server computer
already has access to the network. You can either use a shared CD-ROM drive
or copy the entire contents of the distribution disc onto a shared hard drive.

Giving multiboot the boot

Multiboot installations enable you to have more
than one operating system on a single com-
puter. Of course, only one of these operating
systems can be running at any time. When you
boot the computer, a menu appears with each
of the installed operating systems listed. You
can choose which operating system to boot
from this menu.

Multiboot is most useful for software developers
or network managers who want to make sure
that software is compatible with a wide variety
of operating systems. Rather than set up a bunch
of separate computers with different operating
system versions, you can install several operat-
ing systems on a single PC and use that one PC
to test the software. For production network
servers, however, you probably don't need to
have more than one operating system installed.

If you still insist on loading two or more operat-
ing systems on a network server, be sure to

install each operating system into its own disk
partition. Although most network operating sys-
tems let you install two (or more) operating sys-
tems into a single partition, doing so is not a
good idea. To support two operating systems in
a single partition, the operating systems have to
play a risky shell game with key system files —
moving or renaming them each time you restart
the computer. Unfortunately, things can go
wrong. For example, if lightning strikes and the
power goes out just as the NOS is switching the
startup files around, you may find yourself with
a server that can't boot to any of its installed
operating systems.

The best way to set up a multiboot system is to
install each operating system into its own parti-
tion. Then you can use a boot manager program
to choose the partition you want to boot from
when you start the computer.
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Obviously, the server computer must have network access for this technique
to work. If the server already has an operating system installed, it probably
already has access to the network. If not, you can boot the computer from a
floppy that has basic network support.

If you're going to install the NOS on more than one server, you can save time
by first copying the distribution CD to a shared hard drive. That’s because
even the fastest CD-ROM drives are slower than the network. Even with a
basic 10/100 Mbps network, access to hard drive data over the network is
much faster than access to a local CD-ROM drive.

Automated and remote installations

In case you find yourself in the unenviable position of installing a NOS on sev-
eral servers, you can use a few tricks to streamline the process:

v Automated setup: Lets you create a setup script that provides answers
to all the questions asked by the installation program. After you create
the script, you can start the automated setup, leave, and come back
when the installation is finished.

Creating the setup script is a bit of work, so automated setup makes
sense only if you have more than a few servers to install.

* Remote Installation Services (RIS): The Microsoft feature that lets you
install Windows 2000 Server or Windows Server 2003 from a remote net-
work location without even going to the server computer.

This feature is tricky to set up, so it’s worth it only if you have to install
operating systems on a lot of servers. (RIS can also install client operat-
ing systems.)

Gathering Vour Stuff

Before you install a network operating system, you should gather up every-
thing you need so that you don’t have to look for something in the middle of
the setup. The following sections describe the items you're most likely to need.

A capable server computer

Obviously, you have to have a server computer on which to install the NOS.
Each NOS has a list of the minimum hardware requirements supported by the
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operating system. Table 7-2 lists two kinds of minimum requirements for
Windows Server 2003:

v Microsoft’s extremely inadequate published requirements

v Your author’s realistic recommendations for acceptable performance

Table 7-2 Windows Server 2003 Hardware Requirements

Hardware Microsoft's Published Doug’s Realistic
Minimum Minimum

CPU 133 MHz Pentium 1 GHz Pentium
RAM 128MB 2GB
Free disk space 1.5GB 20GB

V?‘“\NG!
$ Computer components are inexpensive enough that you shouldn’t scrimp on

hardware costs.

You should also check your server hardware against the list of compatible
hardware published by the maker of your NOS. For example, Microsoft pub-
lishes a list of hardware that it has tested and certified as compatible with
Windows servers. This list is the Hardware Compatibility List, or HCL for short.
You can check the HCL for your specific server by going to the Microsoft Web
site at www.microsoft.com/whdc/hcl/default.mspx. You can also test
your computer’s compatibility by running the Check System Compatibility
option from the Windows distribution disc.

The server operating system

You also need a server operating system to install. You need either the distri-
bution discs or access to a copy of them over the network. In addition to the
discs, you should have these items:

v The product key: The installation program asks you to enter the prod-
uct key during the installation to prove that you have a legal copy of the

software.
\\3

If you have the actual CD-ROM discs, the product key should be on a
sticker attached to the case.

v Manuals: If the operating system came with printed manuals, keep them
handy.
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v A startup diskette: If you're installing on a brand-new server, you need
some way to boot the computer. Depending on the NOS version you're
installing and the capabilities of the server computer, you may be able
to boot the computer directly from the distribution disc. If not, you need
a floppy disk from which to boot the server.

+* Your license type: You can purchase Microsoft operating systems on a
per-server or per-user basis. You need to know which plan you have
when you install the NOS.

P Check the CD-ROM distribution disc for product documentation and addi-
tional last-minute information. For example, Windows servers have a \docs
folder that contains several files that have useful setup information.

Other software

In most cases, the installation program should be able to automatically con-
figure your server’s hardware devices and install appropriate drivers. Just
in case, though, you should dig out the driver discs that came with your
devices, such as network interface cards, SCSI devices, CD-ROM drives,
printers, and scanners.

A working Internet connection

This item isn’t an absolute requirement, but the installation goes much more
smoothly if you have a working Internet connection before you start. The
installation process may use this Internet connection for several tasks:

v Downloading late-breaking updates or fixes to the operating system:
This can eliminate the need to install a service pack after you finish
installing the NOS.

v Locating drivers for nonstandard devices: This one can be a big plus if
you can’t find the driver disk for your obscure SCSI card.

v Activating the product after you complete the installation (for
Microsoft operating systems): For more information, see the section
“Activating Windows,” later in this chapter.

A good book

You spend lots of time watching progress bars during installation, so you may
as well have something to do while you wait.
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Making Informed Decisions
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When you install a NOS, you have to make some decisions about how you want
the operating system and its servers to be configured. Most of these decisions
aren’t cast in stone, so don’t worry if you’re not 100 percent sure how you
want everything configured. You can always go back and reconfigure things.
However, you can save yourself time if you make the right decisions up front
rather than just guess when the Setup program starts asking you questions.

The following list details most of the decisions that you need to make:

+~ The existing operating system: If you want to retain the existing operat-
ing system, the installation program can perform a multiboot setup,
which allows you to choose which operating system to boot to each
time you start the computer.

This is rarely a good idea for server computers. [ recommend that you
delete the existing operating system.

v~ Partition structure: Most of the time, you want to treat the entire server
disk as a single partition. However, if you want to divide the disk into
two or more partitions, you should do so during setup. (Unlike most of
the other setup decisions, this one is hard to change later.)

v Computer name: During the operating system setup, you're asked to
provide the computer name used to identify the server on the network.

If your network has only a few servers, you can just pick a name, such as
Server(O1 or MyServer. If your network has more than a few servers,
follow an established guideline for creating server names.

v Administrator password: Okay, this one is tough. You don’t want to pick
something obvious, like Password, Administrator, or your last name. On
the other hand, you don’t want to type something random that you’ll
later forget, because you’ll be in a big pickle if you forget the administra-
tor password.

Make up a complex password consisting of a mix of uppercase and lower-
case letters, some numerals, and a special symbol or two; then write it
down and keep it in a secure location where you know that it won’t get lost.

1 Networking protocols: You almost always need to install the TCP/IP pro-
tocol, the Microsoft network client protocol, and file and printer sharing.
Depending on how the server will be used, you may want to install other
protocols as well.

1 TCP/IP configuration: You need to know which IP address to use for the
server. Even if your network has a DHCP server to dynamically assign IP
addresses to clients, most servers use static IP addresses.

v Domain name: You need to know the domain name for the network.

145
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Making Final Preparations

Before you begin the installation, you should take a few more steps:

v Clean up the server’s disk by uninstalling any software that you don’t
need and removing any old data that’s no longer needed. This step is
especially important if you’re converting a computer that has been in
use as a client computer to a server. You probably don’t need Microsoft
Office or a bunch of games on the computer after it becomes a server.

v Do a complete backup of the computer. Operating system setup programs
are almost flawless, so the chances of losing data during installation are
minimal. But you still face the chance that something may go wrong.

v~ If the computer is connected to an Uninterruptible Power Supply (UPS)
that has a serial or USB connection to the computer, unplug the serial or
USB connection. In some cases, this control connection can confuse the
operating system’s Setup program when it tries to determine which
devices are attached to the computer.

v Light some votive candles, take two Tylenol, and put on a pot of coffee.

Installing a Network Operating System

The following sections present an overview of a typical installation of
Windows Server 2003. Although the details vary, the overall installation
process for other network operating systems is similar.

The method you use to begin the installation depends on whether the com-
puter already has a working operating system:

v~ If the computer already has a working operating system, simply insert
the Windows 2003 Setup disc in the computer’s CD-ROM drive. After a
moment, a dialog box appears, asking whether you want to install
Windows Server 2003. Click Yes to proceed.

v If you're installing Windows Server 2003 from a network drive, open a
My Network Places window, navigate to the shared folder that contains
the distribution files, and run Winnt32 . exe.

v~ If the computer doesn’t already have a working operating system but
can boot from a CD-ROM disc, insert the distribution disc into the
CD-ROM drive and restart the computer.

v~ If the computer doesn’t have a working operating system and can’t boot
from its CD-ROM drive, insert a bootable floppy disk that has CD-ROM
support into drive A and restart the computer. When the MS-DOS com-
mand prompt appears, type d: to switch to the CD-ROM drive (assuming
that drive D is the CD-ROM), type cd \i386, and then type winnt.
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As the Setup program proceeds, it leads you through five distinct installation
phases: Collecting Information, Dynamic Update, Preparing Installation,
Installing Windows, and Finalizing Installation. The following sections
describe each of these installation phases in greater detail.

Phase 1: Collecting Information

In the first installation phase, the Setup program asks for the preliminary
information that it needs to begin the installation. A wizard-like dialog box
appears so that it gather the following information:

1 Setup Type: You can choose to perform a new installation or an upgrade.

v License Agreement: The official license agreement is displayed. You
have to agree to its terms to proceed.

v Product Key: Enter the 25-character product key that’s printed on the
sticker attached to the CD-ROM disc case. If Setup says that you entered
an invalid product key, double-check it carefully. You probably just
typed the key incorrectly.

v Setup Options: You can click Advanced Options to change the file loca-
tions used for Setup, but you should stick to the defaults. If you need to
use accessibility features, such as the Magnifier, during Setup, click
Accessibility Options and enable the features you need. In addition, if
you want to change the language setting, click Primary Language and
make your selections.

v Upgrade to NTFS: If you want to upgrade a FAT32 system to NTFS, you
need to say so now.

Phase 2: Dynamic Update

In the next installation phase, Setup connects to the Microsoft Web site by using
your Internet connection and checks to see whether any installation files have
been changed. If so, the updated installation files are downloaded at this time. If
you don’t have a working Internet connection, you have to skip this phase.

Phase 3: Preparing Installation

In this phase, the computer is restarted and booted into a special text-mode
Setup program. After the Welcome screen appears, Setup proceeds through
these steps:

v~ Partition Setup: You're asked to choose the partition that you want to
use for the installation. You can reconfigure your partitions from this
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screen by deleting existing partitions or creating new ones. In most
cases, you want to install Windows into a single partition that uses all
available space on the drive.

1 Delete Existing Windows Installation: This page lets you choose whether
you want to delete your existing Windows installation or leave it in place.
You should choose to delete it unless you want a multiboot installation.

v Convert to NTFS: If you elected to convert an existing FAT32 partition to
\\3 NTEFS, the conversion takes awhile.

Now is a good time to get a fresh cup of coffee.

v Copying Files: Now Windows copies its installation files to your hard
drive. This step also takes awhile.

Phase 4: Installing Windows

Now that the drive has been set up and the installation files copied, Windows
Setup reboots your computer back into Windows mode and begins the actual
process of installing Windows. You're taken through the following steps:

v~ Installing Devices: Windows automatically examines each and every
device on the computer and installs and configures the appropriate
device drivers. This step can take awhile.

+ Regional and Language Options: In this step, you're asked to enter

" information about your region and language.

If you're in the U.S., you can accept the defaults. Otherwise, you can
change the settings appropriately.

1 Personalize Your Software: In this step, you can enter your name and your
company name. Your name is required, but the company name is optional.

v License Modes: In this step, you choose whether you purchased per-
server or per-device/per-user licensing. You can change this setting

W later, but you can only change the setting once.

If you're not sure, double-check the invoice that Microsoft shipped along
with the software.

v Computer Name and Administrator Name: Enter the computer name
QWING/ and Administrator account password here.

V.
S Be sure to write down the password and keep it in a secure location.
You'll be in serious trouble if you forget it.

+ Date and Time Settings: If the date and time information is incorrect,
you can change it here.

1 Network Settings: In most cases, you can select the Typical option in
this step to install the network features that are used most often: Client
for Microsoft Networks, Network Load Balancing, File and Printer
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Sharing for Microsoft Networks, and Internet Protocol (TCP/IP). If you
don’t want to use these defaults, you can select Custom Settings, and
then configure these features yourself.

1+ Workgroup or Domain: Next, you're asked whether the computer is part
of a workgroup or a domain. Choose the appropriate option and enter
the workgroup or domain name.

v Copying Files: Windows copies files, updates the registry, and ties up
any loose ends. This step can take a long time, so you may want to go
for a walk.

Phase 5: Finalizing Installation

To complete the installation, Setup saves your settings and reboots the com-
puter one final time. When the computer restarts, press Ctrl+Alt+Delete to bring
up the Log On dialog box. Enter the password you created for the Administrator
account and click OK, and you’re logged on. Now the real fun begins.

Life after Setup

After the Setup program completes its duty, you still have several tasks to
complete before your server is ready to use. The following sections describe
these post-installation chores.

Logging on
After the Setup program restarts your computer for the last time, you must
log on to the server by using the Administrator account:

1. Press Ctrl+Alt+Delete to open the Log On to Windows dialog box.

2. Type the password you created for the Administrator account during
setup.

3. Click OK to log on.

Windows grinds and whirs for a moment while it starts up and then dis-
plays the familiar Windows desktop.

Activating Windows

The Microsoft Product Activation feature is designed to prevent you from
installing an illegal copy of Windows or other Microsoft software products.
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|
Figure 7-3:
Activating
Windows.
|

After you install a product, you have 30 days to activate it. If you don’t acti-
vate the product within 30 days, it stops working. To prevent that from hap-
pening, activate the software immediately after installing it.

Fortunately, activating a Windows server operating system is easy to do if
you have a working Internet connection. Windows displays a pop-up reminder
in the notification area (in the right corner of the taskbar). Just click this
bubble to start the Activation Wizard, as shown in Figure 7-3.

’-‘ Activate Windows

Let's activate Windows

Ta help

When you activate a Microsoft software product, a unique code is assigned to
your system and sent to Microsoft, where the code is stored in a Product
Activation database. The code includes information about the configuration
of your computer, so Microsoft can tell whether someone tries to install the
same copy of the software on a different computer.

The activation code is based on ten hardware characteristics and allows for
you to make certain changes to your computer without having to reactivate.
The Product Activation feature has a certain amount of built-in tolerance to
hardware changes. As a result, you can add another hard drive or more
memory to your server without having to reactivate. But, if you change the
computer too much, Product Activation thinks you’ve stolen the software or
are trying to install it on a second computer. In that case, you’ll have to contact
Microsoft and convince them that you've just done a major overhaul of the
server computer and should be allowed to reactivate your software. Good
luck. For the details about how Product Activation determines when you need
to reactivate, see the nearby sidebar “How much change is too much?”
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How much change is too much?

Microsoft's Product Activation feature uses an
activation code that's based in part on your com-
puter’s hardware configuration. In particular, the
code includes information about the following
ten hardware components of your system:

v The display adapter

v The SCSI disk adapter

v~ The IDE disk adapter

v The network adapter’s MAC address

v The amount of RAM

v The processor type

v The processor’s serial number

v The hard drive device type

v The hard drive’s volume serial number
v The CD-ROM, CD-RW, or DVD-ROM drive

To determine whether your computer’s hard-
ware has changed, Product Activation uses
a voting system that compares the hardware
that was present when the product was first

installed with the current hardware. For each
component that's the same, one vote is tallied —
except for the network card’s MAC address,
which counts for three votes. If you get at least
seven votes, you don't have to reactivate the
product. However, if you get fewer than seven
votes, you have to reactivate.

Suppose that you upgrade the computer’s hard
drive and add 128MB of memory. Because the
network card is the same, it counts for three
votes. The SCSI disk adapter, IDE disk adapter,
processor type, serial number, and CD-ROM
drive score an additional five votes, for a total
of nine votes. Because you exceeded seven
votes, you don't have to reactivate.

However, suppose also that you then replace
the network interface card. Now you don't get
the three votes for the network card, so you
have only six votes and will need to reactivate
the product. (You may be able to thwart this
process by making sure that the new hard
drive uses the same volume serial number as
the old drive.)

You can activate your software in two ways:

v The easiest way is automatically over the Internet.

151

v If you don’t have a working Internet connection, you can do it over the
phone. However, you'll probably be put on hold for a while until a cus-
tomer service representative can answer. Then you have to read a 50-
digit number over the phone and write down the long confirmation
number that you're given to type into the Activation dialog box. Product
Activation over the Internet is a lot easier.
P If your company has a volume licensing agreement with Microsoft, you don’t
have to bother with Product Activation; it doesn’t apply to products pur-
chased under a volume licensing agreement.
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Downloading service packs

Service packs are maintenance updates to an operating system that contain
minor enhancements and bug fixes. Most of the fixes in a service pack address
security problems that have been discovered since the operating system was
first released. The usual way to get service packs is by downloading them
from the operating system vendor’s Web site.

Depending on the operating system version you installed, you may or may
not need to apply a service pack immediately after installing the operating
system. The Windows Server 2003 Setup program automatically checks for
updates before it installs the operating system, so you shouldn’t normally
have to install a service pack after running Setup. However, you may need to
do so with other operating systems.

Unfortunately, applying service packs is something you have to do through-
out the life of the server. Microsoft and other operating system vendors peri-
odically release new service packs to correct problems as they arise.

Testing the installation

After Setup finishes, check to make sure that your server is up and running.
Here are some simple checks you can perform to make sure that your server
has been properly installed:

v Check the Event Viewer to see whether it contains any error messages
related to installation or startup. Depending on the Windows server
version you're using, you can open the Event Viewer by choosing Start~
Administrative Tools=>Event Viewer or Start=>Program Files=>
Administrative Tools=>Event Viewer. (Non-Windows server operating
systems have similar features that allow you to view event logs.)

v Check your TCP/IP settings by running the command ipconfig /all
from a command prompt. This command tells you whether TCP/IP is
running and shows you the host name, IP address, and other useful
TCP/IP information.

v To make sure that you can reach the server over the network, open a
command prompt at a client computer and attempt to ping the server
by entering the command ping hostname where hostname is the
name displayed by the ipconfig command for the server.

Configuring Server Roles

After you install your server operating system and verify that the installation
was successful, your next step is to configure the various services you want
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the server to provide. You'll find information about configuring services for
specific network operating systems in later chapters throughout this book.
For now, [ want to show you the Configure Your Server Wizard, which is built
into Windows Server 2003. This wizard starts automatically the first time you
log on to Windows Server 2003. You can get back into this wizard at any time
by choosing Start=>All Programs=>Administrative Tools=>Configure Your Server.

After displaying some preliminary configuration information, the wizard lets
you set up a default Typical configuration for a first server or a custom con-
figuration that lets you choose which services you want to enable. [ suggest
that you choose Custom configuration even if this is the first server on your
network. That way, you can see which services are being set up and how they
will be configured.

Figure 7-4 shows the Server Role page of the Configure Your Server Wizard. This
page lets you configure the various roles your server will play. You can use the
wizard to configure one of these roles at a time by choosing one of the roles
from the list and clicking Next. This action takes you through one or more pages
that ask for configuration information for the server role you selected. You even-
tually come back to this page, where you can configure other server roles.

]
Server Role (/)
Yfou can set up this server to perform one or mare specfic roles, IF you want to add more than one
role bo this server, yvou can run this wizard again,
Select a role, If the role has not been added, youcan add &, IF it has abeady been added, you can
remove it, If the role you want to add or remove is not ksted, open Add or Remove Programs.
Server Role Configured | File server
Prink server Yes
Application server (115, ASP.MET) Mo This server is configured as a Fils
Mad server (POP3, SMTF) Mo server,
Terminal server Mo To manage this server, open Manade
Remote access [ PN server Mo Your Server.
|
Domain Controller (Active Directory) Yes I "
- DNS server Yes To remove this role, dick Next,
Flgure 1-4: DHCP server Mo
Streaming media server Mo
YOU canuse WINS server Mo
this page to
configure
the roles Wew the Cosfigure our Server log,
your server
will play.
play. < Back | Next > ] Cancel Help
|

The following list describes the server roles you can configure:

v~ File Server: This role allows you to create shared folders that can be
accessed by network users. You can set up disk quotas to limit the amount
of storage available to each user, and you can set up an indexing service
that helps users quickly find their files.

v Print Server: This role allows you to share printers connected to the
server with network users.
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v~ Application Server: This is a fancy name for Internet Information
Services, Microsoft’s Web server. If you want the server to host Web
sites, you need to configure the application server role.

v Mail Server: This role provides basic e-mail features based on the stan-
dard Internet mail protocols (POP3 and SMTP).

v Terminal Server: This role lets other users run applications on the
server computer as though they’re working at the server.

+ Remote Access/VPN Server: This role enables dialup connections and
virtual private network connections, which work like dialup connections
but operate over the Internet rather than over a private phone line.

v Domain Controller: This role enables Active Directory and designates
the server as a domain controller so that it can manage user accounts,
logon activity, and access privileges.

v DNS Server: This role configures the computer as a DNS server for the
network so that it can resolve Internet names. For smaller networks,
you’ll probably use your ISP’s DNS server. You probably need your own
DNS server only for large networks.

v DHCP Server: A DHCP server assigns IP addresses to computers auto-
matically so that you don’t have to manually configure an IP address for
each computer. On many networks, the router that provides the net-
work’s connection to the Internet doubles as a DHCP server. Unless your
network is really large, you probably don’t need two DHCP servers.

v~ Streaming Media Server: If you plan on using digital media (such as
audio or video) over your network, you should set up the Streaming
Media Server role. One common use of streaming media is for online
conferencing using programs, such as Microsoft NetMeeting.

v WINS Server: This role allows the server to translate NetBIOS names to
IP addresses. All Windows networks should have at least one WINS
server. However, you need two or more only for very large networks.
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Configuring Windows XP
and Vista Clients

In This Chapter

Configuring network connections for Windows clients
Setting the computer name, description, and workgroup
Joining a domain

Setting logon options

Before your network setup is complete, you must configure the network’s
client computers. In particular, you have to configure each client’s net-
work interface card so that it works properly, and you have to install the right
protocols so that the clients can communicate with other computers on the
network.

Fortunately, the task of configuring client computers for the network is
child’s play in Windows. For starters, Windows automatically recognizes
your network interface card when you start up your computer. All that
remains is to make sure that Windows properly installed the network
protocols and client software.

With each version of Windows, Microsoft has simplified the process of config-
uring client network support. In this chapter, I describe the steps for config-
uring networking for Windows XP and Vista.

Configuring Network Connections

Windows automatically detects the presence of a network adapter; normally,
you don’t have to install device drivers manually for the adapter. When
Windows detects a network adapter, it automatically creates a network con-
nection and configures it to support basic networking protocols. However, you
may need to change the configuration of a network connection manually. The
procedures for Windows XP and Vista are described in the following sections.
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Configuring Windows XP
network connections

The following steps show how to configure your network connection on a
Windows XP system:
1. Choose Start~>Control Panel to open the Control Panel.
The Control Panel appears.
2. Double-click the Network Connections icon.
The Network Connections folder appears, as shown in Figure 8-1.

3. Right-click the connection that you want to configure and then choose
Properties from the menu that appears.

A\
You can also select the network connection and click Change Settings of
This Connection in the task pane.
Either way, the Properties dialog box for the network connection
appears, as shown in Figure 8-2.
4. To configure the network adapter card settings, click Configure.
This action summons the Properties dialog box for the network adapter,
as shown in Figure 8-3. This dialog box has five tabs that let you config-
ure the NIC:
¢ General: This tab shows basic information about the NIC, such
as the device type and status. For example, the device shown
in Figure 8-3 is a D-Link DFE-530TX+ PCI Adapter. (It’s installed
in slot 3 of the computer’s PCI bus.)
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<® If you're having trouble with the adapter, you can click the
Troubleshoot button to open the Windows XP Hardware
Troubleshooter. You can also disable the device if it’s preventing
other components of the computer from working properly.

e Advanced: This tab lets you set a variety of device-specific param-
eters that affect the operation of the NIC. For example, some cards
allow you to set the speed parameter (typically at 10 Mbps or 100

BE Mbps) or the number of buffers the card should use.
“&N\ R
& Consult the manual that came with the card before you play
around with any of those settings.

¢ Driver: This tab displays information about the device driver
that’s bound to the NIC and lets you update the driver to a newer
version, roll back the driver to a previously working version, or
uninstall the driver.

® Resources: With this tab, you can use manual settings to limit the
system resources used by the card — including the memory range,
I[/O range, IRQ, and DMA channels.

In the old days, before Plug and Play cards, you had to configure
these settings whenever you installed a card, and it was easy to
create resource conflicts. Windows configures these settings auto-
matically so that you should rarely need to fiddle with them.

e Power Management: This tab lets you set power-management
options. You can specify that the network card be shut down
whenever the computer goes into sleep mode — and that the
computer wake up periodically to refresh its network state.
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When you click OK to dismiss the network adapter’s Properties dialog box,
the network connection’s Properties dialog box closes. Select the Change
Settings for This Connection option again to continue the procedure.

5. Make sure that the network items your client requires are listed in the
network connection Properties dialog box.

The following list describes the items you commonly see listed here.
Note that not all networks need all these items:

e Client for Microsoft Networks: This item is required if you want to
access a Microsoft Windows network. It should always be present.

e File and Printer Sharing for Microsoft Networks: This item allows
your computer to share its files or printers with other computers
on the network.

This option is usually used with peer-to-peer networks, but you
can use it even if your network has dedicated servers. However, if
you don’t plan to share files or printers on the client computer, you
should disable this item.

e Internet Protocol (TCP/IP): This item enables the client computer to
communicate by using the TCP/IP protocol.

If all servers on the network support TCP/IP, this protocol should
be the only one installed on the client.

e NWLink IPX/SPX/NetBIOS Compatible Transport Protocol: This pro-
tocol is required only if your network needs to connect to an older
NetWare network that uses the IPX/SPX protocol.
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) In most modern networks, you should enable TCP/IP only and

leave this item disabled.

6. If a protocol that you need isn’t listed, click the Install button to add
the needed protocol.

A dialog box appears, asking whether you want to add a network client,
protocol, or service. Click Protocol and then click Add. A list of available
protocols appears. Select the one you want to add and then click OK.
(You may be asked to insert a disk or the Windows CD.)

7. Make sure that the network client that you want to use appears in the
list of network resources.

For a Windows-based network, make sure that Client for Microsoft
Networks is listed. For a NetWare network, make sure that Client Service
for NetWare appears. If your network uses both types of servers, you

can choose both clients.
\\J

If you have NetWare servers, use the NetWare client software that comes
with NetWare rather than the client supplied by Microsoft with Windows.

8. If the client that you need isn’t listed, click the Install button to add
the client that you need, click Client, and then click Add. Then choose
the client that you want to add and click OK.

The client you selected is added to the network connection’s Properties
dialog box.

9. To remove a network item that you don’t need (such as File and
Printer Sharing for Microsoft Networks), select the item and click the
Uninstall button.

For security reasons, make it a point to remove any clients, protocols, or
services that you don’t need.

10. To configure TCP/IP settings, click Internet Protocol (TCP/IP) and
then click Properties to display the TCP/IP Properties dialog box.
Adjust the settings and then click OK.

The TCP/IP Properties dialog box, as shown in Figure 8-4, lets you
choose from these options:

e Obtain an IP Address Automatically: Choose this option if your net-
work has a DHCP server that assigns IP addresses automatically.
Choosing this option drastically simplifies the administering of
TCP/IP on your network. (See Chapter 6 for more information
about DHCP.)

e Use the Following IP Address: If your computer must have a specific
IP address, choose this option and then type the computer’s IP
address, subnet mask, and default gateway address. (For more
information about these settings, see Chapter 6.)
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e Obtain DNS Server Address Automatically: The DHCP server can also
provide the address of the Domain Name System (DNS) server that
the computer should use. Choose this option if your network has a
DHCP server. (See Chapter 6 for more information about DNS.)

e Use the Following DNS Server Addresses: Choose this option if a
DNS server isn’t available. Then type the IP address of the primary
and secondary DNS servers.

Internet Protocol (TCP/IP) Properties 2[=]

General | Atemate Corfiguration |
You can get |P settings assigned automatically if your network supports

this capability. Otherwise, you need to ask your network administrstor for
the appropriate |P settings.

®Dbtain an [P address automaticalli

() Use the following [P address:

(2 Obtasin DNS server address automatically

(%) Use the following DNS server addresses:

Prefered DNS server: 192 168 . 1 . 10 |
I Atermate DNS server 85 255 112 61 |
Figure 8-4:
Configuring (poences.. |
TCP/IP.
/
I

Configuring Windows Vista
network connections

The procedure for configuring a network connection on Windows Vista is
similar to the procedure for Windows XP, except that Microsoft decided to
bury the configuration dialog boxes a little deeper in the bowels of Windows.

To find the settings you need, follow these steps:

1. Choose Start~>Control Panel to open the Control Panel.
The Control Panel appears.

2. Choose View Network Status and Tasks under the Network and
Internet heading.

This step opens the Network and Sharing Center, as shown in Figure 8-5.
3. Click Manage Network Connections.

The Network Connections folder appears, as shown in Figure 8-6.
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4. Right-click the connection that you want to configure and then choose
Properties from the menu that appears.

The Properties dialog box for the network connection appears, as shown
in Figure 8-7. If you compare this dialog box with the dialog box that was
shown earlier, in Figure 8-2, you see that they’re the same.

5. Click Configure to configure the network connection.

From this point, the steps for configuring the network connection are
the same as they are for Windows XP. As a result, you can continue
beginning with Step 4 in the previous section, “Configuring Windows XP
network connections.”

U Local Area Connection Properties &J

Networking :
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l Configure...

This connection uses the following tems:
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=] nk-Layer Topology Discovery Mapper 140 Driver
W -&. Link-Layer Topalogy Discovery Responder

{ Install... | | Uninstall | | Properties

Description

Allows your computer to access resources on @ Microsoft
network.

0K | [ Cancel

Configuring Client Computer
Identification

Every client computer must identify itself to participate in the network.
The computer identification consists of the computer’s name, an optional
description, and the name of either the workgroup or the domain to which
the computer belongs.

The computer name must follow the rules for NetBIOS names; it may be 1
to 15 characters long and may contain letters, numbers, or hyphens but no
spaces or periods. For small networks, it’'s common to make the computer
name the same as the username. For larger networks, you may want to
develop a naming scheme that identifies the computer’s location. For
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example, a name such as C-305-1 may be assigned to the first computer in
Room 305 of Building C. Or MKTG010 may be a computer in the Marketing
department.

If the computer will join a domain, you need to have access to an Administrator
account on the domain unless the administrator has already created a com-
puter account on the domain. Note that only Windows 2000, Windows XP,

and Windows Server (NT, 2000, and 2003) computers can join a domain.
(Windows 98 or 95 users can access the domain’s resources by logging on to
the domain as users, but domain computer accounts for Windows 9x clients
aren’t required.)

When you install Windows on the client system, the Setup program asks for
the computer name and workstation or domain information. You can change
this information later, if you want. The procedure varies depending on
whether you’re using Windows XP or Windows Vista.

Configuring Windows XP
computer identification
To change the computer identification in Windows XP, follow these steps:
1. Open the Control Panel and double-click the System icon to open the
System Properties dialog box.
2. Click the Computer Name tab.
The computer identification information is displayed.
3. Click the Change button.

This step displays the Computer Name Changes dialog box, as shown in
Figure 8-8.

4. Type the new computer name and then specify the workgroup or
domain information.

To join a domain, select the Domain radio button and type the domain
name into the appropriate text box. To join a workgroup, select the
Workgroup radio button and type the workgroup name in the corre-
sponding text box.

5. Click OK.

6. If you’re prompted, enter the username and password for an
Administrator account.

You’re asked to provide this information only if a computer account has
not already been created for the client computer.
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7. When a dialog box appears, informing you that you need to restart
the computer, click OK. Then restart the computer.

You're done!

Configuring Windows Vista
computer identification

To change the computer identification in Windows Vista, follow these steps:

1. Choose the Start button, and then right-click Computer and choose
Properties.

This step displays the System information window, as shown in
Figure 8-9. Notice the section that lists computer name, domain,
and workgroup settings.

2. Click the Change Settings link.

If a dialog box appears and asks for your permission to continue, click
Continue. The System Properties dialog box then appears, as shown in
Figure 8-10.

3. Click the Change button.

This step displays the Computer Name/Domain Changes dialog box, as
shown in Figure 8-11.
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Computer Name/Domain Changes &J
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4. Enter the computer name and the workgroup or domain name.

If you want to join a domain, choose the Domain option button and type

the domain name. To join a workgroup, choose the Workgroup option
and type the workgroup name.

5. Click OK.

6. Enter the username and password for an Administrator account when

prompted.

You're asked to provide this information only if a computer account has

not already been created for the client computer.

7. When a dialog box appears, informing you that you need to restart
the computer, click OK. Then restart the computer.

The computer is then added to the domain or workgroup.

Configuring Network Logon

\\3

Every user who wants to access a domain-based network must log on to the
domain by using a valid user account. The user account is created on the
domain controller — not on the client computer.

Network logon isn’t required to access workgroup resources. Instead, work-
group resources can be password-protected to restrict access.
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When you start a Windows computer that has been configured to join a domain,
as described in the section “Configuring Client Computer Identification,” earlier
in this chapter, the Log On to Windows dialog box is displayed. The user can
use this dialog box to log on to a domain by entering a domain username and
password and then selecting the domain that she wants to log on to (from the
Log On To drop-down list).

You can create local user accounts in Windows that allow users to access
resources on the local computer. To log on to the local computer, the user
selects This Computer from the Log On To drop-down list and enters the
username and password for a local user account. When a user logs on by
using a local account, he isn’t connected to a network domain. To log on to a
domain, the user must select the domain from the Log On To drop-down list.

If the computer isn’t part of a domain, Windows can display a friendly logon
screen that displays an icon for each of the computer’s local users. The user
can log on simply by clicking the appropriate icon and entering a password.
(This feature isn’t available for computers that have joined a domain.)

Note that if the user logs on by using a local computer account rather than a
domain account, she can still access domain resources. A Connect To dialog
box appears whenever the user attempts to access a domain resource. Then
the user can enter a domain username and password to connect to the domain.
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Chapter 9
Wireless Networking

In This Chapter

Looking at wireless network standards

Reviewing some basic radio terms

Considering infrastructure and ad hoc networks

Working with a wireless access point

Configuring Windows for wireless networking

A\

Wth wireless networking, you don’t need cables to connect your
computers. Instead, wireless networks use radio waves to send

and receive network signals. As a result, a computer can connect to a
wireless network at any location in your home or office.

Wireless networks are especially useful for notebook computers. After all,
the main benefit of a notebook computer is that you can move it.

This chapter introduces the ins and outs of using a wireless network.

Diving into Wireless Networking

A wireless network is a network that uses radio signals rather than direct
cable connections to exchange information.

A computer with a wireless network connection is like a cellphone. Just as you
don’t have to be connected to a phone line to use a cellphone, you don’t have
to be connected to a network cable to use a wireless networked computer.

The following list summarizes some key concepts and terms that you need to
understand to set up and use a basic wireless network:



] 70 Partii:Building Your Own Network

CMBER

v A wireless network is often referred to as a WLAN, for wireless local-area
network.

Some people prefer to switch the acronym around to local-area wireless
network, or LAWN.

The term Wi-Fi is often used to describe wireless networks, although
it technically refers to just one form of wireless networks: the 802.11b
standard. See the section “Eight-Oh-Two-Dot-Eleventy Something? (Or,
Understanding Wireless Standards),” later in this chapter, for more
information.

v A wireless network has a name, known as an SSID. SSID stands for
service set identifier. (Wouldn’t that make a great Jeopardy! question?
I'll take obscure four-letter acronyms for $400, please!)

All the computers that belong to a single wireless network must have
the same SSID.

1 Wireless networks can transmit over any of several channels.

For computers to talk to each other, they must be configured to transmit
on the same channel.

v The simplest type of wireless network consists of two or more com-
puters with wireless network adapters.

This type of network is an ad hoc mode network.

v A more complex type of network is an infrastructure mode network. All
this really means is that a group of wireless computers can be connected
to not only each other but also an existing cabled network via a device
called a wireless access point, or WAP. (I tell you more about ad hoc and
infrastructure networks later in this chapter.)

A Little High School Electronics

I was a real nerd in high school: I took three years of electronics. The elec-
tronics class at my school was right next door to the auto shop. Of course,
all the cool kids took auto shop, and only nerds like me took electronics. We
hung in there, though, and found out all about capacitors and diodes while
the cool kids were learning how to raise their cars and install 2-gigawatt
stereo systems.

It turns out that a little of that high school electronics information proves
useful when it comes to wireless networking — not much, but a little. You'll
understand wireless networking much better if you know the meanings of
some basic radio terms.
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Waves and frequencies

For starters, radio consists of electromagnetic waves that are sent through
the atmosphere. You can’t see or hear them, but radio receivers can pick
them up and convert them into sounds, images, or — in the case of wireless
networks — data.

Radio waves are cyclical waves of electromagnetic energy that repeat at a
particular rate, or frequency. Figure 9-1 shows two frequencies of radio waves:
The first is one cycle per second; the second is two cycles per second. (Real
radio doesn’t operate at a frequency that low, but I figured one and two
cycles per second is easier to draw than 680,000 cycles per second or 2.4
million cycles per second.)

The measure of a frequency is cycles per second, which indicates how many
complete cycles the wave makes in one second. (Duh.) In honor of Heinrich
Hertz, who did not invent catsup but rather was the first person to success-
fully send and receive radio waves (it happened in the 1880s), cycles per
second is usually referred to as hertz, abbreviated Hz. Thus, 1 Hz is one cycle
per second. Incidentally, when the prefix K (for kilo, or 1,000), M (for mega,

1 million), or G (for giga, 1 billion) is added to the front of Hz, the H is still
capitalized. Thus, 2.4 MHz (not 2.4 Mhz) is correct.

The beauty of radio frequencies is that transmitters can be tuned to broad-
cast radio waves at a precise frequency. Likewise, receivers can be tuned

to receive radio waves at a precise frequency and ignore waves at other
frequencies. That’s why you can tune the radio in your car to listen to dozens
of different radio stations: Each station broadcasts at its own frequency.

Wavelength and antennas

A term related to frequency is wavelength. Radio waves travel at the speed of
light. The term wavelength refers to how far the radio signal travels with each
cycle. For example, because the speed of light is roughly 300 million meters
per second, the wavelength of a 1 Hz radio wave is about 300 million meters.
The wavelength of a 2 Hz signal is about 150 million meters.

As you can see, the wavelength decreases as the frequency increases. The
wavelength of a typical AM radio station broadcasting at 580 KHz is about
500 meters. For a TV station broadcasting at 100 MHz, it’s about 3 meters.
For a wireless network broadcasting at 2.4 GHz, the wavelength is about 12
centimeters.
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It turns out that the shorter the wavelength, the smaller the antenna needs
to be in order to adequately receive the signal. As a result, higher-frequency
transmissions need smaller antennas. You may have noticed that AM radio
stations usually have huge antennas mounted on top of tall towers, but cell-
phone transmitters are much smaller and their towers aren’t nearly as tall.
That’s because cellphones operate on a higher frequency than AM radio sta-
tions do. So who decides what type of radio gets to use specific frequencies?
That’s where spectrums and the FCC come in.
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Spectrums and the FCC

The term spectrum refers to a continuous range of frequencies on which radio
can operate. In the United States, the Federal Communications Commission
(FCC) regulates not only how much of Janet Jackson can be shown at the
Super Bowl but also how various portions of the radio spectrum can be used.
Essentially, the FCC has divided the radio spectrum into dozens of small
ranges called bands and restricted certain uses to certain bands. For exam-
ple, AM radio operates in the band from 535 KHz to 1,700 KHz.

Table 9-1 lists some of the most popular bands. Note that some of these bands
are wide — for example, UHF television begins at 470 MHz and ends at 806
MHz, but other bands are restricted to a specific frequency. The difference
between the lowest and highest frequency within a band is the bandwidth.

Table 9-1 Popular Bands of the Radio Spectrum
Band What It's Used For
535 KHz-1,700 KHz AM radio

5.9 MHz-26.1 MHz

Short wave radio

26.96 MHz-27.41 MHz

Citizens Band (CB) radio

54 MHz—-88 MHz

Television (VHF channels 2 through 6)

88 MHz—-108 MHz

FM radio

174 MHz-220 MHz

Television (VHF channels 7 through 13)

470 MHz-806 MHz

Television (UHF channels)

806 MHz-890 MHz

Cellular networks

900 MHz

Cordless phones

1850 MHz-1990 MHz

PCS Cellular

2.4 GHz-2.4835 GHz

Cordless phones and wireless networks (802.11b

and 802.11g)
4 GHz-5 GHz Large-dish satellite TV
5 GHz Wireless networks (802.11a)

11.7 GHz-12.7 GHz

Small-disk satellite TV
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And now, a word from the irony department

| was an English literature major in college, so |
like to use literary devices, such as irony. Of
course, irony doesn't come up much in com-
puter books. So, when it does, | like to jump on it
like a hog out of the water.

Here's my juicy bit of irony for today: The first
Ethernet system was a wireless network.
Ethernet traces its roots back to a network
developed at the University of Hawaii in 1970:
the Alohanet. This network transmitted its data
by using small radios. If two computers tried to
broadcast data at the same time, the computers

detected the collision and tried again after a
short, random delay. This technique was the
inspiration for the basic technique of Ethernet,
now called carrier sense multiple access with
collision detection (CSMA/CD). The wireless
Alohanet network inspired Robert Metcalfe to
develop his cabled network, Ethernet, as his
doctoral thesis at Harvard in 1973.

For the next 20 years or so, Ethernet was pretty
much a cable-only network. It wasn’t until the
mid-1990s that Ethernet finally returned to its
wireless roots.

Two of the bands in the spectrum are allocated for use by wireless networks:
2.4 GHz and 5 GHz. Note that these bands aren’t devoted exclusively to wire-
less networks. In particular, the 2.4 GHz band shares its space with cordless
phones. As a result, cordless phones can sometimes interfere with wireless
networks.

Eight-Oh-Two-Dot-Eleventy Something?
(Or, Understanding Wireless Standards )

The most popular standards for wireless networks are the IEEE 802.11
standards. These essential wireless Ethernet standards use many of the same
networking techniques that the cabled Ethernet standards (in other words,
802.3) use. Most notably, 802.11 networks use the same CSMA/CD technique
as cabled Ethernet to recover from network collisions.

The 802.11 standards address the bottom two layers of the IEEE seven-layer
model: the Physical layer and the Media Access Control (MAC) layer. Note
that TCP/IP protocols apply to higher layers of the model. As a result, TCP/IP
runs just fine on 802.11 networks.

The original 802.11 standard was adopted in 1997. Two additions to the
standard, 802.11a and 802.11b, were adopted in 1999. The latest and greatest
version is 802.11g.

Table 9-2 summarizes the basic characteristics of the three variants of 802.11.
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Table 9-2 802.11 Variations

Standard Speeds Frequency Typical Range (Indoors)
802.11a Up to 54 Mbps 5 GHz 150 feet

802.11b Up to 11 Mbps 2.4 GHz 300 feet

802.11¢g Up to 54 Mbps 2.4 GHz 300 feet

Most wireless networks are now based on the 802.11b standard. Although
802.11a is faster than 802.11b, it’s considerably more expensive and has less
range. In addition, 802.11a and 802.11b aren’t compatible with each other
because 802.11a transmits at 5 GHz and 802.11b transmits at 2.4 GHz. As a
result, 802.11a and 802.11b devices can’t receive each other’s signals.

The new standard, 802.11g, solves this problem by enabling high-speed con-
nections at 2.4 GHz. As a result, 802.11g devices are compatible with existing
802.11b networks.

802.11b networks operate on the same radio frequency as many cordless
phones: 2.4 GHz. If you set up an 802.11b network in your home and you also
have a 2.4 GHz cordless phone, the network and phone may occasionally
interfere with each other. The only way to completely avoid the interference
is to switch to a 900 MHz phone or use more-expensive 802.11a network com-
ponents, which transmit at 5 GHz rather than at 2.4 GHz.

Home on the Range

The maximum range of an 802.11b wireless device indoors is about 300 feet.
This range can have an interesting effect when you get a bunch of wireless
computers together — such that some of them are in range of each other but
others are not. Suppose that Wally, Ward, and the Beaver all have wireless
notebooks. Wally’s computer is 200 feet away from Ward’s computer, and
Ward’s computer is 200 feet away from Beaver’s in the opposite direction (see
Figure 9-2). In this case, Ward can access both Wally’s computer and Beaver’s
computer, but Wally can access only Ward’s computer, and Beaver can access
only Ward’s computer. In other words, Wally and Beaver can’t access each
other’s computers because they're outside the 300-feet range limit. (This is
starting to sound suspiciously like an algebra problem. Now suppose that
Wally starts walking toward Ward at 2 miles per hour and Beaver starts run-
ning toward Ward at 4 miles per hour. . . .)
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Although the normal range for 802.11b is 300 feet, the useful range may be
less in actual practice:

1 Obstacles, such as solid walls, bad weather, cordless phones, microwave
ovens, and backyard nuclear reactors can all conspire to reduce the
effective range of a wireless adapter. If you're having trouble connecting
to the network, sometimes just adjusting the antenna helps.

v Wireless networks tend to slow down when the distance increases. The
802.11b network devices claim to operate at 11 Mbps, but they usually
achieve that speed only at ranges of 100 feet or less. At 300 feet, they
often slow down to 1 Mbps.

v At the edge of the wireless device’s range, you're more likely to suddenly
lose your connection because of bad weather.

Wireless Network Adapters

Each computer that will connect to your wireless network needs a wireless
network adapter. The wireless network adapter is similar to the network inter-
face card (NIC) that’s used for a standard Ethernet connection. However,
rather than have a cable connector on the back, a wireless network adapter
has an antenna.
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You can get several basic types of wireless network adapters, depending on
your needs and the type of computer you will use it with:

v A wireless PCI card is a wireless network adapter that you install into an
available slot inside a desktop computer.

To install this type of card, you need to take your computer apart, so use
this type of card only if you have the expertise and the nerves to dig into
your computer’s guts.

v A wireless USB adapter is a separate box that plugs into a USB port
on your computer. Because the USB adapter is a separate device, it
takes up extra desk space. However, you can install it without taking
apart your computer.

v A wireless PC card is designed to slide into the PC card slot found in
most notebook computers.

This card is the type to get if you want to network your notebook.

You can purchase a combination 802.11b/g PCI adapter for under $50. USB
versions cost about $10 more.

At first, you may think that wireless network adapters are prohibitively
expensive. After all, you can buy a regular Ethernet adapter for as little as
$20. However, when you consider that you don’t have to purchase and install
cable to use a wireless adapter, the price of wireless networking becomes
more palatable. And, if you shop around, you can sometimes find wireless
adapters for as little as $19.95.

Wireless Access Points

Unlike cabled networks, wireless networks don’t need a hub or switch. If all
you want to do is network a group of wireless computers, you just purchase a
wireless adapter for each computer, put them all within 300 feet of each
other, and voila! — instant network.

What if you already have an existing cabled network? For example, you may
work at an office with 15 computers all cabled up nicely, and you just want
to add a couple of wireless notebook computers to the network. Or, suppose
that you have two computers in your den connected to each other with net-
work cable but you want to link up a computer in your bedroom without
pulling cable through the attic.
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That’s where a wireless access point, or WAP, comes in. A WAP performs two
functions:

1 The WAP acts as a central connection point for all your computers that
have wireless network adapters.

In effect, the WAP performs essentially the same function as a hub or
switch performs for a wired network.

v The WAP links your wireless network to your existing wired network
so that your wired computer and your wireless computers get along
like one big, happy family. (Sounds like the makings of a Dr. Seuss
story. “Now the wireless sneeches had hubs without wires. But the
twisted-pair sneeches had cables to thires. . ..”)

Wireless access points are sometimes just called access points, or APs. An
access point is a box that has an antenna (or, often, a pair of antennae) and an
RJ-45 Ethernet port. You just plug the access point into a network cable and
then plug the other end of the cable into a hub or switch, and your wireless
network should be able to connect to your cabled network.

Figure 9-3 shows how an access point acts as a central connection point
for wireless computers and how it bridges your wireless network to your
wired network.
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Infrastructure mode

When you set up a wireless network with an access point, you're creating an
infrastructure mode network. It’s called infrastructure mode because the access
point provides a permanent infrastructure for the network. The access points
are installed at fixed physical locations, so the network has relatively stable
boundaries. Whenever a mobile computer wanders into the range of one of
the access points, it has come into the sphere of the network and can connect.

An access point and all the wireless computers that are connected to it are
referred to as a Basic Service Set, or BSS. Each BSS is identified by a Service
Set Identifier, or SSID. When you configure an access point, you specify the
SSID that you want to use. The SSID is often a generic name such as wireless,
or it can be a name that you create. Some access points use the MAC address
of the WAP as the SSID.

Multifunction WAPs

<® Wireless access points often include other built-in features. For example,
some access points double as Ethernet hubs or switches. In that case, the
access point will have more than one RJ-45 port. In addition, some access
points include broadband cable or DSL firewall routers that enable you to
connect to the Internet:

v An 802.11b wireless access point that lets me connect a notebook com-
puter and a computer located on the other side of the house because |
didn’t want to run cable through the attic.

v A 4-port 10/100 MHz switch to which I can connect up to four computers
by using twisted-pair cable.

v A DSL/cable router that [ connect to my cable modem. This enables all the
computers on the network (cabled and wireless) to access the Internet.
\\J
A multifunction access point that’s designed to serve as an Internet gateway
for home networks sometimes is a residential gateway.

Roaming

You can use two or more wireless access points to create a large wireless
network in which computer users can roam from area to area and still be
connected to the wireless network. As the user moves out of the range of
one access point, another access point automatically picks up the user
and takes over without interrupting the user’s network service.
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To set up two or more access points for roaming, you must carefully place
the WAPs so that all areas of the office or building that are being networked
are in range of at least one of the WAPs. Then just make sure that all the
computers and the access points use the same SSID and channel.

Two or more access points joined for the purposes of roaming, along with

all the wireless computers connected to any of the access points, form an
Extended Service Set, or ESS. The access points in the ESS are usually con-
nected to a wired network.

One current limitation of roaming is that each access point in an ESS must
be on the same TCP/IP subnet. That way, a computer that roams from one
access point to another within the ESS retains the same IP address. If the
access points had a different subnet, a roaming computer would have to
change IP addresses when it moved from one access point to another.

Wireless bridging

Another use for wireless access points is to bridge separate subnets that can’t
easily be connected by cable. For example, two office buildings may be only
about 50 feet apart. To run cable from one building to the other, you’d have to
bury conduit — a potentially expensive job. Because the buildings are so close,
though, you can probably connect them with a pair of wireless access points
that function as a wireless bridge between the two networks. Connect one of the
access points to the first network and the other access point to the second net-
work. Then configure both access points to use the same SSID and channel.

Ad hoc networks

A wireless access point isn’t necessary to set up a wireless network. Anytime
two or more wireless devices come within range of each other, they can link
up to form an ad hoc network. For example, if you and a few of your friends all
have notebook computers with 802.11b/g wireless network adapters, you can
meet anywhere and form an ad hoc network.

All the computers within range of each other in an ad hoc network are called
an Independent Basic Service Set, or IBSS.

Configuring a Wireless Access Point

The physical setup for a wireless access point is pretty simple: You take it out
of the box, put it on a shelf or on top of a bookcase near a network jack and a
power outlet, plug in the power cable, and plug in the network cable.
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The software configuration for an access point is a little more involved but
still not complicated. It’s usually done by using a Web interface. To get to the
configuration page for the access point, you need to know the access point’s
IP address. Then you just type that address into the address bar of a browser
from any computer on the network.

Multifunction access points usually provide DHCP and NAT services for the
networks and double as the network’s gateway router. As a result, they typi-
cally have a private IP address that’s at the beginning of one of the Internet’s
private IP address ranges, suchas 192.168.0.10r 10.0.0.1. Consult the
documentation that came with the access point to find out more.

If you use a multifunction access point that is both your wireless access point
and your Internet router and you can’t remember the IP address, run the
IPCONFIG command at a command prompt from any computer on the network.
The default gateway IP address should be the IP address of the access point.

Basic configuration options

Figure 9-4 shows the main configuration screen for a typical wireless access
point router. [ called up this configuration page by entering 192.168.1.1
in the address bar of a Web browser and then supplying the logon password
when [ was prompted.
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Thes screen contans all of the router's basic setup funcbions. Most
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any changes. If you require help during configuration, please sea the
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SSID Broadcast: (2 Cnable O Disable

Channel: |10 |*| [Domain: USA
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This configuration page offers the following configuration options that are
related to the wireless access point functions of the device. Although these
options are specific to this particular device, most access points have similar
configuration options:

v Enable/Disable: Enables or disables the device’s wireless access

point functions.

v SSID: The Service Set Identifier used to identify the network. Most

access points have well-known defaults.

You can talk yourself into thinking that your network is more secure

by changing the SSID from the default to something more obscure, but
in reality that protects you only from first-grade hackers. By the time
most hackers get into the second grade, they know that even the most
obscure SSID is easy to get around. | recommend that you leave the SSID
at the default and apply better security measures, as described in
Chapter 10.

v Allow SSID Broadcast to Associate? Disables the access point’s periodic

broadcast of the SSID. Normally, the access point regularly broadcasts
its SSID so that wireless devices that come within range can detect the
network and join in.

For a more secure network, you can disable this function. Then a
wireless client must already know the network’s SSID to join the
network.

v Channel: Lets you select one of 11 channels on which to broadcast. All

the access points and computers in the wireless network should use the
same channel.

If you find that your network frequently loses connections, try
switching to another channel. You may be experiencing interference
from a cordless phone or other wireless device operating on the
same channel.

Switching channels is also a friendly way for neighbors with wireless net-
works to stay out of each other’s way. For example, if you share a build-
ing with another tenant who also has a wireless network, you can agree
to use separate channels so that your wireless networks don’t interfere
with each other. Keep in mind that this agreement doesn’t give you any
real measure of security because your neighbor could secretly switch
back to your channel and listen in on your network. You still need to
secure your network as described in Chapter 10.

v WEP — Mandatory or Disable: Lets you use a security protocol called

wired equivalent privacy.
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DHCP configuration

P You can configure most multifunction access points to operate as a DHCP
server. For small networks, it’'s common for the access point to also be the
DHCP server for the entire network. In that case, you need to configure the
access point’s DHCP server. Figure 9-5 shows the DHCP configuration page for
the Linksys WAP router. To enable DHCP, select the Enable option and then
specify the other configuration options to use for the DHCP server.

Larger networks that have more-demanding DHCP requirements are likely
to have a separate DHCP server running on another computer. In that case,
you can defer to the existing server by disabling the DHCP server in the
access point.

£ hip/I192.165.1.1DHCP. htm - Windows Internet Explarer ==
(€] w | 2] hatpsf 192, 168 1 JOHCR hitm bl |l e i
WG| ip a2 168 1 UDHGR hm - e

You can conlgure the router te act 43 a DHCP [Dynamic Host
Configuration Protocol) server for your network. Consult the user guide
for instructions on how to setup your PCs to work with this feature.
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Configuring Windows for
Wireless Networking

The first step in configuring Windows XP for wireless networking is to install
the appropriate device driver for your wireless network adapter. To do that,
you need the installation CD that came with the adapter. Follow the instruc-
tions that came with the adapter to install the drivers.
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Windows XP has some nice built-in features for working with wireless
networks. Follow these steps to access the features:

1. Open the Network Connections folder.

\\3
Choose Start=>Control Panel and then double-click the Network
Connections icon.
2. Right-click the wireless network connection and then choose
Properties to open the Properties dialog box.
3. Click the Wireless Networks tab.
The wireless networking options are displayed, as shown in Figure 9-6.
<L Wireless Network Connection Properties B %]
General “wireless Metworks | ddvanced
[Flise indows to configure my wireless network settings
Bvailable networks:
To connect to an available network, click Conligure.
G linksys LConligure
Refresh
Preferred networks:
Autamatically connect to available networks in the arder isted
I helow!
. Q linksys
Figure 9-6:
Configuring
Wireless l Add... I l Remaove ] I Properties ]
.netvyorklng e |
in Windows I
XP.
|

Each time you connect to a wireless network, Windows XP adds that network
to this dialog box. Then you can juggle the order of the networks in the
Preferred Networks section to indicate which network you prefer to join if
you find yourself within range of two or more networks at the same time. You
can use the Move Up and Move Down buttons next to the Preferred Networks
list to change your preferences.

To add a network that you haven’t yet joined, click the Add button. This
action opens the dialog box shown in Figure 9-7. Here, you can type the SSID
value for the network that you want to add. You can also specify other infor-
mation, such as whether to use data encryption, how to authenticate yourself,
and whether the network is an ad hoc rather than an infrastructure network.

When your computer comes within range of a wireless network, a pop-up bal-
loon appears on the taskbar, indicating that a network is available. If one of
your preferred networks is within range, clicking the balloon automatically
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connects you to that network. If Windows XP doesn’t recognize any of the
networks, clicking the balloon displays the Wireless Network Connection
dialog box. With this dialog box, you can choose the network that you want
to join (if more than one network is listed) and then click Connect to join the
selected network.

After you join a wireless network, a network status icon appears in the notifi-
cation area of the taskbar. You can quickly see the network status by hover-
ing the mouse cursor over this icon; a balloon appears to indicate the state
of the connection. For more detailed information, you can click the status
icon to display the Wireless Network Connection Status dialog box, as shown

in Figure 9-8.
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This dialog box provides the following items of information:

v~ Status: Indicates whether you're connected.
v Duration: Indicates how long you've been connected.
v~ Speed: Indicates the current network speed.

Ideally, this option should say 11 Mbps for an 802.11b network, or 54
Mbps for an 802.11a or 802.11g network. However, if the network connec-
tion is not of the highest quality, the speed may drop to a lower value.

v~ Signal Strength: Displays a graphical representation of the quality of
the signal.

+” Packets Sent & Received: Indicates how many packets of data you sent
and received over the network.

You can click the Properties button to open the Connection Properties dialog
box for the wireless connection.
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The 5th Wave By Rich Tennant

O RIGSTENNANT

“Frankly, the idea of an entirely wireless future
scares me to death.”



In this part . . .

A fter you build your network, the chapters in this part
show you how to connect it to the outside world.
You'll learn how to connect your network to the Internet,
set up and manage an e-mail server, set up a corporate
intranet, use your network as a telephone system, and
connect to your network from home. Whew! You'll be
more connected than a Hollywood talent agent.




Chapter 10

Connecting Your Network
to the Internet

In This Chapter
Looking at DSL and cable
Examining T1 and T3 connections
Using a router
Securing your connection with a firewall

Using the firewall that comes with Windows

5) you decided to connect your network to the Internet. All you have to
do is run to the local computer discount store, buy a cable modem, and
plug it in, right? Wrong. Unfortunately, connecting to the Internet involves
more than just installing a modem. For starters, you have to make sure that
a modem is the right way to connect — other methods are faster but more
expensive. Then you have to select and configure the software you use to
access the Internet. Finally, you have to lie awake at night worrying whether
hackers are breaking into your network via its Internet connection.

Connecting to the Internet

Connecting to the Internet isn’t free. For starters, you have to purchase the
computer equipment necessary to make the connection. Then you have to
obtain a connection from an Internet Service Provider, or ISP. The ISP charges
you a monthly fee that depends on the speed and capacity of the connection.

The following sections describe the most commonly used methods of
connecting network users to the Internet.
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Connecting with cable or DSL

For small and home offices, the two most popular methods of connecting to
the Internet are cable and DSL. Cable and DSL connections are often called
broadband connections, for technical reasons you don’t really want to know.

Cable Internet access works over the same cable that brings 40 billion TV
channels into your home, whereas DSL is a digital phone service that works
over a standard phone line. Both offer three major advantages over normal
dialup connections:

1 Cable and DSL are much faster than dialup connections.

A cable connection can be anywhere from 10 to 200 times faster than
a dialup connection, depending on the service you get. And the speed
of a DSL line is comparable to cable. (Although DSL is a dedicated con-
nection, cable connections are shared among several subscribers. The
speed of a cable connection may slow down when several subscribers
use the connection simultaneously.)

1 With cable and DSL, you’re always connected to the Internet.

You don’t have to connect and disconnect each time you want to go
online. No more waiting for the modem to dial your service provider
and listening to the annoying modem shriek as it attempts to establish
a connection.

1 Cable and DSL don’t tie up a phone line while you’re online.

With cable, your Internet connection works over TV cables rather than
over phone cables. With DSL, the phone company installs a separate
phone line for the DSL service, so your regular phone line isn’t affected.

Unfortunately, there’s no such thing as a free lunch, and the high-speed,
always-on connections offered by cable and DSL don’t come without a price.
For starters, you can expect to pay a higher monthly access fee for cable or
DSL. In most areas of the United States, cable runs about $50 per month for
residential users; business users can expect to pay more, especially if more
than one user will be connected to the Internet via the cable.

The cost for DSL service depends on the access speed you choose. In some
areas, residential users can get a relatively slow DSL connection for as little
as $30 per month. For higher access speeds or for business users, DSL can
cost substantially more.

Cable and DSL access aren’t available everywhere. If you live in an area where
cable or DSL isn’t available, you can still get high-speed Internet access by
using a satellite hookup. With satellite access, you still need a modem and a
phone line to send data from your computer to the Internet. The satellite is
used only to receive data from the Internet. Still, a satellite setup like this is
much faster than a modem-only connection.
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Connecting with high-speed
private lines: T1 and T3

If your network is large and high-speed Internet access is a high priority,
contact your local phone company (or companies) about installing a dedi-
cated high-speed digital line. These lines can cost you plenty (on the order
of hundreds of dollars per month), so they’re best suited for large networks
in which 20 or more users are accessing the Internet simultaneously.

A T1 line has a connection speed of up to 1.544 Mbps. A T3 line is faster yet:
It transmits data at an amazing 44.184 Mbps. Of course, T3 lines are also
considerably more expensive than T1 lines.

If you don’t have enough users to justify the expense of an entire T1 or T3
line, you can lease just a portion of the line. With a fractional T1 line, you can
get connections with speeds of 128 Kbps to 768 Kbps, and with a fractional T3
line, you can choose speeds ranging from 4.6 Mbps to 32 Mbps.

Setting up a T1 or T3 connection to the Internet is stuff best left to profes-
sionals. Getting this type of connection to work is far more complicated than
setting up a basic LAN.

You may be wondering whether T1 or T3 lines are really any faster than cable
or DSL connections. After all, T1 runs at 1.544 Mbps and T3 runs at 44.184
Mbps, and cable and DSL claim to run at comparable speeds. But there are
many differences that justify the substantial extra cost of a T1 or T3 line.

In particular, a T1 or T3 line is a dedicated line — not shared by any other
users. T1 and T3 are higher-quality connections, so you actually get the 1.544
or 44.184 connection speeds. In contrast, both cable and DSL connections
usually run at substantially less than their advertised maximum speeds
because of poor-quality connections.

Sharing an Internet connection

After you choose a method to connect to the Internet, you can turn your
attention to setting up the connection so that more than one user on your net-
work can share it. The best way to do that is by using a separate device called
a router. An inexpensive router for a small network can be had for under $100.
Routers suitable for larger networks will, naturally, cost a bit more.

Because all communications between your network and the Internet must
go through the router, the router is a natural place to provide the security
measures necessary to keep your network safe from the many perils of the
Internet. As a result, a router used for Internet connections often doubles as
a firewall, as described in the section “Using a firewall,” later in this chapter.

191
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Securing Your Connection with a Firewall
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If your network is connected to the Internet, a whole host of security issues
bubble to the surface. You probably connected your network to the Internet
so that your network’s users could get out to the Internet. Unfortunately,
however, your Internet connection is a two-way street. It not only enables
your network’s users to step outside the bounds of your network to access
the Internet, but it also enables others to step in and access your network.

And step in they will. The world is filled with hackers who are looking for net-
works like yours to break into. They may do it just for the fun of it, or they
may do it to steal your customers’ credit card numbers or to coerce your
mail server into sending thousands of spam messages on behalf of the bad
guys. Whatever their motive, rest assured that your network will be broken
into if you leave it unprotected.

Using a firewall

A firewall is a security-conscious router that sits between the Internet and
your network with a single-minded task: preventing them from getting to us.
The firewall acts as a security guard between the Internet and your LAN. All
network traffic into and out of the LAN must pass through the firewall, which
prevents unauthorized access to the network.

Some type of firewall is a must-have if your network has a connection to the
Internet, whether that connection is broadband (cable modem or DSL), T1, or
some other high-speed connection. Without it, sooner or later a hacker will
discover your unprotected network and tell his friends about it, and within

a few hours your network will be toast.

You can set up a firewall in two basic ways:
v~ Firewall appliance: The easiest way. It’s basically a self-contained router

with built-in firewall features.

Most firewall appliances include Web-based interfaces that enable you to
connect to the firewall from any computer on your network by using a
browser. You can then customize the firewall settings to suit your needs.

v Server computer: Can be set up to function as a firewall computer.
The server can run just about any network operating system, but most
dedicated firewall systems run Linux.

Whether you use a firewall appliance or a firewall computer, the firewall must
be located between your network and the Internet, as shown in Figure 10-1.
Here, one end of the firewall is connected to a network hub, which is, in turn,



Chapter 10: Connecting Your Network to the Internet , 93

connected to the other computers on the network. The other end of the fire-
wall is connected to the Internet. As a result, all traffic from the LAN to the
Internet (and vice versa) must travel through the firewall.

The term perimeter is sometimes used to describe the location of a firewall on
your network. In short, a firewall is like a perimeter fence that completely sur-
rounds your property and forces all visitors to enter through the front gate.

QNING/ In large networks, it’s sometimes hard to figure out exactly where the perime-
Y ter is located. If your network has two or more WAN connections, make sure

that every one of those connections connects to a firewall and not directly to
the network. You can do this by providing a separate firewall for each WAN
connection or by using a firewall with more than one WAN port.

A\
Some firewall routers can also enforce virus protection for your network. For
more information about virus protection, see Chapter 23.

|
Figure 10-1:
A firewall
router
createsa
secure link
between a
network and
the Internet.
|

The built-in Windows firewall

Both Windows XP and Vista include a built-in firewall that provides basic
packet-filtering firewall protection. In most cases, you're better off using
a dedicated firewall router because these devices provide better security
features than the built-in Windows firewall does. Still, the built-in firewall
is suitable for home networks or very small office networks.

Here are the steps that activate the built-in firewall in Windows XP or Vista:
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1. Choose Start=>Control Panel.
The Control Panel appears.
2. Click the Windows Firewall icon.

This step opens the Windows Firewall dialog box. Figure 10-2 shows the
Windows Vista version.

3. Select the On (Recommended) option.
This option enables the firewall.

4. Click OK.
That’s all there is to it.

Note that the firewall that’s included with Windows Vista has additional options
you can configure. However, | recommend against fiddling with those options
unless you’ve taken an upper-division college course in computer security.

Do not enable the Windows Internet firewall if you're using a separate firewall
router to protect your network. Because the other computers on the network
are connected directly to the router and not to your computer, the firewall
doesn’t protect the rest of the network. Additionally, as an unwanted side effect,
the rest of the network will lose the capability of accessing your computer.

Beginning with Windows XP Service Pack 2, the firewall is turned on by
default. If your computer is already behind a firewall, disable the Windows
firewall that’s enabled by Service Pack 2.

P Windows Firewall Settings &

General | Exceptions | Advanced

'] tindows Freval s helping to protect your

‘Windoves Firewall can help prevent hackers or malidous software from gaining
access o your computer through the Internet or @ network.

0' @ On (recommended)
This setiing blocks all outside sources from connecting to this
computer, except for those unblocked on the Exceptions tab.
_ Block all incoming connections
Select this opbon when you connect to less secure netwarks. Al

exceptions wil be ignored and you will not be notified when
Windaws Frewall blocks programs.

@.' Off (not recommended)

Avoid using this setting. Tuming off Windows Firewall will make this
computer more vulnerable to hackers or malidous software.
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In This Chapter

Working with the Exchange Server consoles
Managing mailboxes

Granting mailbox access

0ne of the most important ways in which network users connect is
through e-mail. As a result, a mail server is a vital component of all
but the smallest networks.

For Windows networks, the most common mail server is Exchange, properly
known as Microsoft Exchange Server 2003 in its current incarnation. Although
there are alternative e-mail servers, Exchange is the most commonly used.

In this chapter, you discover how to perform the most commonly requested
maintenance chores in Exchange Server, such as how to create a new mailbox,
grant a user access to an additional mailbox, and deal with mailbox size limits.

This chapter doesn’t delve into the intricacies of installing and setting up
Exchange. That subject is best left to the pros. After an Exchange server is
set up, basic maintenance of it (adding and deleting users and configuring
Outlook, for example) is relatively easy.

Using the Exchange System
Manager Console

Most management tasks for Exchange Server are performed from one of two
management consoles. To manage an individual user’s e-mail requirements,
you use Active Directory Users and Computers, as described in detail in
Chapter 16. I discuss several of the Exchange-specific features of this console
later in this chapter.
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Figure 11-1:
The
Exchange
System
Manager
console.

To manage Exchange Server itself, you work with the Exchange System
Manager console, as shown in Figure 11-1. You can use this console to
perform such chores as monitoring the status of the server, setting system
mailbox size limits, and creating public folders.

& Exchange System Manager [_[C]
@ Bl action vew  window Help JISTETES]

% | First Organization (Fxchange)

Hame:

3 Global Settings
-3 Connectors L3 Recipients
-4 Tools L Servers
-3 Folders L Connectors
3 Tooks

3 Folders

-3 Recipierts
-3 Servers

Managing Mailboxes

When you create a new user by using the Add User Wizard from the Server
Management console, an Exchange mailbox is created automatically for the
new user. As a result, you don’t usually have to create Exchange mailboxes
separately. On occasion, though, you may need to modify some aspect of a
user’s Exchange configuration.

Several tabs in the user account Properties dialog box are useful for manag-
ing mailboxes. To summon this dialog box, choose Startc>All Programs=>
Administrative Tools=>Active Directory Users and Computers. Then drill
down to the user account you need to modify and double-click it to bring
up the Properties dialog box. The following sections describe the Exchange
features that are available from the various tabs of this dialog box.

The Exchange General tab
The Exchange General tab, as shown in Figure 11-2, lets you set these options:

v Alias: The default name is the user’s name, but you can change it if
you want.

v Delivery Restrictions: Set a message size limit for incoming and outgoing
messages. You can also specify whom the user can receive messages from.
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v Delivery Options: Create a forwarding address and grant permission to
other users to send on behalf of this account.

v~ Storage Limits: Set the storage limits for the user’s mailbox. You can
have a warning message sent whenever the mailbox reaches one size
limit and then prevent the user from sending or receiving mail after the
mailbox reaches a second size limit.

George Bush Properties ﬂ
Member Of | Dialin I Enviranment i Sessions I Remate cantrol
E-mail Addresses I Exchange Features | Exchange Advanced
General l Addiess I Account | Profile I Telephones l Organization
Terminal Services Frofle | COM+ Exchange General
Mailbox store:

IMMA1 #First Storage Group/ailbox Stare [MAT)

Alias:
igbush

Set the marimum message size and specify Delivery Restictions
the messages accepted by this mailbos. =

Designate delegated permissions and a
forwarding address

— e S
Figure 11-2:
The
Exchange
General tab.

ak Cancel Lpply Help

The E-mail Addresses tab

The E-mail Addresses tab of the User Properties dialog box, as shown in
Figure 11-3, displays the e-mail addresses associated with a user account. If
an e-mail address has been assigned incorrectly, you can use this dialog box
to change it. Just select the incorrect e-mail address, click the Edit button,
and enter the correct e-mail address. You can also add or remove an e-mail
address from this dialog box.

The Exchange Features tab

Figure 11-4 shows the Exchange Features tab of the user Properties dialog
box, which lets you configure optional Exchange features for the user.
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George Bush Properties ﬂ
Member OF | Dialin | Enviratiment l Sessions | Remote contral
Terminal Services Profle | COM+ | Exchange General
General I Address l Account | Profile I Telephones I Organization
E-mail Addresses | Exchange Fealures | Exchange Advanced
Each e-mail address type has one default reply address. To change the
default, gelect an entry in the list, and then click Set A Primary,
E-mail addresses:
Type | Address |
SMTP gbushi@ aasach.com
smtp gbush@aasach. local
X400 c=l5:a= :p=First Organizati.o=Excha.._
|
Figure 11-3:
The E-mail e I e |
Addresses v Automatically update e-mail addresses based on recipient policy
tab.
0k | Camedl | Apn | Hek |
|
George Bush Properties ﬂ
Member Of | Dialin I Enviranment I Sessions I Remate cantrol
Terminal Services Profile | COM+ l Exchange General
General I Addiess I Account I Profile | Telephones I Organization
E-mail &ddresses Exchange Featurss Erchange Advanced
| Features | Status I
E Mobile Services
[#=1 Outlnclk Mohile Access Enabled
B"' User Initiated Synchronization  Enabled
[ Up-to-date Motifications Enabled
5" Protocols
@ Outlook ‘web Access Enabled, using pratocol defaults.
ci. POP32 Enabled, using pratocol defaults.
\_-];r_1 IMAP4 Enabled, using protocol defaults.
|
B Eropetties, b Ensble 3 Disable
Figure 11-4:
Th i Description
€ Select a feature to see its description
Exchange
Features
tab.
0K l Cancel Apply Help
|

The following list describes these features:

v Outlook Mobile Access: The user can access Exchange data from a
mobile device, such as a cellphone or PDA.

v~ User Initiated Synchronization: The user can start a synchronization
operation, to update the mobile device’s data from the data on the
Exchange server.
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|
Figure 11-5:
The
Exchange
Advanced
tab.
|

v Up-to-Date Notifications: Enable automatic synchronizations.

+* Outlook Web Access: The user can access her Exchange mailbox from
a Web browser rather than from an Outlook client. With this feature
enabled, the user can read e-mail from any computer that has an
Internet connection.

v POP3: Enable Internet e-mail by using the POP3 protocol.
v IMAP4: Enable Internet e-mail by using the IMAP4 protocol.

The Exchange Advanced tab

On the Exchange Advanced tab, as shown in Figure 11-5, you can configure
various advanced features of Exchange.

George Bush Properties ﬂ
Member Of | Dialin I Enviranment i Sessions I Remate cantrol
Terminal Services Profile | COM+ l Exchange General

General l Addiess I Account | Profile I Telephones l Organization
E-mail &ddresses l Exchange Featuras Exchange Advanced

Simple display name:
[l

[™ Hide from Exchange address lists
I~ Downgrade high priority mail bound for 2 400

View and modify custom attnbutes B om b
Configure server and account infarmation ILS Settings...
for Intemet locator service —

View and modify permissions to access Mailbc Rights
this mailbos —

Administrative Group: first administiative group

QK | Cancel Lpply Help

The following list describes these features:

v~ Simple Display Name: Specify a display name used by computers that
can’t display the full display name. You probably don’t have to mess
with this feature unless your computers can’t display ASCII characters.

v Hide from Exchange Address Lists: Check this option to prevent a user
from appearing in address lists. This option is useful for mailboxes that
you don’t want to be widely known.
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+* Downgrade High Priority Mail Bound for X.400: This option is compat-
ible with the original X.400 standard, which was first released in 1984. If
you exchange mail with old-style X.400 systems, you may need to use
this option.

v Custom Attributes: This button leads to a dialog box that lets you track
up to 15 different custom attributes for a user. You can safely ignore this
option.

v~ ILS Settings: If you have an Internet Locator Service server installed,
you can click this button to configure it. ILS lets online users find each
other. It’s used by applications, such as NetMeeting.

v Mailbox Rights: The most frequently used feature on the Exchange
Advanced tab, it lets you grant access to this user’s mailbox to other
users. For more information, see the section “Viewing Another Mailbox,”
later in this chapter.

Configuring Qutlook for Exchange

When you create an Active Directory user, the user is automatically set up
with a mailbox. However, you must still configure that user’s Outlook client
software to connect to the user’s account. Follow these steps:
1. Start Outlook on the user’s computer.
An Outlook icon is usually near the top of the Start menu.
2. Choose Tools~E-mail Accounts.

The E-mail Accounts dialog box appears, as shown in Figure 11-6.

E-mail Accounts @@

E-mail Accounts %
‘You can change the e-mail accounts and directories that Outlook uses. =

E-mail

™ Wiew or change existing e-mail accounts

Directory
- . ~
F|gure 11_6. Add & new directory or address book
. " Miew or change existing directories or address books
The first

page of the
E-mail
Accounts

dialog box. Het> | Qo
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3. Select the Add a New E-mail Account option and then click Next.

The dialog box, as shown in Figure 11-7, appears. This dialog box lists
the various types of e-mail accounts that you can create for Outlook.

4. Select the Microsoft Exchange Server option and then click Next.

The dialog box, as shown in Figure 11-8, appears.

E-mail Accounts Egj

Server Type
‘You can choose the type of server your new e-mail acount will work with, 2
@ Micrasolt Enchange Server]
Conneck ko an Exchange server to read e-mail, access public folders, and
I share documents.
. " pOP3
F|gure 1 1 -7: Connect ko a POP3 e-mail server to download
your e-mail,
Outlook can C ne
Connect to an IMAP e-mail server to download e-mail and synchronize
handle mailbox Falders.
" HTTP
ma ny Conneck ko an HTTP e-mail server such as Hotmail ko download e-mail and
dlfferent syncl-'w_on\ze mailbo:: Folders,
(" Additional Server Types
types Of Conneck ko another workgroup or Srd-party mail server,
e-mail
accounts. < Back. Hest s I Cancel
|

E-mail Accounts

Exchange Server Settings
¥ou can enter the required information to connect ko your Exchange server.

Type the name of your Microsoft Exchange Server computer, For information, see your system
administrator,

Microsoft Exchange Server:

Type the name of the mailbo:x set up For you by your administrator. The maibaox name is usually
O USEr Name.

Figure 11-8:
YOU muSt User Mame:

identify the
Exchange

server and

provide a

username. < Back Newt » | Cancel |

5. Enter the name of the Exchange server and the username in the
appropriate text boxes, and then click Next.

You see this message:

The E-Mail account you have just added will not
start until you choose Exit from the File menu
and then restart Microsoft Outlook.
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Figure 11-9:
Don Pardo,
tell them
what
they've
done.
|

6. Click OK.

The message dialog box disappears, and the last page of the E-Mail
Accounts Wizard appears, as shown in Figure 11-9.

7. Click the Finish button.
The wizard is dismissed.
8. Choose Filer>Exit to close Outlook and then restart Outlook.

The mailbox should now be configured.

E-mail Accounts @@
Congratulations!

¥ou have successfully entered all the information required to setup your account,

To close the wizard, click Finish.

Viewing Another Mailbox

Sometimes you want to set up Outlook so that the user has access to not just
his main mailbox but also to another user’s mailbox. For example, you may
create a user named Support so that your customers can send e-mail to
Support@YourCompany . com to ask technical support questions. If you
don’t set up at least one user to read the Support mailbox, any mail sent to
Support@YourCompany . com languishes unanswered. Assuming that that’s
not what you want, you can set up one or more users to access the Support
mailbox and read and respond to its mail.

First, you must configure the Support user account’s mailbox so that it grants
access rights to the user you want to have access to the account. Follow
these steps:

1. On the server, choose Start=>Active Directory Users and Computers,
and then find and double-click the e-mail account that you want to
access from another user’s copy of Outlook.

The Properties dialog box appears.
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|
Figure 11-10:
The Mailbox

Rights tab.

Permissions for Support E E

Maibox Righs |

Group or user names:

4

m AMONYMOUS LOGON
m Domain Admins [aasachiDomain Admins)
m Enterprise Admins [aasach Enterprise Admins]

. Click the Exchange Advanced tab and then click the Mailbox Rights

button.

The Permissions for Support dialog box appears and displays the
Mailbox Rights tab, as shown in Figure 11-10.

. Click the Add button.

This step brings up the Select Users, Computers, or Groups dialog box.

. Type the name of the user you want to grant access to and then click OK.

You return to the Permissions for Support dialog box. The user you
added is selected in the list of users with access to the mailbox.

. Select the Allow check box for the Full Mailbox Access option to grant

the user full access to the mailbox and then click OK.

The Mailbox Rights dialog box is dismissed.

. Click OK.

The user Properties dialog box is dismissed.

Eusariimm =

Add, | Remove
Permissions for Administrator Allaw Deny

Associated external account

For special permissions or for advanced settings, Advanced l
click Advanced. =

Delete mailbox storage
Read permissions
Change permissions

T ske ownership

Full mailbox access

oEEEEE
aoono

0K I Caneel i Bl |

After you grant access to the account, you can configure the user’s copy of
Outlook to read the Support account. Follow these steps:

1. On the user’s computer, start Outlook and choose Tools=

E-mail Accounts.

The E-mail Accounts dialog box (refer to Figure 11-6) is displayed.
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2. Select the View or Change Existing E-Mail Accounts option and then
click Next.

The dialog box, as shown in Figure 11-11, is displayed. This dialog box
lists the e-mail accounts that have been configured for the Outlook client.

E-mail Accounts

E-mail Accounts
‘ou can select an account and change its settings or remove it. E

Outlook processes e-mail For these accounts in the Fallowing order:

o [, |
change er Exchange (Defaul)
S o
- Remove
Figure 11-11: =]

;

The e-mail
accounts :
. 4 > c
configured
for an Deliver new e-mail to the Following location:

|Pr\vate Folders j Mew Dutlook Data File. ..
Outlook =
Cllent. < Back Finish | Cancel

3. Select the Microsoft Exchange Server account and then click the
Change button.

The Exchange Server Settings dialog box appears, as shown in Figure 11-12.

E-mail Accounts E @
Exchange Server Settings
‘You can enter the required information to connect ko your Exchange server. 3
Type the name of your Microsoft Exchange Server computer. For information, see your system
adrministrator,

Microsaft Exchange Server: ML

Type the name of the mailbox set up For you by your administrator, The maibox name is usually
| AR

Figure 11-12; | U= [osloe =]
The
Exchange
Server

. More Settings ...
Settings
dlaloq bOX. < Back | | Cancel |

4. Click the More Settings button and then click the Advanced tab.

The Advanced tab of the Microsoft Exchange Server dialog box appears,
as shown in Figure 11-13.
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Figure 11-13:
The
Advanced
tab of the
Microsoft
Exchange
Server
dialog box.
|

A\

Microsoft Exchange Server @

General Advanced ‘Cunnacliun] Remote Ma\ll

Mailboxes
©pen these additional mailboxes:

Add...

oo

Encrypt information
[~ When using the nebwork
™ When using dial-up networking

Logon nebwork security:

|Password Authentication ﬂ
Offline Folder File Settings...
oK Cancel | J Help |

5. Click the Add button.

A dialog box prompts you for the name of the mailbox you want to add.

6. Type the name of the mailbox you want to add and then click OK.

The mailbox is added to the list box in the Microsoft Exchange Server

dialog box.
7. Click OK.

You return to the Exchange Settings dialog box.
8. Click Next and then click Finish.

You’re done! You can now view the Support mailbox.

To view the mailbox, choose Viewm>Folder List to open the Folder List window
in Outlook. Then double-click the Support mailbox in the list to open it.
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Chapter 12
Creating an Intranet

In This Chapter

Getting acquainted with intranets

Finding good uses for intranets

How to set up a simple intranet

How to manage IIS

No, I'm not mispronouncing the word Internet. The term intranet has
gained popularity in recent years. It’s similar to the Internet, but with
a twist: Rather than connect your computer to millions of other computers
around the world, an intranet connects your computer to other computers
in your company or organization. How is an intranet different from your
ordinary, run-of-the-mill network? Read on, and I'll explain.

What Is an Intranet?

\\J

Everyone knows that the Internet, and especially the World Wide Web, has
become a phenomenon. Millions of computer users worldwide surf the Web,
and many join the bandwagon every day.

Recently, ingenious network managers at large companies figured out that
although the Web is interesting for distributing public information to the
world, the Web is even better for distributing private information within a
company. Thus, the idea of intranets was born. An intranet is a network that
is built by using the same tools and protocols that are used by the global
Internet but applied instead to an organization’s internal network.

Think of an intranet as a small, private version of the World Wide Web. Anyone
who connects to your local-area network (LAN) can access your intranet.

The intranet is accessed by using a Web browser, such as Internet Explorer

or Firefox. However, users don’t need an Internet connection because the
information on the intranet is stored on the company’s server computers
rather than on a computer that must be accessed from the Internet.
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The intranet is analogous to a closed-circuit television system, which can
be viewed only by people within the organization that owns the system. In
contrast, the Internet is more like cable television in that anyone who’s will-
ing to pay $20 or so per month can watch.

Here are two interesting but contradictory points of view about the significance
of intranets:

v Some computer industry pundits say that intranets are more popular
than the Internet. For example, many companies that sell Web develop-
ment tools make more money selling software used for intranets than for
the Internet.

+ On the other hand, other industry pundits think that the intranet phe-
nomenon is merely a fad that some other promising new technology,
such as pet rocks or hula hoops, will replace in a few years. Only time
will tell.

What Do Vou Use an Intranet For?

Intranets can distribute just about any type of information within a company.
Intranets use two basic types of applications:

v~ Publishing application: Information is posted in the form of pages that
you can view from any computer with access to the intranet. This type
of intranet application is commonly used for company newsletters,
policy manuals, and price lists, for example.

< Publishing applications are simple to set up. In fact, you may be able
to set up one yourself without a lot of outside help from highly paid
computer consultants.
v Transaction application: Information is gathered from users of the
intranet who file online expense reports, report problems to the help
@‘“\NG! desk, or enroll in employee benefit programs, for example.
S

Expect to spend big bucks on computer consulting to get an intranet
transaction application set up.

Here’s the key difference between these two types of intranet applications:

+ In a publishing application, information flows in one direction. It
flows from the intranet to the user. The user requests some information,
and the intranet system delivers it.

+ In a transaction application, information flows in both directions. Not
only does the user request information from the intranet system, but the
intranet system itself also requests information from the user.
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What You Need to Set Up an Intranet

To properly set up an intranet, you need the right tools. Here’s a list of
requirements:

v A network: An intranet doesn’t require its own cabling; it can operate on
your existing network.

1 A server computer that’s dedicated to the intranet: Make sure that this
computer has plenty of RAM (at least 2GB) and gigabytes of disk space
(at least 100GB). Of course, the more users your network has and the
more information you intend to place on the server, the more RAM and

disk storage you need.

1 Windows Server 2003 or a Linux operating system: Web server soft-
ware requires one or the other.

v Web server software for the server computer: You need to install a
Web server, such as IIS (for Windows servers) or Apache (for Linux

or Windows servers).

A Webless intranet

The correct way to set up a proper intranet is to
set up a Windows-based server running IIS or a
Linux-based server running Apache or some
other Web server. However, you can create a
rudimentary intranet without going to the trouble
of setting up an actual Web server. Here's how:

1. Setup a share on afile server that will hold
the HTML files that make up your intranet.

2. Create an HTML file for the home page of
your intranet and save the file in the loca-
tion you create in Step 1.

| recommend that you name it index.
html.

3. Create any other HTML files that your
intranet needs.

The index.html file should include links
to these pages.

4. Point your Web browser to the index.
html file at the shared network location.

For example, if the serveris named i server
and the share is named intranet, enter
this information into your browser’s address
box: \iservenintranet\index.html. Voila! —
you have an instant intranet without the fuss
of a Web server.

This rudimentary intranet works without a Web
server because a Web browser can display
HTML files directly, without the need for a Web
server. However, without a Web server, your
intranet is limited in what it can do. In particu-
lar, all its pages must be static (their content is
fixed). For dynamic content, which users inter-
act with, you need to set up a Web server.
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v Programs to help you create Web pages: If you're the type who dreams in

binary, you can create Web pages by typing HTML codes directly into text
files. In that case, the only program you need is Notepad. Alternatively,
you can use a program designed specifically for creating web pages, such
as Microsoft FrontPage, or perhaps something fancier, such as Adobe
Dreamweaver. If you're going to develop transaction-based applications,
you need additional tools.

How to Set Up an IIS Web Server

Microsoft’s Web server for Windows server operating systems is Internet
Information Services, or IIS. 1IS is included with Windows Server 2003 but
isn’t enabled by default. So, you need to configure it before you can use it
to create an intranet. Here are the steps:

\\J

1.

Choose Start=>All Programs->Administrative Tools=>Configure Your
Server Wizard.

This step launches the Configure Your Server Wizard, which displays a
friendly greeting screen.

. Click Next.

The Configure Your Server Wizard displays a screen full of helpful tips,
which you should read.

The only tip you need to pay attention to for this procedure is the one
that advises you to have your Windows Server 2003 Setup CD handy. If
you don’t have it nearby, go get it before you continue.

. Click Next.

The Configure Your Server Wizard grinds and whirs for a moment and
then displays the page shown in Figure 12-1.

. Select the Application Server (IIS, ASP.NET) option and then click Next.

The Configure Your Server Wizard displays the options for installing IIS,
as shown in Figure 12-2.

. Select both the FrontPage Server Extensions option and the Enable

ASP.NET option.

There’s no real reason not to enable both these options, so I recommend
that you select them both, even if you're not sure that you need them:

* FrontPage Server Extensions: Makes it easier to work with
FrontPage to create Web pages for your intranet.

e Fnable ASPNET: Enables the ASP.NET programming platform, which
lets you create sophisticated, Web-based programs for your intranet.
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Figure 12-2:
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Configure Your Server Wizard

Server Role
You can set up this server ta perform one o mare specfic rales, TF you wank to add more than one
role ta this server, you can run this wizard again.

Select arole. If the role has not been added, you can add . If it has skeady been added, you can
remove it, IF the role you want to add or remove is not ksted, open Add or Remove Programs,

Read about application sarvers

View the Confiqure Your Server log.

Server Role Configured | Application server (115, ASP.NET)
File server Ves

Print server Yes

Application server (115, ASP.NET) Mo Application servers provide the core
Mal server (POP3, SMTF) Mo technalogies required to buid, deploy,
Terminal server Mo and operate XML Web Services, Web
Remote access [ VPN server Mo applications, and distributed

Domain Coritralier (Active Directory) Ves applications. Application server

DNS server Yes technologies include ASP.NET, COM+
DHCP server Mo and Internet Information Services
Streaming media server Mo (us).

WINS server Mo

x|

Configure Your Server Wizard

Application Server Options
115, COM+, ASP.NET, and Microsoft .NET Framework are installed automatically for this role.

Select the additional tools that vou want to install on this server,
[V FrontPage Server Extensions

FronkPage Server Extensions are a sat of Web server extensions that you can use to publis
content with FrantPage, Visual Studio, and Web Folders.

¥ En
ASP.NET is a powerful programming framework for building Web-based applications and
services that can target any browser or device,

A

=),

h

< Back Nest > Cancel

Help

6. Click Next.

The wizard displays a summary page that indicates the options you

selected, as shown in Figure 12-3.

7. Click Next.

The wizard installs IIS and ASP.NET. This process may take a few minutes,

so be patient.

If you're prompted to insert the Windows Server 2003 Setup CD, do so

cheerfully.

After the installation is finished, the page shown in Figure 124 is displayed.
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8. Click Finish.

You're done!

T
Summary of Selections S
‘iew and confirm the options you have selected, h
Summary:
Install Internet Information Services (T1S)
Enable COM+ for remoke transactions
Enable Microsaft Distributed Transaction Coordinator (DTC) For remate access
Install FrontPage Server Extensions
Enable ASPNET
|
Figure 12-3:
The
Configure
Your Server
Wiza rd |S To change your selections, click Back. To continue setting up this role, chck Mext,
ready to go. o
|

ure Your Server Wizard

This Server is Now an Application server

You have successfully set up this server as an appheation server by
installing I15.

To add or remove another role, run the Configure Your Server Wizard
again,

Wiew the next steps for this role

Figure 12-4:
The
Configure
Your Server
Wizard is
finished.
|

For arecord of your changes, see the Configure Your Server log,
To clase this wizard, chck Finish.

Carcel Help |

How to Create a Simple Intranet Page

After you configure IIS, it’s ready to start serving up Web pages for your
intranet. All you have to do is create Web pages and save them in the correct
location. For the default Web site created by IIS, this location is ¢ : \ inetpub\
webroot.
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To get you started, follow these steps to create a simple home page that

displays the text Welcome to my Intranet!

1. On the server, choose Start=>All Programs->Accessories~>Notepad.

Notepad, the handy-dandy free text editor, appears.

2. Type these three lines in the Notepad window:

<hl>
Welcome to my Intranet!
</hl>

3. Choose File~>Save, navigate to c: \inetpub\webroot, and save the

file as index.htm.

Be sure to save the file as index.htm, not index.html.

4. Close Notepad.

5. Open a Web browser on a client computer that’s connected to the

network.

6. Enter the server name in the address bar and press Enter.

Your intranet comes to life, as shown in Figure 12-5.

Granted, this intranet doesn’t do much. You're on your own now to
create more interesting Web pages for your intranet. Just save the pages

in c:\inetpub\webroot.

& http:/liserver01/ - Windows Internet Explorer

2=}

(€]

4 v || htm:/fserverol/

W | @ httpHiserver01/ | -5 -

e

5 »
=y Page v Gk Tools +

Welcome to my Intranet!

Done %4 Local intranet

#100% -
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Managing 11S

You can manage IIS by using the IIS Manager, as shown in Figure 12-6. To start
this tool, choose Start=>All Programs=>Administrative Tools=>Internet
Information Services (IIS) Manager.
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The pane on the left side of the IIS Manager lists all the Web sites managed by
the server. The Default Web Site folder is the Web site that’s displayed when
the user uses a Web browser to browse to the server.

You can right-click a Web site in the IIS Manager and choose Properties to
display the Web site’s Properties page, as shown in Figure 12-7.

Alot of information is presented in the nine tabs of this dialog box. The most
important items are described in this list:

v IP Address: In most cases, this field is set to All Unassigned, which
means that this Web site will be associated with all IP addresses for
the server that aren’t specifically assigned to other Web sites.

v Home Directory: This tab tells you where on the server’s hard drive the
HTML and other files for the Web site are located. For the default Web
site, the standard location is c: \ inetpub\webroot. If you want to
store the files somewhere else, change the Local Path field on this tab.



Figure 12-7:
The
Properties
dialog box
for the
default
Web site.
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v Documents: This tab contains a list of filenames that are used when the
user navigates to the Web site but doesn’t provide a filename. For exam-
ple, when you enter just the server name without a filename, IIS searches
the Web site’s home directory for one of the files listed on this tab. The
default is to look for the following files, in this order:

default.htm
default.asp
index.htm
iisstart.htm
Default.aspx
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Chapter 13

Is It a Phone or a Computer?
(Or, Understanding VolP
and Convergence)

In This Chapter

How VoIP works

Advantages of VolP
Disadvantages of VoIP

Some popular VolP providers

One of the newest trends in networking is the convergence of two distinct
but similar types of networks: computer networks and telephone net-
works. Both types of networks can be either cabled or wireless, and both can
carry voice and data. In other words, the distinction between computer net-
works and telephone networks is getting blurry.

This chapter gives you a brief introduction to VoIP, a technology that lets you
send voice data over your computer network. In other words, VoIP attempts
to make your phone cables obsolete by having the computer network handle
voice traffic.

\\3
This chapter isn’t a complete guide to VoIP. For that, check out VolIP For
Dummies, written by Timothy V. Kelly and published by Wiley.

Understanding VolP

VoIP, which stands for Voice Over IP (Internet Protocol), works much the same as
a regular telephone. However, rather than connect to the public telephone net-
work, your phones connect directly to the Internet. The main benefit is reduced
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cost, especially if you make a lot of long distance phone calls. Most VoIP ser-
vices charge a single flat monthly rate, usually in the neighborhood of $25-$35.

When you use a normal phone to make a long distance call, your voice is
transmitted (usually in digital form) over the public switched telephone net-
work, or PSTN. Along the way, you're charged by-the-minute fees by your long
distance service provider.

When you use VoIP, your voice is still converted into digital form. However,
rather than be sent over private networks owned by telephone companies, it
is sent over the Internet. Because the Internet uses the IP protocol, the digital
data that represents your voice must be converted into packets that can be
sent reliably over IP — hence the name Voice Over IP, or VoIP.

Carrying telephone conversations over the Internet isn’t new. In fact, the
technology has been around for many years. Only recently has the technol-
ogy become inexpensive enough to catch on for residential service. That’s
why you may not have heard of VoIP until now.

There are two basic approaches to setting up VolP:

1 Software-only VoIP systems: These run on your computer and enable
you to talk free with anyone else anywhere in the world provided they’re
using the same software you are.

The best-known software-only VoIP system is Skype (www . skype . com).
The advantage of Skype is that it’s free. Software-only VoIP has two
major drawbacks:

¢ You can only use it from your computer. You can’t just pick up a
phone, dial a number, and make a call via Skype.

¢ The other person must use Skype. You can’t just call anyone.

A fee-based system, SkypeOut, lets you call regular phone numbers
from Skype for about $0.02 per minute (way cheap).

Skype is great if you do most of your long distance calling to geeks who
don’t mind sitting at the computer for “phone” calls.

1 VoIP services, such as Vonage and AT&T CallVantage: These services
don’t require a computer. They use an Analog Telephone Adapter (ATA)
that connects a normal telephone to the Internet. The adapter lets you
use VolIP pretty much as though it were a regular telephone. You just
pick up the phone and dial a number. The fact that the call is routed
over the Internet rather than over the public phone network is, for the
most part, transparent.
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Advantages of VolP

VolP service has several compelling advantages over traditional telephone
service. Here are a few:

v Long distance calls over VoIP are cheaper than they are over tradi-
tional phone service. With VoIP, you typically pay a fixed monthly rate
of $25-$35 for unlimited calls — long distance or not. If your phone bill
now runs more than $35 per month, you may want to consider VoIP.

+* You can take your ATA device with you on the road and use it anywhere
that you can plug into the Internet. For example, you can go on vacation
and take your ATA with you. Then you can plug into the Internet and
receive or make calls by using your home phone number. (Of course,
you don’t have to take your ATA with you. After all, avoiding calls from
your in-laws may be the reason you're going on vacation in the first place.)

1~ Because calls are carried over the Internet and not over the public
switched telephone network, your phone isn’t tied to a specific area
code. In fact, VoIP lets you choose any area code you want. For example,
if your small company is located in Fresno, you can get a VoIP service
with a 415 area code so that your customers will think you’re in San
Francisco.

An enterprising small business in Fresno can set up two VoIP lines with
a 415 area code and a 212 area code. Your customers will think that you
have offices in San Francisco and New York, even though both numbers
ring phones in sunny Fresno.

+ Choosing a local area code saves on phone charges. Suppose that
your office is in Fresno, but nearly all your clients are in San Francisco.
Setting up a 415 VoIP number lets your clients dial your number as a
local call. Choosing an area code other than your real area code isn’t
always just for looks.

+* VoIP services have more features in the standard package. Features,
such as call waiting, call forwarding, caller ID, 3-way calling, and voice
mail, usually don’t cost extra with VoIP.

v Modern VoIP audio quality is as good as traditional phone service.
Sometimes, it’s better.

v VoIP services have additional features that you can use if you connect a
computer to the ATA device. For example, some services can send your
voice-mail messages to an e-mail account as attachments. Then you can
use Microsoft Outlook or another mail program to listen to your voice mail.
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Disadvantages of VolP

You have to consider a few disadvantages before you switch your phone
service over to VoIP. Here are the most important ones:

+ You must have a reliable broadband Internet connection. If your
Internet connection goes down, so will your VoIP connection.

1 The ATA requires electrical power to work. As a result, you can’t use
your VoIP phone during a power outage unless you connect it to an
Uninterruptible Power Supply (UPS). In contrast, traditional telephones
draw their power directly from the phone lines. That’s why traditional
phones continue to work even during power outages.

v VoIP isn’t really mobile in the same sense as a cellphone. You probably
need a cellphone, too.

v~ Calls to the 911 emergency system are problematic with VolP services.
The basic problem is that the 911 system is designed to contact local
emergency dispatchers. Because VoIP services aren’t tied to a particular
location, you must notify your VoIP provider of your location for 911 to
work. If you take your VoIP ATA with you on a trip and then forget to notify
your provider of your new location before dialing 911, you're connected to
emergency services in your hometown, not in your present location.

Popular VolP Providers

If you're thinking of switching to VoIP, investigate these services:

v Vonage: One of the oldest and most popular VoIP providers. A residen-
tial customer can get unlimited access for $24.95 per month. Or, you can
get a 500-minute plan for $14.95 per month. See www . vonage . com.

v AT&T CallVantage: The basic plan for residential customers, with
unlimited long distance, costs $29.95 per month. See www.usa.att.
com/callvantage.

1 Cablevision Optimum Voice: The Cablevision Optimum Voice plan costs
$34.95 per month. See www . opt imumvoice.com.

1 Verizon VoiceWing: The basic unlimited service plan is $29.95 per
month. Like Vonage, Verizon offers a 500-minute plan for $14.95 per
month. See www .voicewing.com.



Chapter 14
Connecting from Home

In This Chapter

Accessing your e-mail with Outlook Web Access

Using a virtual private network

A typical computer user takes work home to work on in the evening or
over the weekend and bring back to the office the following weekday.
This arrangement can work okay, except that exchanging information
between your home computer and your office computer isn’t easy.

One way to exchange files is to mark them for offline access, as described in
Chapter 3. However, this approach has its drawbacks. What if someone goes
to the office on Saturday and modifies the same file you're working on at
home? What if you get home and discover that the file you need is on a folder
you didn’t mark for offline access?

What about e-mail? Offline access doesn’t give you access to your company
e-mail account, so you can’t check whether you have mail in your Inbox or
send mail from your company e-mail account.

This chapter introduces two features that can alleviate these problems. The
first is Internet-based access to your e-mail via Outlook Web Access (OWA) in
Microsoft Exchange. The second is the virtual private network (VPN), which
lets you connect to your network from home as though you were at work so
that you can safely access all your network resources as though you were
locally connected to the network.

Using Outlook Web Access

Most people who connect to their office networks from home really just need
their e-mail. If the only reason for accessing the office network is to get
e-mail, Outlook Web Access is a simple, easy tool.
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|
Figure 14-1:
OWA looks
alot like
Outlook.
|

Outlook Web Access (OWA) is a Microsoft Exchange Server feature that

can access your company e-mail from any computer that has an Internet con-
nection. The remote computer just needs a Web browser and an Internet
connection; no VPN or other special configuration is required.

The best part is that you don’t have to do anything special to enable OWA;
it’s enabled by default when you install Microsoft Exchange 2003. Although
you can configure plenty of options to improve its use, OWA is functional
right out of the box.

To access OWA from any Web browser, just browse to the address that’s des-
ignated for your organization’s OWA. The default address is the DNS name of
your mail server, followed by /exchange. For example, for the mail server
smtp.lowewriter.com, the OWA address is smtp.lowewriter.com/
exchange.

The connection must use the secure version of the normal HTTP Web proto-
col. You must type https:// before the OWA address. The complete address
will be something like https://smtp.lowewriter.com/exchange.

When you browse to your OWA address, you're prompted to enter a name
and password. Use your regular network logon name and password. OWA
will appear in the browser window, as in Figure 14-1.
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If you're familiar with Outlook, you’ll have no trouble using OWA. Almost all
Outlook’s features are available, including your Inbox, calendar, contacts,
tasks, reminders, and even public folders. You can even set up an Out of
Office reply.

One difference between OWA and Outlook is that there’s no menu bar across
the top. However, most of the functions that are available from the menu bar
are available elsewhere in OWA. If you can’t find a feature, look in the Options
page, which you can reach by clicking Options at the bottom left of the
window. Figure 14-2 shows the Options page. As you can see, this page lets
you create an Out of Office reply, set your signature, and change a variety of
other options.
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Using a Virtual Private Network

The term virtual private network, or VPN, refers to several different types of
secure forms of Internet communication. In this chapter, a VPN is a secure
channel between a remote computer and a local network. This type of VPN
enables you to log on to your company network from your home computer.
Then you can access any resource on your company network as though you
were using a computer that’s physically connected to the company network.
In other words, the VPN extends the reach of the company network to
include your home computer.

The security mechanism that makes this magic work is the Internet protocol
known as [PSec. The details of how IPSec works are way beyond the scope of
this humble little book. Suffice it to say that IPSec encrypts all the Internet
traffic related to the VPN. This encryption effectively creates a secret tunnel
between the office network and your home computer. Thus, the VPN connec-
tion is secure.

Although the VPN connection itself is secure, the computer that the VPN con-
nects to may not be. Using a VPN with your home computer is analogous to
taking your computer to work and plugging it in to the network. If your com-
puter is already infected with a virus, you run the very real risk of letting that
virus loose on your corporate network. As a result, you must be certain that
the same security precautions you use with your company network are in use
with any computer that you let connect to the network via a VPN. You must
therefore ensure that the computer has, at minimum, adequate antivirus
protection in place.

In most networks, the VPN is implemented by the firewall router that con-
nects the network to the Internet. Thus, if you plan on providing VPN capabil-
ity for your network users, you should make sure that the router you use to
connect to the Internet has VPN support built in.

The office network side of the VPN is provided by the firewall router. The
other side of the VPN — the remote computers — is provided by software
that must be installed on the computers themselves. Send a copy of this
software home with each user who wants to use the VPN, along with detailed
instructions on how to install and configure it. Either that, or you’ll have to
visit each person’s home to install and configure the software yourself. (I
wrote instructions for installing VPN software for a user who has a vacation
home in Monterey, California. Unfortunately, the instructions were clear
enough that he was able to install the VPN software himself, so I didn’t

have to make a house call. Next time, I'm writing the instructions in Latin.)

After a remote user has used a VPN to connect to your network, the user can
access any of the network’s shared resources. For example, the user can map
network drives and access shared network folders and can also use network

printers. And, she can use Outlook to access her e-mail.
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In this part . . .

ou discover that there’s more to networking than

installing the hardware and software. After you get
your network up and running, you have to keep it up and
running. That’s called nefwork management.

The chapters in this part show you how to set up your
network’s security system, improve your network’s per-
formance, and protect your network from disaster. At
times, things may get a bit technical, but no one said that
life is easy.




Chapter 15

Welcome to Network
Management

In This Chapter

Exploring the many jobs of the network administrator
Documenting the network

Dusting, vacuuming, and mopping

Managing network users

Choosing the right tools

Getting certified

’{elp wanted. Network administrator to help small business get control of a
network run amok. Must have sound organizational and management
skills. Only moderate computer experience required. Part-time only.

Does this sound like an ad that your company should run? Every network
needs a network administrator, whether the network has 2 computers or
2,000. Of course, managing a 2,000-computer network is a full-time job,
whereas managing a 2-computer network isn’t. At least, it shouldn’t be.

This chapter introduces you to the boring job of network administration.
Oops — you're probably reading this chapter because you’ve been elected
to be the network manager, so I'd better rephrase that:

This chapter introduces you to the wonderful, exciting world of network manage-
ment! Oh, boy! This is going to be fun!

What a Network Administrator Does

A network administrator “administers” a network: Installing, configuring,
expanding, protecting, upgrading, tuning, and repairing the network.
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A network administrator takes care of the network hardware (such as cables,
hubs, switches, routers, servers, and clients) and the network software (such
as network operating systems, e-mail servers, backup software, database
servers, and application software). Most important, the administrator takes
care of network users by answering their questions, listening to their trou-
bles, and solving their problems.

On a big network, these responsibilities constitute a full-time job. Large
networks tend to be volatile: Users come and go, equipment fails, software
chokes, and life in general seems to be one crisis after another.

Smaller networks are much more stable. After you get your network up and
running, you probably won’t have to spend much time managing its hardware
and software. An occasional problem may pop up, but with only a few com-
puters on the network, problems should be few and far between.

Regardless of the network’s size, the administrator attends to common chores:

v Get involved in every decision to purchase new computers, printers,
or other equipment.

+* Put on the pocket protector whenever a new computer is added to the
network. The network administrator’s job includes considering changes
in the cabling configuration, assigning a computer name to the new com-
puter, integrating the new user into the security system, and granting
user rights.

1+ Whenever a software vendor releases a new version of its software,
read about the new version and decide whether its new features war-
rant an upgrade. In most cases, the hardest part of upgrading to new soft-
ware is determining the migration path — that is, upgrading your entire
network to the new version while disrupting the network and its users as
little as possible. This statement is especially true if the software in ques-
tion happens to be your network operating system because any change to
the network operating system can potentially impact the entire network.

CMBER
‘{y‘“ Between upgrades, software vendors periodically release patches and
service packs that fix minor problems. For more information, see
Chapter 23.

v Perform routine chores, such as backing up the servers, archiving old
data, and freeing up server disk space. Much of the task of network
administration involves making sure that things keep working, by finding
and correcting problems before users notice that something is wrong. In
this sense, network administration can be a thankless job.

v Gather, organize, and track the entire network’s software inventory.
You never know when something will go haywire on the ancient
Windows 95 computer that Joe in Marketing uses, and you have to rein-
stall that old copy of Lotus Approach. Do you have any idea where the
installation disks are?
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Picking a Part-Time Administrator and
Providing the Right Resources

The larger the network, the more technical support it needs. Small networks —
with just one or two dozen computers — can manage with just a part-time
network administrator. Ideally, this person should be a closet computer geek:
someone who has a secret interest in computers but doesn’t like to admit it;
someone who will take home books to read over the weekend; and someone
who enjoys solving computer problems just for the sake of solving them.

égN\BEﬁ' The job of managing a network requires some computer skills, but it isn’t

& entirely a technical job. Much of the work is routine housework. Basically, the
network administrator does the electronic equivalent of dusting, vacuuming,
and mopping the network periodically, to keep it from becoming a mess.

Here are some resources the network administrator needs:

1 Allow enough time for network administration. For a small network
(no more than 20 or so computers), an hour or two each week is enough
time to do the job. More time is needed upfront while the network
administrator settles into the job and discovers the ins and outs of the
network. After an initial settling-in period, network administration for a
small-office network doesn’t take more than an hour or two per week.
(Larger networks take more time.)

v Give the position some teeth. You need to make sure that everyone
knows who the network administrator is and that he has the authority
to make decisions about the network, such as which access rights each
user has, which files can and can’t be stored on the server, and how
often backups are done.

v Provide backup. The network administrator needs an understudy —
someone who knows almost as much about the network, is eager to
make a mark, and smiles when the worst network jobs are “delegated.”

v~ Supply a job title and a job description. The network manager should
have some sort of official title, such as Network Boss, Network Czar, Vice
President in Charge of Network Operations, or Dr. Net. A badge, a per-
sonalized pocket protector, or a set of Spock ears helps, too.

Here are some suggestions for picking a part-time network administrator.
Make sure that the person you choose

v Is organized: Conduct a surprise office inspection and place the person

with the neatest desk in charge of the network.

WING/
& | . |
Don’t warn anyone in advance, or else everyone may mess up their

desks intentionally the night before the inspection.
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v~ Is assertive and willing to irritate people to get the job done: A good
network administrator should ensure that backups are working before a
disk fails and that everyone is following good antivirus practices before a
virus wipes out the entire network.

1 Knows how to install the software: Usually, the person who installs the
network is also the network administrator. This is appropriate because
no one understands the network better than the person who designs
and installs it.

Documenting the Network

One of the network administrator’s main jobs is to keep the network docu-
mentation up-to-date. I suggest that you keep all important information about
your network in a three-ring binder. Give this binder a clever name, such as
The Network Binder. Here are some items it should include:

»* An up-to-date diagram of the network: This diagram can be a detailed
floor plan showing the location of each computer or a more abstract and
Picasso-like depiction. Anytime you change the network layout, update
the diagram. Include a detailed description of the change, the date that

W the change was made, and the reason for the change.

Microsoft sells the Visio program, which is specially designed for creat-
ing network diagrams. I highly recommend it.

v A detailed inventory of your computer equipment: Table 15-1 provides a
sample checklist you can use to keep track of your computer equipment.

v~ A System Information printout for each computer: Choose Start=>
All Programs=>Accessories=>System Tools=System Information.

v A detailed list of network shares and standard drive assignments:
Don'’t just list the name of each network share; provide a brief descrip-
tion of each share’s purpose as well.

v Any other information that you think may be useful: Give details about
how you must configure a particular application program to work with
the network and copies of every network component’s original invoice —
just in case something breaks and you need to seek warranty service.

v Backup schedules: Include a schedule of when each server is backed up

QNG as well as an explanation of the tape rotation schedule.
$V~
Never put passwords in the binder!
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Table 15-1 Computer Equipment Checklist

Computer location:

User:

Manufacturer:

Model number:

Serial number:

Date purchased:

CPU type and speed:

Memory:

Hard drive size:

Video type:

Printer type:

Other equipment:

Operating system version:

Application software and version:

Network card type:
MAC address:

\P
) Even if you keep track of the information in your network binder by using a

spreadsheet or database program, keep a printed copy of the information on
hand.

If your network is large, you may want to invest in a nefwork-discovery program,
such as NetworkView Software’s NetworkView (www . networkview.com). This
program can gather the network documentation automatically: It scans the net-
work carefully for every computer, printer, router, and other device it can find
and then builds a database of information. The program then automatically
draws a pretty diagram and chugs out helpful reports.

Performing Routine Chores

Much of the network manager’s job is routine stuff — the equivalent of vacu-
uming, dusting, and mopping, or changing your car’s oil and rotating the tires.
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These tasks are boring, but they have to be done:

1 Create backups: The network manager must ensure that the network is
properly backed up. If something goes wrong and the network isn’t
backed up, guess who gets the blame? On the other hand, if disaster
strikes yet you're able to recover everything from yesterday’s backup
with only a small amount of work lost, who gets the pat on the back, the
fat bonus, and the vacation in the Bahamas? Chapter 21 describes the
options for network backups. Read it soon.

v Provide security: Another major task for a network administrator is
sheltering the network from the evils of the outside world. These evils
come in many forms, including hackers trying to break into your net-
work and virus programs arriving through e-mail. Chapter 22 describes
this task in more detail.

v Cleanup: Users think that the network server is like the attic: They want to
throw files up there and leave them forever. No matter how much disk stor-
age your network has, your users will fill it up sooner than you think, so the
network manager gets the fun job of cleaning up the attic once in a while.
The best advice I can offer is to continually complain about how messy it is
up there and warn your users that spring cleaning is on the to-do list.

Managing Network Users

Managing network technology is the easiest part of network management.
Computer technology can be confusing at first, but computers aren’t as con-

fusing as people. The real challenge of managing a network is managing the
network’s users.

The difference between managing technology and managing users is obvious:
You can figure out computers, but who can ever really figure out people? The
people who use the network are much less predictable than the network
itself. Here are some tips for dealing with users:

v Make user training a key part of the network manager’s job. Make sure
that everyone who uses the network understands how it works and how
to use it. If the network users don’t understand how the network works,
they may unintentionally do all kinds of weird things to it.

v Treat network users respectfully. If users don’t understand how to use
the network, it’s not their fault. Explain it to them. Offer a class. Buy
each one a copy of this book, and tell them to read it during the lunch
hour. Hold their hands. Just don’t treat them like idiots.

v Create a network cheat sheet. It should contain everything users need to
know about using the network — on one page. Everyone needs a copy.

v~ Be as responsive as possible. If you don’t quickly fix a network user’s
problem, he may try to fix it. You don’t want that to happen.
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<® The better you understand the psychology of network users, the more
prepared you are for the strangeness they often serve up. Toward that end,
I recommend that you read the Diagnostic and Statistical Manual of Mental
Disorders (also known as DSM-IV) from cover to cover.

Acquiring Software Tools for
Network Administrators

Network managers need certain tools to get their jobs done. Managers of big,
complicated, expensive networks need big, complicated, expensive tools.
Managers of small networks need small tools.

Some of the tools that a manager needs are hardware tools, such as screw-
drivers, cable crimpers, and hammers. The tools I'm talking about, however,
are software tools. I mention a couple of them earlier in this chapter: Visio
(to help you draw network diagrams) and a network-discovery tool to help
you map your network. Here are a few others:

v+ Built-in TCP/IP commands: Many of the software tools that you need in
order to manage a network come with the network itself. As the network
manager, you should read through the manuals that come with your net-
work software to see which management tools are available. For example,
Windows includes anet diag command that you can use to make sure
that all the computers on a network can communicate with each other. (You
canrun net diag from an MS-DOS prompt.) For TCP/IP networks, you can
use the TCP/IP diagnostic commands that are summarized in Table 15-2.

v~ System Information: This program, which comes with Windows, is a
useful utility for network managers.

v Hotfix Checker: This handy tool from Microsoft scans your computers
to see which patches need to be applied. You can download the Hotfix
Checker for free from the Microsoft Web site. Just go to www.microsoft.
com and search for hfnetchk.exe.

1 Baseline Security Analyzer: If you prefer GUI-based tools, check out this
program, which you can download for free from the Microsoft Web site.
To find it, go to www.microsoft.com and search for Microsoft Baseline
Security Analyzer.

v~ A third-party utility: Get one of those 100-in-1 utility programs, such as
Symantec’s Norton Utilities. It has invaluable utilities for repairing dam-
aged hard drives, rearranging the directory structure of your hard drive,
and gathering information about your computer and its equipment.
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Never use a hard-drive repair program that isn’t designed to work with
the operating system or version that your computer uses or the file
system you installed. Anytime you upgrade to a newer version of your
operating system, also upgrade your hard-drive repair program to a
version that supports the new operating system version.

v Protocol analyzer: A protocol analyzer (or packet sniffer) can monitor

and log the individual packets that travel along your network. You can
configure the protocol analyzer to filter specific types of packets, watch
for specific types of problems, and provide statistical analysis of the
captured packets.

Most network administrators agree that Sniffer, by Sniffer Technologies
(www.sniffer.com) is the best protocol analyzer available. However,
it’s also one of the most expensive. If you prefer a free alternative, check
out Ethereal, which you can download for free from www.ethereal . com.

v Network Monitor: Windows 2000 and Windows XP — as well as Windows

2000 Server and Windows Server 2003 — include this program,; it provides
basic protocol analysis and can often help solve pesky network problems.

Table 15-2 TCP/IP Diagnostic Commands

Command What It Displays

arp Address resolution information used by the Address Resolution
Protocol (ARP)

hostname Your computer’s host name

ipconfig Current TCP/IP settings

nbtstat The status of NetBIOS over TCP/IP connections

netstat Statistics for TCP/IP

nslookup DNS information

ping Verification that a specified computer can be reached

route The PC’s routing tables

tracert The route from your computer to a specified host

Building a Library

Scotty delivered one of his best lines in the original Star Trek series when he
refused to take shore leave so that he could get caught up on his technical
journals. “Don’t you ever relax?” asked Kirk. “I am relaxing!” Scotty replied.
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To be a good network administrator, you need to read computer books — lots
of them. And you need to enjoy doing it. If you're the type who takes computer
books with you to the beach, you’ll make a great network administrator.

Read books on a variety of topics. I don’t recommend specific titles, but [ do
recommend that you get a good, comprehensive book on each of these topics:

v Network cabling and hardware

v Ethernet

v Windows 2000 Server

v Windows Server 2003

v Windows XP Professional

v Windows Vista

v Exchange

v Linux

v TCP/IP

v DNS and BIND

v SendMail

v Exchange Server

v Security and hacking

1 Wireless networking
In addition to reading books, you may also want to subscribe to some maga-
zines to keep up with what’s happening in the networking industry. Here are a
few you probably should consider, along with their Web addresses:

v InformationWeek: www . informationweek.com

v InfoWorld: www . infoworld.com

v Network Computing: www .networkcomputing.com

v Network: www .networkmagazine.com

v Windows & .NET: www .winntmag.com

v 2600: www . 2600 . com (a great magazine on computer hacking and

security)

The Internet is one of the best sources of technical information for network
administrators. Stock your browser’s Favorites menu with plenty of Web sites
that contain useful networking information. Many Web sites have online
newsletters you can subscribe to so that you regularly get fresh information
by e-mail.
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Pursuing Certification

Remember the scene near the end of The Wizard of Oz when the Wizard
grants the Scarecrow a diploma, the Cowardly Lion a medal, and the Tin Man
a testimonial?

Network certifications are kind of like that. I can picture the scene now:

The Wizard: “And as for you, my network-burdened friend, any geek with
thick glasses can administer a network. Back where [ come from, there are
people who do nothing but configure Cisco routers all day long. And they
don’t have any more brains than you do. But they have one thing you don’t
have: certification. And so, by the authority vested in me by the Universita
Committeeatum E Pluribus Unum, I hereby confer upon you the coveted cer-
tification of CND.”

You: “CND?”
The Wizard: “Yes, that’s, uh, Certified Network Dummy.”

You: “The Seven Layers of the OSI Reference Model are equal to the Sum of
the Layers on the Opposite Side. Oh, rapture! I feel like a network administra-
tor already!”

Certification doesn’t guarantee that you really know how to administer a net-
work. That ability comes from real-world experience — not from exam crams.

However, certification is important in today’s competitive job market. So, you
may want to pursue certification — not just to improve your skills but also to
improve your résumé. Certification is an expensive proposition. Its tests can
cost several hundred dollars each, and depending on your technical skills,
you may need to buy books to study or enroll in training courses before you
take the tests.

You can pursue two basic types of certification: vendor-specific and vendor-
neutral. The major networking vendors (such as Microsoft, Novell, and Cisco)
provide certification programs for their own equipment and software.
CompTIA, a nonprofit industry trade association, provides the best-known
vendor-neutral certification.
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Managing User Accounts
with Active Directory

In This Chapter

Understanding user accounts
Creating user accounts
Setting account options
Working with groups

Creating a logon script

E/ery user who accesses a network must have a user account. User
accounts let you control who can access the network and who can’t. In
addition, user accounts let you specify which network resources each user
can use. Without user accounts on your network, all your resources are open
to anyone who casually drops by your network.

Basics of Windows User Accounts

User accounts are one of the basic tools for managing a Windows server. As a
network administrator, you spend a large percentage of your time dealing
with user accounts — creating new ones, deleting expired ones, resetting
passwords for forgetful users, granting new access rights, and so on. Before |
get into the specific procedures of creating and managing user accounts, this
section presents an overview of user accounts and how they work.
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Local accounts versus domain accounts

A local account is a user account that is stored on a particular computer and
applies to only that computer. Typically, each computer on your network has
a local account for each person who uses that computer.

In contrast, a domain account is a user account that is stored by Active Direc-
tory and can be accessed from any computer that’s a part of the domain.
Domain accounts are centrally managed. This chapter deals primarily with
setting up and maintaining domain accounts.

User account properties

Every user account has a number of important account properties that specify
the characteristics of the account. The three most important account proper-
ties are

v Username: A unique name that identifies the account. The user must
enter her username when logging on to the network.

The username is public information. Other network users can (and
often, should) find out your username.

v~ Password: A secret word needed to access the account.
You can set up Windows to enforce password policies, such as
e The minimum length of the password
¢ Whether the password must contain both letters and numerals
¢ How frequently the user must change the password

v Group membership: Indicates the group or groups to which the user
account belongs. Group memberships are the key to granting access
rights to users so that they can

¢ Access network resources, such as file shares or printers

¢ Perform network tasks, such as creating new user accounts or
backing up the server

Groups are a handy way to send e-mail to multiple users. For example, if
all users in your marketing department are members of a group named
Marketing, you send them all an e-mail by addressing the mail to the
Marketing group.

Many other account properties record information about the user, such as
her contact information and whether she’s allowed to access the system only
at certain times or from certain computers. I describe the most important of
these features in later sections of this chapter.
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Creating a New User

Figure 16-1:
The Active
Directory
Users and
Computers
manage-
ment
console.
|

To create a new domain user account in Windows Server 2003, follow these
steps:

1. Choose Start~>Administrative Tools>Active Directory Users and
Computers.

This step fires up the Active Directory Users and Computers manage-
ment console, as shown in Figure 16-1.

4 Active Directory Users and Computers _|Of x|

.‘«7_‘,1 File  Action Miew MWindow Help |_ 5‘5'
= AE R EFRNE R ek vay

@ Active Directory Users and Computers | Users 29 objects
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B4 i
= “?_‘j gdauml?n.cum ﬁ Administrator User Built-in account For admini...

=

= M ﬁ Anne User

-] Computers .

= . ﬁ ASPMET User Account used For running .,

[#-{£3] Domain Controllers ﬁi

= (1 ForsignSecurityPrincipals etk Publishers  Security Group ... Members of this group are...

424 Users ﬁDEhugger Users Security Group ...  Debugger users can debu...

!ﬁDHCP Adminis, .. Security Group ... Members who have admini...
ﬁEDHCP Users Security Group ... Members who have view-...
ﬁEDnsAdm\ns Security Group ... DNS Administrators Group

ﬂDnsUpdatEPr... Security Group ... DNS clients wha are permi...
!ﬁDDma\n Admins  Security Group ... Designated administrators. .,

ﬁIDDma\n Comp... Security Group .., All workstations and serve. ., |
ﬁzDDma\n Contr.., Security Group ... All domain controllers in th...

ﬁDnma\n Guests  Security Group ... All domain guests

!ﬁDDma\n Users  Security Group ... Al domain users

ﬁ Daoug User

ﬁEEnterprlse Ad... Security Group ... Designated administratars,..
ﬂGmup Palicy ... Security Group ... Members in this group can...
€ Guest User Built-in account for guest ...

ﬁ_‘ _’l €T Helpservices...  Security Group ... Group for the Help and Su... L'

2. Right-click the domain that you want to add the user to and then
choose Newr>User.

This step calls the New Object Wizard, as shown in Figure 16-2.
3. Type the user’s first name, middle initial, and last name.

As you type the name, the New Object Wizard automatically fills in the
Full Name field.

4. Change the Full Name field if you want it to appear differently than
proposed.

For example, you may want to reverse the first and last names so that
the last name appears first.

5. Type the user logon name.

This name must be unique within the domain.
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MNew Object - User x|
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— User logon name [pre-windows 2000);
Figure 16-2: [MYDOMAINY [rclzaver
Creating a
new user. Back I Mext > I Cancel
|
P Pick a naming scheme to follow when creating user logon names. For
example, use the first letter of the first name followed by the complete
last name, the complete first name followed by the first letter of the last
name, or any other scheme that suits your fancy.
6. Click Next.
The second page of the New Object Wizard appears, as shown in
Figure 16-3.
Newobject trer E
g Createin:  mydomain.comdUsers
Password: ||
LConfirm pazsword; |
¥ User must change password at next lngon
™ User cannct change password
| [ Password never expires
Figure 16_3: [ Account is disabled
Setting the
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|

7. Type the password twice.

You're asked to type the password twice, so type it correctly. If you don’t
type it identically in both boxes, you're asked to correct your mistake.
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8. Specify the password options that you want to apply.
The following password options are available:
¢ User must change password at next logon.
e User cannot change password.
¢ Password never expires.
¢ Account is disabled.

For more information about these options, see the section, “Setting
account options,” later in this chapter.

9. Click Next.

You're taken to the final page of the New Object Wizard, as shown in
Figure 16-4.

MNew Object - User x|

ﬁ Createine  mydomain.comdlsers

When you click Finish, the following object will be created:

Full name: Theodaore Cleaver ;]
User logon name: teleaver@mydomain. com

The uger must change the password at nest logon,
|

Figure 16-4:
Verifying

the user =l
account
information.
|

< Back Cancel |

10. Verify that the information is correct and then click Finish to create

the account.
A\

If the account information isn’t correct, click the Back button and cor-
rect the error.

You're done! Now you can customize the user’s account settings. You’ll prob-

ably want to add the user to one or more groups. You may also want to add
contact information for the user or set up other account options.

Setting User Properties

After you create a user account, you can set additional properties for the
user by right-clicking the new user and choosing Properties. This action
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Figure 16-5:
The General
tab.

brings up the User Properties dialog box, which has about a million tabs that
you can use to set various properties for the user. Figure 16-5 shows the
General tab, which lists basic information about the user, such as the user’s
name, office location, and phone number.

Theodore Cleaver Properties b 2lx|
Member OF I Dial-in I Enviranment | Sessions
Remote control | Temninal Services Profile I COM+

General | Address I Account I Profile | Telephones | Organization

g Theodore Cleaver

First name:;

Initials:

Last name: ICIeaver

Digplay name: |T heodore Cleaver

Deszcription: |

Dffige: |

Telephone number: Other... I

E-mail |

‘web page: Other... I

oK I Cancel | Sipply |

The following sections describe some of the administrative tasks that you
can perform by using the tabs in the User Properties dialog box.

Changing a user’s contact information

Several tabs in the User Properties dialog box contain contact information for
the user:

v Address tab: Change the user’s street address, post office box, city,
state, zip code, and so on.
v~ Telephones tab: Specify the user’s phone numbers.

v+ Organization tab: Record the user’s job title and the name of his or
her boss.

Setting account options

The Account tab of the User Properties dialog box, as shown in Figure 16-6,
features a variety of interesting options that you can set for the user. From
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this dialog box, you can change the user’s logon name. In addition, you can
change the password options that you set when you created the account and
set an expiration date for the account.

Theodore Cleaver Properties b

Member OF I Dial-in I
Remote contral |
General I Address

2lx]

Sessions
Temninal Services Profile I COM+
Account | Profile: | Telephones | Organization

Eriranment |

User logon name:
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Uszer logon name [pre-windows 2000];
[MYDOMAINA

|tcleavel

Logon Howrs... LogOnTo.. |

[T scoount is locked out

Account options:

v Usar must change pagssword at nest logon ﬂ
™ User cannat change password

[~ Password never expires

™ Stare password using reversible encryption ;l

i Aeocount expies
& Mever
" Endoaf:

[wednesday, Auguet 13,2003 |

o]

Cancel | Sipply |

The following account options are in the Account Options list box:

+ User must change password at next logon: Use this option, which is
selected by default, to create a one-time-only password that can get the
user started with the network. The first time the user logs on to the net-
work, he is asked to change the password.

v~ User cannot change password: Use this option if you don’t want to
allow users to change their passwords. (Obviously, you can’t use this
option and the previous one at the same time.)

1 Password never expires: Use this option if you want to bypass the pass-

word expiration policy for this user so that he never has to change his
password.

v~ Store password using reversible encryption: This option stores pass-
words by using an encryption scheme that hackers can easily break, so
avoid it like the plague.

v Account is disabled: Use this option to create an account that you

don’t yet need. As long as the account remains disabled, the user cannot
log on.

See the section, “Disabling and Enabling User Accounts,” later in this
chapter, to find out how to enable a disabled account.



244 Part IV: Network Management for Dummies

|
Figure 16-7:
The Profile
tab.
|

v Smart card is required for interactive logon: If the user’s computer has
a smart card reader to automatically read security cards, check this
option to require the user to use it.

v Account is trusted for delegation: This option indicates that the
account is trustworthy and can set up delegations.

This feature is usually reserved for Administrator accounts.

v Account is sensitive and cannot be delegated: Prevent other users from
impersonating this account.

v+ Use DES encryption types for this account: Beef up the encryption for
applications that require extra security.

v Do not require Kerberos preauthentication: Select this option if you
use a different implementation of the Kerberos protocol.

Setting a user’s profile information

The Profile tab, as shown in Figure 16-7, lets you configure the user’s profile
information. This dialog box lets you configure three bits of information
related to the user’s profile:

Theodore Cleaver Properties _

Member O I Dialin I Ervironment |
Remote control | Teminal Services Profile I
General I Address I Account

2]

Sessions
COM+
Frafile I Telephones | Organization

~Uszer profile

Profile path: I

Logon script: I

i~ Home folder

" | ocal path: !

" Connect: |

F2[ o

o

Cancel Apply

v Profile path: Specifies the location of the user’s roaming profile.

For more information, see Chapter 22.
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v Logon script: The name of the user’s logon script. A logon script is a batch
file that’s run whenever the user logs on. The main purpose of the logon
script is to map the network shares that the user requires access to.

Logon scripts are a carryover from the early versions of Windows NT
Server. In Windows Server 2003, a profile is the preferred way to config-
ure the user’s computer when she logs on, including setting up network
shares. However, many administrators still like the simplicity of logon
scripts. For more information, see the section, “Creating a Logon Script,
later in this chapter.

”

v Home folder: Where you specify the default storage location for the
user. Follow these steps:

1. Set up a network share on a file server.
Typically, this share is named Home.

2. Assign a drive letter (usually H) that points to this location and speci-
fies the variable %USERNAME%, like this:

\\fileserver01l\Home\$USERNAMES

Windows substitutes the user’s actual username to determine the folder
where the user’s files are stored. For example, if the user’s username

is bcleaver, the user’s home folder is \\ fileserver01\Home\
bcleaver.

The Profile tab lets you specify the location of an existing profile for the user,
but it doesn’t let you set up the profile. For more information about setting
up a profile, see Chapter 22.

Resetting User Passwords

\\3

By some estimates, the single most time-consuming task of most network
administrators is resetting user passwords. It’s tempting to think that users
are just forgetful idiots, but put yourself in their shoes. Network administra-
tors insist that users set their passwords to something incomprehensible,
such as 94kD821el.384K, that they change it a week later to something even
less memorable, such as dJUQ63DWd8331, and that they don’t write it down.
Then they get mad when users forget their passwords.

When a user calls and says that she forgot her password, the least you can do
is be cheerful when you reset it for her. She probably spent 15 minutes trying
to remember it before giving up and admitting failure.
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Here’s the procedure to reset the password for a user domain account:

1.

Log on as an administrator.

Y